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Chapter 1 
Welcome 

Welcome to Datacap Taskmaster 7.6 – and to the Taskmaster 7.6 Installation & Configuration 
Guide. 

This Guide provides you with the information you need to install and configure all components 
of Taskmaster 7.6 in two configurations: 

• Install, Configure, and Run on Single Vista Machine 

• Install, Configure, and Run on Client and Server 

This Welcome chapter describes the contents of the Taskmaster 7.6 Installation & 
Configuration Guide, and, lists contact information for Datacap and Datacap Support. 

About this Book 

The Taskmaster 7.6 Installation & Configuration Guide contains the following chapters. 

Chapter 1: Welcome 
Chapter 1 describes the contents of the Taskmaster 7.6 Installation & Configuration Guide. 

Chapter 2: Installation and Configuration Prerequisites 
Chapter 2 describes what you need before you begin the installation of Datacap Taskmaster 
7.6 software.  These prerequisites ensure that you can install, configure, and run the 
Taskmaster components of a sample application either on a single machine, or on multiple 
machines in a client/ server network configuration.  

Chapter 3: Install, Configure, and Run on Single Vista Machine 
Chapter 3 describes what you need to know to install all of the Taskmaster software 
components on a single Windows Vista machine (“Workstation”), perform a minimal amount 
of configuration, and run each of the Taskmaster software components "out of the box." 

Chapter 4: Install, Configure, and Run on Client and Server 
Chapter 4 describes what you need to know to install, configure, and run Datacap Taskmaster 
7.6 server, web, and clients in a client/server, Windows desktop and/or web-based environment 
for development, test, and production purposes. It also includes instructions that guide you 
through using a sample application so you can see it process sample batches of documents. 

The server ("Server") hosts the Taskmaster Server, the applications, batch files, and databases. 
For the Server, these instructions cover Windows Vista (which limits the number of users to 
five), Windows 2000, Windows 2003, and Windows 2008.  
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The workstation ("Workstation") hosts the thick clients (Taskmaster Client, Report Viewer, 
Datacap Studio, etc.) and the browser.  For the Workstation, these instructions cover Windows 
Vista. 

An optional, separate server ("RRServer") hosts Rulerunner running as a web service.  For 
RRServer, these instructions cover Windows 2003. 

These instructions also include account settings for five types of users:  Developers with 
administrative rights on both Server and Workstation, the Taskmaster Server Service, 
Taskmaster Client Service, Rulerunner running as a web service, and end users.  

Chapter 5: Uninstall Taskmaster 7.6 
This chapter provides the information you need to uninstall Taskmaster 7.6 software 
components. 

Appendix A: Vista Machine Setup Checklist 
This Appendix provides a summary of the account and configuration settings that are required 
to run Datacap Taskmaster 7.6 server, web, and clients on a single Windows Vista, IIS 7  
machine with a single Domain/Windows user who has administrator rights on the machine.  

Appendix B: Client/Server Setup Checklist 
This Appendix provides a summary of the account and configuration settings that are required 
to run Datacap Taskmaster 7.6 server, web, and clients in a client/server, Windows desktop 
and/or web-based environment for development, test, and production purposes. 

Appendix C: Taskmaster Installer Command Line Parameters 
This Appendix provides information about the most commonly used parameters available 
when running the Taskmaster InstallShield Setup.exe from the command line. 

If You Need Help 

Telephone number for Datacap Inc.’s Technical Support: 

  914-259-1300 

Fax number for Datacap Inc.'s Technical Support: 

  914-366-0500 

Email address for Datacap Inc.'s Technical Support: 

  support@datacap.com 

Web address for Datacap Inc.'s Technical Support: 

 http://support.datacap.com 
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Chapter 2 
 Installation & Configuration Prerequisites 

This chapter of the Taskmaster 7.6 Installation & Configuration Guide provides the 
information you need before you begin the installation of Datacap Taskmaster 7.6 software.  
These prerequisites ensure that you can install, configure, and run each Taskmaster component 
of a sample application either on a single machine, or on multiple machines in a client/server 
network configuration.  

Configuration Assumptions 

For information on hardware and operating system requirements for Datacap Taskmaster 
software, see: 

http://dnld.datacap.com/TechNotes/hardware.htm 

To keep things simple, instructions are provided for two configurations: 

• Chapter 3 Install, Configure, and Run on Single Vista Machine - These instructions 
allow you to install, configure, and run all of the Taskmaster components on a single 
Microsoft Windows Vista machine.  This machine is referred to as the “Workstation.”  
The instructions assume your Windows user account has administrator rights on the 
Workstation.  For a checklist of the account and configuration settings, see Appendix A 
Vista Machine Setup Checklist. 

• Chapter 4 Install, Configure, and Run on Client and Server - These instructions allow 
you to install, configure, and run Datacap Taskmaster 7.6 server, web, and clients in a 
client/server, Windows desktop and/or web-based environment for development, test, and 
production purposes. The server ("Server") hosts the Taskmaster Server, the applications, 
batch files, and databases; the instructions cover Vista (which limits the number of users 
to five), as well as Windows 2000, Windows 2003, and Windows 2008.  The workstation 
("Workstation") hosts the thick clients (Taskmaster Client, Report Viewer, Datacap 
Studio, etc.) and the browser; these instructions cover Vista. The instructions assume your 
user account has administrator rights on the Workstation and Server, and that you will 
create domain accounts for the developer, Taskmaster Server Service, the Taskmaster 
Client Service, Rulerunner running as a web service, and end users.  For a checklist of the 
account and configuration settings, see Appendix B Client/Server Setup Checklist. 

Before You Begin 

Before beginning the installation, ensure you have done the following: 

• Make a note of and shut down Taskmaster software  

• Backup and uninstall Taskmaster Versions 7.1 and 7.1 SP1  

• Backup Taskmaster Version 7.5 or 7.5 SP1  
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• Ensure scanner is set up and works  

• Ensure domain accounts exist  

• Ensure IIS is installed on Vista and Windows 2008 Servers  

• Confirm IIS Configuration on Windows 2000, Windows 2003 Servers  

• Obtain the default Taskmaster administrative user ID and password  

Make a Note of and Shut Down Taskmaster Software 
Before beginning the installation, we recommend shutting down all Taskmaster software on 
the machine, and if the machine is part of a Taskmaster network configuration, on all machines 
in the following sequence:  

1 Taskmaster Client software for all applications (including Taskmaster Client, 
Taskmaster Web Client, Taskmaster Client Service, Datacap Studio, Batch Pilot, Report 
Viewer, etc.)  

2 Taskmaster Web and any Taskmaster Web Services (WRRS, Fingerprint Service, etc.)  

3 Taskmaster Server Service 

Backup and Uninstall Taskmaster Versions 7.1 and 7.1 SP1 
When either Taskmaster version 7.1 or version 7.1 SP1 exists on a machine on which you want 
to install Taskmaster 7.6, you must correctly and completely uninstall the earlier version 
before you install Taskmaster 7.6.  

WARNING 

Uninstalling Taskmaster version 7.1 or version 7.1 SP1 must be performed using the 
Windows Add or Remove Programs tool in a specific sequence: 
1  Uninstall Datacap Taskmaster 
2  Reboot the machine 
3  Uninstall Datacap CD 

1 Before you begin, ensure you have shut down all software (in addition to the 
Taskmaster software) on the machine. 

2 Copy the entire shared Datacap folder, including your application’s process folder, to a 
backup location. 

3 From the Windows Start menu, select Settings, select Control Panel, and double-click 
Add or Remove Programs.  When the Add or Remove Programs window opens, scroll 
down and select Datacap Taskmaster. 

4 Click Change/Remove.  The Preparing to Install window is displayed, followed by the 
Welcome window. 

5 Select the Remove option, then click Next.  A Confirm Uninstall message box is 
displayed. 

6 Click OK.  The message box closes and the Setup Status window displays a progress 
bar for various removal and unregistration activities, followed by the InstallShield 
Wizard Complete window.  The Yes I want to restart my computer now option is 
selected. 

7 Click Finish.  The window closes, and the machine reboots. 
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8 When the machine has restarted, log on again. 

9 From the Windows Start menu, select Settings, select Control Panel, and double-click 
Add or Remove Programs.  When the Add or Remove Programs window opens, scroll 
down and select Datacap CD. 

10 Click Change/Remove.  A message box prompts you to confirm you want to remove 
Datacap from your computer. 

11 Click Yes.  The message box is closes and the Setup Status window displays a progress 
bar for various removal and unregistration activities, followed by a message box 
confirming that Datacap has been uninstalled successfully. 

Back Up Taskmaster Version 7.5 or 7.5 SP1 
When Taskmaster version 7.5 or 7.5 SP1 exists on a machine on which you will install 
Taskmaster 7.6, while there is no need to remove it before you install Taskmaster 7.6 (as the 
7.6 installation process will uninstall it automatically), you should copy the entire shared 
Datacap folder, including your application’s process folder, to a backup location.  This ensures 
you have a backup copy of your customized applications and all separately purchased Datacap 
options. 

Ensure Scanner is Set Up and Works 
Follow the manufacturer’s instructions to attach the scanner to the Workstation, and install and 
configure the required scanner software.  Be sure you can scan successfully using the scanner 
using any image capture software product.  If you cannot scan documents outside of 
Taskmaster, you will not be able to scan documents using Taskmaster. 

Note:  A physical scanner is not required for running the Datacap foundation or sample 
applications, as those applications can process the prescanned images included during 
installation. 

Ensure Domain/Windows Accounts Exist 
When installing all Taskmaster components on a single Vista machine, the Windows accounts 
you need are local users that are usually found on a Vista workstation:  the developer's/your 
own Windows user ID, and the NETWORK SERVICE and IUSR local users.  At a minimum, 
the developer's/your Windows User ID must have Administrator rights to the Workstation. 

When installing on a client workstation and one or more servers, the Workstation and Server 
must be in the same domain and the domain must also include accounts for the Taskmaster 
Server Service, the Taskmaster Client Service, and any developers and end users who you 
want to be able to use Taskmaster.  The developer's/your Windows User ID must have 
Administrator rights to the Workstation and the Server.   

In addition, ensure that the Taskmaster Server Service and the Taskmaster Client Service have 
been granted the Log on as a Service right on the primary domain controller. 

Microsoft MSXML 6.0 Parser 
Datacap software requires the Microsoft MSXML 6.0 Parser and if it isn't already installed, it 
will be installed automatically during the Datacap software installation process. 

Microsoft Windows Installer 3.1 
Datacap software also requires the Microsoft Windows Installer 3.1.  If it isn't already 
installed, it will be installed automatically during the Datacap software installation process. 



Installation & Configuration Guide 

Page 12 Confidential and Proprietary Information of Datacap Inc. 

 Copyright © 2010 Datacap Inc. 

Microsoft .NET Framework 2.0 
Servers and Workstations running Datacap software require Microsoft .NET Framework 2.0, 
and if it is not already installed, it will be installed automatically during the Datacap software 
installation process. 

Microsoft Internet Information Services 
Servers running Taskmaster Web require Microsoft Internet Information Services (IIS). 

Ensure IIS is Installed on Vista and Windows 2008 Servers 
You must install Internet Information Services if was not installed when your Vista or 
Windows 2008 operating system was installed, and we recommend installing all IIS 
components.  

On Vista: 

1 From the Server’s Windows Start menu, select Control Panel, select Programs and 
Features, and then click Turn Windows Features on or off. 

2 Expand and select Internet Information Services, then ensure all components and 
subcomponents are selected. 

On Windows 2008: 

1 From the Server’s Windows Start menu, select Administrative Tools, and then click 
Server Manager. 

2 In the Server Manager hierarchy pane, expand Roles, and then select Web Server (IIS). 

3 Ensure all Web Server components and subcomponents are selected. 

Confirm IIS Configuration on Windows 2000, Windows 2003 Servers 
Confirm that IIS was installed properly on your Windows 2000, or Windows 2003 Server. 

IMPORTANT NOTE  

On Windows 2000 and Windows 2003 Servers, IIS should be installed prior to .NET.   
If IIS is installed after .NET, you must run Microsoft’s ASP.NET IIS Registration Tool 
(aspnet_regiis.exe) with the installation parameter (-i) to update the ASP.NET application 
script maps to point to the appropriate ASP.NET ISAPI version.  For instructions on running 
the tool, see Run aspnet_regiis.exe.  For more information about the tool, search for 
“aspnet_regiis.exe” on the Microsoft website. 

Determine if IIS and .NET are installed 
This procedure provides instructions on how to determine whether IIS and .NET are already 
installed on the Workstation or Server:  

1 When your operating system is Vista, skip this step, as.NET is included with Vista.  
From the Windows Start menu, select Settings, select Control Panel, and double-click 
Add or Remove Programs.  When the Add or Remove Programs window opens, scroll 
down to determine whether Microsoft .NET Framework 2.0 is installed, then close the 
window. 

2 In Control Panel, select Administrative Tools and determine whether there is an entry 
for Internet Information Services displayed.   

3 If: 
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 Neither .NET nor IIS is displayed, install IIS, then continue with the Taskmaster 
installation process 

 Both .NET and IIS are displayed, and your operating system is Windows 2000, or 
Windows 2003, run aspnet_regiis.exe, then continue with the Taskmaster 
installation process 

 Only IIS is displayed, continue with the Taskmaster installation process 
 Only .NET is displayed, install IIS, then run aspnet_regiis.exe, then continue with 

the Taskmaster installation process 

Run aspnet_regiis.exe 
This procedure provides instructions on how to run Microsoft’s aspnet_regiis.exe to update the 
ASP.NET application script maps to point to the appropriate ASP.NET ISAPI version.  

1 From the Windows Start menu, select Run.  The Run dialog opens. 

2 In the Open field, type cmd, and click OK. A DOS command prompt window opens. 

3 Locate the aspnet_regiis.exe (for example, from your C:\> prompt, type: dir 
aspnet_regiis.exe /s)  

4 Run the aspnet_regiis.exe with the -i parameter (for example:  
C:\>C:\WINDOWS\Microsoft.NET\Framework\v2.0.50727\aspnet_regiis.exe -i) 
Progress messages are displayed indicating the start and completion of the installation. 

5 When the installation has finished, exit/close the DOS window. 

Obtain the Default Taskmaster Administrative User ID and Password 
You need the default administrator User ID and password to log into the Taskmaster software.  
Contact your Datacap Implementation Specialist or Support for the administrative User ID 
password. 
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Chapter 3 
Install, Configure, and Run on Single Vista 

Machine 

This chapter provides the information you need to install all of the Taskmaster software 
components on a single Windows Vista machine (“Workstation”), perform a minimal amount 
of configuration, and run each of the Taskmaster software components "out of the box" 
including: 

• Taskmaster Server Service 

• APT Taskmaster Client processing 

• APT Taskmaster Client Report Viewer 

• Taskmaster Web 

• APT Taskmaster Web Client processing 

• APT Taskmaster Web Client report generation 

• Datacap Studio 

The sections are sequenced deliberately, as some items in later sections depend on steps from 
the previous sections having been completed successfully. 

For a checklist of the account and configuration settings, see Appendix A Vista Machine 
Setup Checklist.  

WARNINGS 

The steps for installing and configuring on more than one machine are significantly 
different than the steps for installing on a single machine.  For information on how to 
install Taskmaster components on separate machines in a client/server environment, 
see Chapter 4 Install, Configure, and Run on Client and Server.  

While the installation package (Setup.exe) can be located anywhere (for example, on an 
accessible network drive, on the CD in the Workstation's CD/DVD drive), the 
destination of the installed software must be on a physical hard drive of the machine 
from which you run the Setup.exe.   

Your initial Taskmaster software installation must be into the c:\Datacap folder on the 
Workstation.  If you do not use this installation path, the foundation (APT, Flex) and 
sample (Survey, Express) applications will not function. 
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Overview of Taskmaster Installation on Single Windows Vista Machine 

The Taskmaster installation, configuration, and run processes are performed in the following 
sequence: 

1 Ensure you have met the prerequisites detailed in Chapter 2 Installation and 
Configuration Prerequisites. 

2 Run the Taskmaster InstallShield Wizard and install all of the Taskmaster software 
components on the Workstation. 

3 Reboot the Workstation. 

4 Configure Taskmaster components on the Workstation. 

5 Run Taskmaster Client. 

6 Configure Taskmaster Web. 

7 Configure Internet Explorer. 

8 Run Taskmaster Web Client. 

9 Run Datacap Studio. 

Installation Instructions for Single Vista Machine 

This section provides the information you need to install all of the Taskmaster software 
components on the Workstation. 

Ensure Prerequisites are Met 
Ensure you have met the prerequisites detailed in Chapter 2 Installation and Configuration 
Prerequisites.  

Install All Taskmaster Components on Single Vista Machine 
This procedure provides instructions on how to run the Taskmaster InstallShield Wizard to 
install all components on a single Windows Vista machine (referred to as "Workstation").  

WARNINGS 

The steps for installing and configuring on more than one machine are significantly 
different than the steps for installing on a single machine.  For information on how to 
install on a workstation and a server, see Chapter 4 Install, Configure, and Run on 
Client and Server. 

While the installation package (Setup.exe) can be located anywhere (for example, on an 
accessible network drive, in the Workstation's CD/DVD drive), the destination of the 
installed software must be on a physical hard drive of the machine from which you run 
the Setup.exe.   

Your initial Taskmaster software installation must be into the c:\Datacap folder on the 
Workstation.  If you do not use this installation path, the foundation (APT, Flex) and 
sample (Survey, Express) applications will not function. 

1 Make the installation package available on your network, or insert the Taskmaster CD 
in the Workstation’s CD/DVD drive.  If the installation process does not start 
automatically, or if the package is on the network, open Windows Explorer, navigate to 
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and double-click the Setup.exe.   
When UAC is on, the User Account Control window opens.  Click Allow. 
The Taskmaster Setup InstallShield Wizard opens.  

2 The InstallShield Wizard displays a Preparing to Install... window followed by the 
InstallShield Wizard Welcome window. 

3 Click Next. The License Agreement window opens. 

4 Click I accept the terms in the license agreement and click Next.  The Setup Type 
window is displayed with the Complete option selected. 

5 Click Next.  The Ready to Install the Program window is displayed. 

6 Click Install.  The Installation Wizard displays progress messages and a progress 
indicator, and when complete, displays the InstallShield Wizard Complete window. 

7 Click Finish.  A prompt to reboot your machine is displayed. 

8 Depending on whether you need to save and close other applications before you reboot 
your system, click either No or Yes.  The message box closes. 

Reboot after Install 
After completing the Taskmaster Installation process, reboot the machine. 

Using Taskmaster APT 

This section provides the information you need to process the sample (pre-scanned) images 
included with Taskmaster APT.  The sample images consist of four one-page invoices, a 
separator page, and one two-page invoice, and are provided so you can run Taskmaster APT 
“out of the box” using a “virtual scan” without having to hook up a real scanner to the 
computer.   

For information on how to process your own pre-scanned invoice images through APT, see the 
instructions in the Taskmaster APT Quick Start Guide, in the section titled: Set Up Taskmaster 
APT to Process Your Invoice Images. 

Run APT Taskmaster Client Application 
This section provides the information you need to run the Datacap Taskmaster foundation APT 
application “out of the box.”  These instructions involve starting the Taskmaster Server 
Service, starting the APT Taskmaster Client application, and running the default APT tasks to 
process sample, pre-scanned images.   

Instructions for running the default APT Taskmaster Web Client tasks are provided after the 
Configure Taskmaster Web on Vista, Windows 2008, IIS 7 Server instructions. 

Overview of Taskmaster APT 
Taskmaster APT is delivered with several different pre-configured “jobs.” A job is a collection 
of tasks to perform and rules to run that process invoices.  The default shortcuts you see when 
you start APT allow you to start and run various job-task combinations.  APT’s pre-configured 
jobs include:   

• Demo 

• Demo-Dot Matrix 
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• Demo-Multipage TIFF 

• Web Demo 

• Web Demo-Dot Matrix 

• Web Main  

• Web Main-Dot Matrix 

(Note that Taskmaster APT also includes Main Job and Main Job-Dot Matrix, however these 
jobs are only displayed after your Datacap Implementation Specialist has customized the 
configuration to your particular scanners.) 

The Demo and Web Demo jobs are the examples used in this documentation.  When running 
the Demo jobs, the default shortcuts you run, and the sequence in which you run them using 
the Taskmaster APT Client are as follows: 

 

This shortcut Does this 
Scan Allows you to select the Demo job, and run the VScan (virtual 

scan) task to bring the sample invoice images into Taskmaster 
APT.  

Background Starts the Batch Profiler task that performs many image 
processing functions including: identification of pages, image 
cleaning (e.g. despeckling), image rotation (if necessary), full 
page character recognition, and more. It also attempts to 
identify the invoice by comparing it to a library of known 
invoices. 

Verify Starts the Verify task that displays the sample invoice images 
and the data that has been recognized in the Verify window so 
you can ensure the data is complete and correct.  When an 
invoice is not a known invoice, the Verify window allows you 
to identify the fields and data on it, and to save its fingerprint so 
it will be recognized the next time.  

Export (or 
Background) 

Starts the Export task that completes processing of images, 
saves information about the invoices, and exports field data to 
XML files for input into your Accounts Payable, document 
imaging, or ERP system.  (Depending on the available batches 
and their current statuses, clicking the Background shortcut 
will run either the Batch Profiler task or the Export task.)  

Prerequisites 
1 Ensure you have met the prerequisites detailed in Chapter 2 Installation and 

Configuration Prerequisites. 

2 Complete the instructions provided to install all of the components on a single 
Workstation on which you have Administrative rights. 

3 From Datacap, obtain the password you need to use when logging in as the Taskmaster 
“admin” user. 
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Start or Ensure Taskmaster Server Service is Started (Vista) 
All configurations of Taskmaster (all components installed on a single Workstation or separate 
components installed on different machines) require that the Taskmaster Server Service be 
running before you can successfully start the application. 

This procedure provides instructions on how to start or ensure the Datacap Taskmaster Server 
Service is started when the operating system is Vista. 

1 From the Workstation's Windows Start menu, select All Programs, select Datacap, 
select Taskmaster Server, and click Taskmaster Server.   
When UAC is on, the User Account Control window is displayed - click Allow. 
The TMS Configuration window opens. 

2 When the Status: 

 Shows as Running, continue with the next step. 
 Shows as Stopped, click Start.  A Starting Service message is displayed.  The Status 

changes to Running when the service is started.  
3 Close the TMS Configuration window. 

Start APT Taskmaster Client for the First Time (Vista) 
This procedure provides instructions on how to start the APT Taskmaster Client application on 
the Workstation for the first time when the Workstation’s operating system is Vista.  Note that 
after the first time you log into the Taskmaster Client, it remembers and displays what you 
entered the previous time. 

1 From the Workstation's Windows Start menu, select All Programs, select Datacap, 
select Applications, select APT, and click the APT Client icon.  The Select Taskmaster 
Server dialog opens with a blank Server name (address) field. 

2 Enter the default IP address of 127.0.0.1 and click OK.  A Station ID is missing in the 
profile message is displayed. 

3 Click OK. An invalid login name or password message is displayed. 

4 Click OK.  The Please login window opens with your Window User ID and the name of 
your computer displayed.  

5 Replace your Windows User ID with admin, use the password provided by Datacap, 
and replace your computer name with the number 1, then click OK.  The APT 
Taskmaster Client main window opens with the Operations pane displayed. 



Installation & Configuration Guide 

Page 20 Confidential and Proprietary Information of Datacap Inc. 

 Copyright © 2010 Datacap Inc. 

 

Run APT Taskmaster Client VScan Task (Scan Shortcut) (Vista) 
This procedure provides instructions on how to run the APT Taskmaster Client VScan task to 
process pre-scanned images. 

1 On the Workstation, in the Operations pane, double-click the Scan shortcut, select the 
Demo job and click OK.   

 
A Task Monitor window opens and a Rulerunner window opens displaying a progress 
bar, then they both close.  A message box is displayed indicating the task has finished. 

2 Click OK. A message box asks if you want to continue processing. 

3 Click No.  The message box closes and the Operations pane is redisplayed. 
When the VScan task finishes successfully, APT has picked up the images from the 
\APT\images\Input folder and created a Taskmaster “batch,” which is a collection of 
document images to be processed.  Taskmaster has assigned a batch ID and created a 
uniquely-numbered folder with the name of the batch ID in \APT\batches.  This folder 
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holds all of the document image processing results for this batch of invoices, including 
the newly-created rrsvscan.xml file.  

4 To view information about the batch, click the View menu and select Job Monitor to 
open the Job Monitor window. 

5 To refresh the information displayed in the Job Monitor window, click the Job 
Monitor's title bar and press F5.  The Job.Task and Status for this batch have been 
updated and are now Demo.Batch Profiler and pending. 

 

Run APT Taskmaster Client Batch Profiler Task (Background Shortcut) (Vista) 
This procedure provides instructions on how to run the APT Taskmaster Client Batch Profiler 
task. 

1 On the Workstation, in the Operations pane, double-click the Background shortcut.  A 
Task Monitor window opens and a Rulerunner window opens displaying a progress bar, 
then they both close.  This may take a few minutes, as Rulerunner is running a number 
of processing-intensive modules, including PageID, ImageFix, CreateDocs, Recognize, 
FindFingerprint, Locate, lookups, and others.  When processing is complete, a message 
box is displayed indicating the task has finished.   

2 Click OK.  A message box asks if you want to continue processing. 

3 Click No.  The message box closes and the Operations pane is redisplayed.   
When the Batch Profiler task finishes successfully, the images have been organized into 
documents, copies (TIO) have been made of the original images, fingerprint (CCO) and 
page XML files have been created, along with a BatchProfiler.xml file in the batch's 
uniquely-numbered folder in \APT\batches. 

4 To refresh the information displayed in the Job Monitor window, click the Job 
Monitor's title bar and press F5.  The Job.Task and Status for this batch have been 
updated and are now Demo.Verify and pending. 
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Run APT Taskmaster Client Verify Task (Verify Shortcut) (Vista) 
This procedure provides instructions on how to run the APT Taskmaster Client Verify task. 

1 On the Workstation, in the Operations pane, double-click the Verify shortcut.  A Task 
Monitor window opens and a Rulerunner window opens, then the Verify - Batch Pilot 
window opens. 
 
Note that for demonstration purposes only, all invoices are deliberately set to be 
displayed in the Verify window.  In a production environment, you decide whether 
you want every invoice to be displayed to the Verify Operator, or only those invoices 
where recognition results are low confidence and data validation rules are violated.  
 
The Verify window displays the first invoice in the batch and the details for the first 
line item on that invoice.   The left side of the window displays fields, recognized data, 
snippets, and a number of buttons, with invoice “header” information displayed on top, 
and line item detail on the bottom.  The right side of the window displays the scanned 
invoice. 
 
When there are errors or low confidence results, the cursor is placed in the first problem 
field and the field is outlined in red.  In addition, the background color of a data field 
indicates:  

• Blue:  No data validation errors or low confidence recognition results 

• Yellow:  Low confidence recognition results (low confidence characters are 
displayed in red) 

• Red: Data validation error 
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2 The following table describes some of the things you can do using buttons and hot-key 

combinations on the APT Verify window; for additional instructions on using the 
Verify window, see the section in the Taskmaster APT Quick Start Guide titled:  Verify 
Window Instructions. 

To Do this  
Move to the next data field Press <Tab> 
Move to next low confidence character Press <Alt+L> 
Fill empty field with data using Click N 
Key 

Click in an empty data entry field, then do one 
of the following: 
Point at the field value on the document image 
and click it, or,  
Click and drag the mouse to draw a rectangular 
box around the existing field data on the image, 
or, 
Press and hold <Alt>, click and drag the mouse 
to draw a rectangular box that encompasses 
additional blank space (to leave room for 
additional characters ), or, 
Press and hold <Shift>, click a field that has 
already been defined and drag the mouse to 
extend the field.   

Invoke validation rules for entire invoice Press <Alt+V> 
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To Do this  
Delete the document that is currently 
displayed 

Press <Alt+D> 

Mark the document for review Press <F2> 
Display the next document in the batch Press <Ctrl+Shift+N> 
Display the previous document in the 
batch. 

Press <Ctrl+Shift+P> 

Move to the next problem document in the 
batch 

Press <Ctrl+N> or 

Click    
Move to the previous problem document 
in the batch 

Press <Ctrl+P> or  

Click    
Lookup and select vendor (either when 
blank or when incorrect vendor is 
displayed) 

Enter at least the first character of the vendor’s 
name and the Remittance_Zip, then click  

  
Identify type of invoice Select from dropdown list  

  
Display original version of scanned image 
(with lines, noise, etc.), display cleaned up 
version of image (toggles from TIO to 
TIF) 

Click   or    

Create new fingerprint for this invoice 
Click    

Display previous page of invoice, display 
next page of invoice 

Click    
Display contents of previous line item, 
display contents of next line item 

Click    
Add line before current (displayed) line,  
add line after current line Click    
View all detail lines (opens separate 
window) Click    

For all detail lines, locate all field values 
for all fields Click    

Calculate missing numeric values using 
existing values and automatically fill blank 
numeric fields 

Click    

Delete current (displayed) line 
Click    
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To Do this  
Display or hide the scanned image On the View menu, select Image View, 

or press <Ctrl+Alt+I> 
Move the image Click and drag the image 

3 Using <Tab>, <Alt+L>, <Alt+V>and other keys described above, review and validate 
each sample document.  When the data has been validated, an End of Page Reached 
message will be displayed. 

4 Click Yes to go to the next document.  When you have finished processing the last 
invoice in the batch, a message box indicates that no additional problems were found. 

5 Click Yes to finish the batch.  A message box is displayed indicating the task has 
finished.   

6 Click OK.  A message box asks if you want to continue processing. 

7 Click No.  The message box closes and the Operations pane is redisplayed.  
When the Verify task finishes successfully, page XML files have been updated (for 
example, when low confidence characters have been changed during Verify), and a 
Verify.xml file has been created in the batch's uniquely-numbered folder in 
\APT\batches. 

8 To refresh the information displayed in the Job Monitor window, click the Job 
Monitor's title bar and press F5.  The Job.Task and Status for this batch have been 
updated and are now Demo.Export and pending. 

 

Run APT Taskmaster Client Export Task (Export Shortcut) (Vista) 
This procedure provides instructions on how to run the APT Taskmaster Client Export task. 
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1 On the Workstation, in the Operations pane, double-click the Export shortcut.  A Task 
Monitor window opens and a Rulerunner window opens displaying a progress bar, then 
they both close.  A message box is displayed indicating that the Export task finished. 

2 Click OK.  A message box asks if you want to continue processing. 

3 Click No.  The message box closes and the Operations pane is redisplayed. 
When the Export task finishes successfully: 

• Export saves information about unknown invoices that were successfully 
validated  (creates new fingerprints) so that the next time Taskmaster APT “sees” 
the same invoice, it can identify the vendor and extract the field data using a 
process called Intellocate. 

• An Export XML file has been added to the batch’s uniquely-numbered folder 
found in \APT\batches. 

• Export outputs the field data to XML files.  The XML files and the image files 
are now ready to be input into a back-end application.  

• If you configured Taskmaster APT to send email notifications and then, during 
Verify, you marked an invoice for review or rescan, or deleted an invoice, Export 
also sends the appropriate emails with the marked or deleted image attached as a 
PDF file.  If you did not configure email notifications, the PDFs of the marked or 
deleted images stay in the batch's uniquely-numbered folder in \APT\batches; the 
images and information about the images are not exported.  

4 To refresh the information displayed in the Job Monitor window, click the Job 
Monitor's title bar and press F5.  The Job.Task and Status for this batch have been 
updated and are now Demo.Export and Job Done.   
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Generate APT Taskmaster Client Reports Manually 

This section provides the information you need to run the sample APT Taskmaster Client 
reports. 

Overview of APT Taskmaster Client Report Viewer 
The APT Taskmaster Client Report Viewer is a separate utility program that can produce a set 
of standard reports "out of the box."  The Report Viewer is installed when you install the 
Taskmaster Client software.  A shortcut is automatically created on your Windows Start menu 
by the installation process. 

Prerequisites 
1 Ensure you have met the prerequisites detailed in Chapter 2 Installation and 

Configuration Prerequisites. 

2 Complete the instructions provided to install all of the components on a single machine 
on which you have Administrative rights. 

3 From Datacap, obtain the password you need to use when logging in as the Taskmaster 
“admin” user. 

4 Ensure the Taskmaster Server Service is started. 

5 To view actual data on one or more reports, run one or more of the APT Taskmaster 
Client or Taskmaster Web Client tasks. 

Start APT Taskmaster Client Report Viewer 
This procedure provides instructions on how to start up the APT Taskmaster Client Report 
Viewer.  Exit the Taskmaster Client on the Workstation before starting Report Viewer on that 
Workstation. 

Note that after the first time you log into Report Viewer, it remembers and displays what you 
entered the previous time. 

1 From the Workstation’s Windows Start menu, select All Programs, select Datacap, 
select Applications, select APT, and click the APT Report Viewer icon.  A Select 
Taskmaster Server dialog opens. 

2 Enter or ensure the Server name (address) is 127.0.0.1, then click OK.  The Report 
Viewer Login window is displayed. 

3 Enter User Name of admin, enter the password provided by Datacap, and ensure the 
Station ID is set to 1, then click OK.  The Report Viewer main window opens. 

Create APT Taskmaster Client Reports Manually 
This procedure provides instructions on how to create a APT Taskmaster Client report 
manually.  

1 With the Report Viewer main window open, on the Report menu, select Open.  The 
Open Report dialog is displayed. 

2 In the:  

 Date portion of the dialog, make changes to indicate the time period to be 
included on the report  

 Report portion of the dialog, select the report you want to view 
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 Filters portion of the dialog, select a filter (optional) 
 then click Open.  The report is displayed. 

3 Use the buttons and fields on the report toolbar as follows: 

 

To Do This 
Set up the printer on which 
you want to print your reports 

1 On the Report menu, click Print Report.  The 
Print Setup window opens. 

2 Clear the No Printer checkbox and select the 
printer you want to use from the drop-down list 
and adjust the other Windows Print controls as 
appropriate. 

3 Click OK.  The Windows Print window opens. 

4 Click Cancel.  The Windows Print window 
closes. 

5 On the Report menu, click Close.  The report 
window closes. 

Export data to PDF file 

(You must have an Adobe 
Acrobat printer driver installed 
to "print" the report to a PDF 
file) 

1 On the Report menu, click Print Report.  The 
Print Setup window opens. 

2 If necessary, clear the No Printer checkbox and 
select the Adobe Acrobat printer driver from the 
drop-down list and adjust the other Windows 
Print controls as appropriate. 

3 Click OK.  The report pages are printed to a 
PDF file. 

4 Depending on your Adobe Acrobat settings, the 
PDF file may open automatically. 

5 On the Report menu, click Close.  The report 
window closes. 

Print report 1 Click Print.  The Windows Print window opens. 

2 Adjust the Windows Print controls as 
appropriate, then click OK to print the report 
pages.  

3 On the Report menu, click Close.  The report 
window closes. 

Refresh the contents of the 
report 

Click Refresh. 

Show or Hide Group Tree Click Toggle Group Tree. 

Resize (enlarge or shrink) the 
report 

Select the appropriate percentage from the drop-
down list. 

Display first page Click Go to First Page. 
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To Do This 
Display previous page Click Go to Previous Page. 

Display specific page Enter a page number then press <ENTER>. 

Display next page Click Go to Next Page. 

Display last page Click Go to Last Page. 

Search for a string on the 
report 

1 Click Search Text.  The Search dialog opens. 

2 Enter the string you want to search for, then 
click Find Next.  The string is highlighted on the 
report. 

3 To close the Search dialog, click Cancel.  The 
Search dialog closes. 

Close report On the Report menu, click Close.  The report 
window closes. 

 

4 Close the Report Viewer window. 

Review Default Installation Results 

This section is optional.  The instructions provided allow you to review the Taskmaster Client 
database connections, and groups, users, and stations installed by the default installation 
process. 

Prerequisites 
1 Ensure you have met the prerequisites detailed in Chapter 2 Installation and 

Configuration Prerequisites. 

2 Complete the instructions provided to install all of the components on a single machine 
on which you have Administrative rights. 

3 From Datacap, obtain the password you need to use when logging in as the Taskmaster 
“admin” user. 

View Default Database Connections (Vista) 
When you perform the default Datacap Taskmaster installation, it automatically sets up 
Microsoft Access databases and ODBC connections for the default Datacap Taskmaster 
foundation and sample application databases. 

This procedure provides instructions on how to view the ODBC connections that were set up 
automatically by the installation process. 

1 From the Workstation's Windows Start menu, select Control Panel, select System and 
Maintenance, select Administrative Tools, and double-click Data Sources (ODBC). 
When UAC is on, the User Account Control window opens.  Click Continue. 
The ODBC Data Source Administrator window opens. 

2 Click the System DSN tab to display it.  The data sources for the databases are listed. 

3 Click Cancel to close the ODBC Data Source Administrator window.  
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Confirm Local System Account for Taskmaster Server Service (Vista) 
When you perform the default  Datacap Taskmaster installation and configuration on a single 
Workstation, the Taskmaster Server Service uses the Local System account to log onto the 
Workstation.   

This procedure provides instructions on how to confirm the Taskmaster Server Service uses 
the Local System Account. 

1 From the Workstation's Windows Start menu, select Control Panel, select System and 
Maintenance, select Administrative Tools, and double-click Services. 
When UAC is on, the User Account Control window opens.  Click Continue. 
The Services window opens. 

2 Scroll down to the Datacap Taskmaster Server Service, right-click it and select 
Properties from the shortcut menu to open the Datacap Taskmaster Server Service 
Properties dialog.  The General tab is displayed on top. 

3 Click the Log On tab to display it.  By default, the Local System account option is 
selected. 

4 Close the Services window. 

Start or Ensure Taskmaster Server Service is Started (Vista) 
All configurations of Taskmaster (all components installed on a single Workstation or separate 
components installed on different machines) require that the Taskmaster Server Service be 
running before you can successfully start the application. 

This procedure provides instructions on how to start or ensure the Datacap Taskmaster Server 
Service is started when the operating system is Vista. 

1 From the Workstation's Windows Start menu, select All Programs, select Datacap, 
select Taskmaster Server, and click Taskmaster Server.   
When UAC is on, the User Account Control window is displayed - click Allow. 
The TMS Configuration window opens. 

2 When the Status: 

 Shows as Running, continue with the next step. 
 Shows as Stopped, click Start.  A Starting Service message is displayed.  The Status 

changes to Running when the service is started.  
3 Close the TMS Configuration window. 

View APT Taskmaster Client Groups, Users, Stations 
When you perform the default Datacap Taskmaster installation and configuration, some 
Datacap Taskmaster groups, users and passwords, and stations are automatically set up for you 
in the APT foundation application. 

Start APT Taskmaster Client 
This procedure provides instructions on how to start the APT Taskmaster Client application.  If 
you have logged into the Taskmaster Client before, the information you entered previously is 
displayed. 

1 From the Workstation's Windows Start menu, select All Programs, select Datacap, 
select Applications, select APT, and click the APT Client icon.  The Select Taskmaster 
Server dialog opens. 
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2 Enter or ensure the default server IP address of 127.0.0.1 is displayed, and click OK.  A 
Please login window opens. 

3 Ensure the User ID is admin, enter the password provided by Datacap, and ensure the 
Station is set to 1, then click OK. 

4 The APT main window opens with the Operations pane displayed. 

View APT Taskmaster Client Groups 
This procedure provides instructions on how to view the default user security group delivered 
as part of the APT Taskmaster Client. 

1 With the Taskmaster Client main window open, on the Settings menu, select Groups. 
The Taskmaster Administrator dialog opens with the Groups tab displayed on top, and 
the Groups listed in the left pane. 

2 Select a group in the left pane. 

3 In the right pane, completely expand the Privileges, Permissions, and Users branches to 
view the options set for this group.  For example, the "Scanners" group has been 
granted permission to the iVScan and Upload tasks for the Web Demo, Web Demo 
Dot-Matrix, Web Main, and Web Main Dot-Matrix jobs. 

4 Then, do one of the following:  

 Click the Users tab and continue with step 2 in the View APT Taskmaster Client 
Users procedure. 

 Click the Stations tab and continue with step 2 in the View APT Taskmaster 
Client Stations procedure. 

 Click Done to close the Taskmaster Administrator dialog. 
5 If you are finished viewing groups, users, or stations, close the Taskmaster Client 

window.  A confirmation message box is displayed.  Click Yes to close the Taskmaster 
Client window. 

View APT Taskmaster Client Users 
This procedure provides instructions on how to view the default user permissions delivered as 
part of the APT Taskmaster Client. 

1 With the Taskmaster Client main window open, on the Settings menu, select Users. The 
Taskmaster Administrator dialog opens with the Users tab displayed on top and the 
Users listed in the left pane. 

2 Select a user in the left pane. 

3 In the right pane, completely expand the Privileges, Permissions, and Groups branches 
to view the options assigned to this user.  For example, the "scan1" user is part of the 
Scanners group, and has been granted the permissions that were granted to the group. 

4 Then do one of the following:  

 Click the Groups tab and continue with step 2 in the View APT Taskmaster 
Client Groups procedure.  

 Click the Stations tab and continue with step 2 in the View APT Taskmaster 
Client Stations procedure. 

 Click Done to close the Taskmaster Administrator dialog. 
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5 If you are finished viewing groups, users, or stations, close the Taskmaster Client 
window.  A confirmation message box is displayed.  Click Yes to close the Taskmaster 
Client window. 

View APT Taskmaster Client Stations 
This procedure provides instructions on how to view the default station permissions delivered 
as part of the APT Taskmaster Client. 

1 With the Taskmaster Client main window open, on the Settings menu, select Stations. 
The Taskmaster Administrator dialog opens with the Stations tab displayed on top. 

2 Select a station in the left pane. 

3 In the right pane, completely expand the Permissions branches to view the specific 
Tasks this station has permission to run.  For example, the "remote" station has been 
granted permissions to run iVScan, Upload, and Verify tasks. 

4 Do one of the following:  

 Click the Groups tab and continue with step 2 in the View APT Taskmaster 
Client Groups procedure.  

 Click the Users tab and continue with step 2 in the View APT Taskmaster Client 
Users procedure. 

 Click Done to close the Taskmaster Administrator dialog. 
5 If you are finished viewing groups, users, or stations, close the Taskmaster Client 

window.  A confirmation message box is displayed.  Click Yes to close the Taskmaster 
Client window. 

Configure Taskmaster Web on Vista, Windows 2008, IIS 7 Server 

This section provides the information you need to set up Taskmaster Web on either a Vista 
machine (which limits the number of users to five) or a Windows 2008, IIS 7 Server so you 
can use the Taskmaster Web Client for processing. 

Prerequisites 
1 Ensure you have met the prerequisites detailed in Chapter 2 Installation and 

Configuration Prerequisites. 

2 Complete the instructions provided to install all of the components on a single machine 
on which you have Administrative rights. 

3 From Datacap, obtain the password you need to use when logging in as the Taskmaster 
“admin” user. 

Stop or Ensure the Taskmaster Server Service is Stopped (Vista) 
This procedure provides instructions on how to stop or ensure the Datacap Taskmaster Server 
Service is stopped when the operating system is Vista. 

1 From the Workstation’s Windows Start menu, select Programs, select Datacap, select 
Taskmaster Server, and click Taskmaster Server.   
When UAC is on, the User Account Control window is displayed - click Allow. 
The TMS Configuration window opens. The TMS Configuration window opens. 

2 When the Status: 
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 Shows as Stopped, continue with the next step. 
 Shows as Running, click Stop.  A Stopping Service message is displayed.  The 

Status changes to Stopped when the service is stopped.  
3 Close the TMS Configuration window. 

Add or Ensure Upload Limit Setting is Large Enough in web.config (All OS) 
Depending on the usual size of the images that will be uploaded from the Taskmaster Web 
Client, you should adjust the upload limit setting found in the web.config file when the 
operating system is Vista. 

This procedure provides instructions on how to locate and change the setting in the web.config 
file that affects upload speed.  

1 On the Workstation, start Windows Explorer, navigate to and open the 
c:\Datacap\tmweb.net folder, scroll down to the web.config file and open it in a text 
editor such as Notepad. 

2 Within the <system.web> element, locate or add the   
<httpRuntime maxRequestLength="52428" />  
element - this parameter is expressed in kilobytes. 

3 Depending on the usual size of the images that are being uploaded, you can increase the 
size, for example: 
<httpRuntime maxRequestLength="102400" /> 

4 When you have made changes, save and close the file. 

Ensure Required IIS Components are Installed (Vista) 
This procedure provides instructions on how to ensure that the appropriate components have 
been installed in Internet Information Services when the ’Workstation's operating system is 
Vista. 

1 From the ’Workstation's Windows Start menu, select Control Panel, and on the Control 
Panel Home window, select Programs, and double-click Programs and Features.  The 
Programs and Features window opens with a Tasks pane on the left. 

2 In the Tasks pane, select Turn Windows features on or off. 
When UAC is on, the User Account Control window opens.  Click Continue. 
The Windows Features window opens and displays a list of features. 

3 Expand Internet Information Services, expand Web Management Tools, expand IIS 6 
Management Compatibility, and select or ensure IIS Metabase and IIS 6 configuration 
compatibility is selected. 

4 Scroll down and expand World Wide Web Services, expand Application Development 
Features, and select or ensure both ASP and ASP.NET are selected (selecting these 
options ensures other prerequisite features are selected).  

5 Click OK to save your changes.  Windows applies any changes you have made, then 
closes the Windows Features window. 

6 Close the Programs and Features window. 

Set IIS ASP Request Size Limit (Vista, Windows 2008) 
Depending on the usual size of the images that will be processed, you should adjust the default 
Maximum Requesting Entity Body Limit (maxRequestEntityAllowed).  
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This procedure provides instructions on how to locate and change the Maximum Requesting 
Entity Body Limit when the operating system is Vista or Windows 2008.  

1 From the Workstation's Windows Start menu, select Control Panel, and on the Control 
Panel Home window, click System and Maintenance.  The System and Maintenance 
window opens. 

2 Click Administrative Tools.  The Administrative Tools window opens. 

3 Double-click Internet Information Services.   
When UAC is on, the User Account Control window opens.  Click Continue. 
The Internet Information Services (IIS) Manager window opens. 

4 In the Connections pane, select the Workstation.  The Workstation’s Home pane is 
displayed. 

5 In the Home pane, scroll down to the IIS area and double-click ASP.   
If ASP is not displayed, ensure it was installed, then restart IIS and the ASP icon should 
be displayed.   
The ASP properties pane is displayed. 

6 In the Behavior section, expand Limits Properties.  Additional properties are displayed. 

7 Locate Maximum Requesting Entity Body Limit (maxRequestEntityAllowed), change 
the value (expressed in number of bytes) to reflect the appropriate size; for example, 
from 200000 (200 kb) to 10238976 (10MB), then tab out.  The Apply button in the 
Actions pane is enabled. 

8 In the Actions pane, click Apply.  A message box indicates the change was saved. 

9 Close the Internet Information Services (IIS) Manager window. 

Create (Nested) Taskmaster Web Site (Vista, Windows 2008) 
This procedure provides instructions on how to create the Taskmaster web site and set the 
parameters required by Taskmaster Web when Taskmaster Web is installed in a Vista or 
Windows 2008 IIS 7 environment. 

1 From the Workstation's Windows Start menu, select Control Panel, and on the Control 
Panel Home window, click System and Maintenance.  The System and Maintenance 
window opens. 

2 Click Administrative Tools.  The Administrative Tools window opens. 

3 Double-click Internet Information Services.   
When UAC is on, the User Account Control window opens.  Click Continue. 
The Internet Information Services (IIS) Manager window opens with a Connections 
pane on the left. 

4 In the Connections pane, expand the computer on which the web site will reside, and 
expand Sites, right-click the Default Web Site, and select Add Application from 
shortcut menu.  The Add Application dialog opens. 

5 Select or enter the following on the Add Application dialog: 

 Alias:  tmweb.net 
 Application pool: Classic .NET AppPool 
 Physical path:  c:\Datacap\tmweb.net 
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 When running on Windows 2008 x64 (64-Bit), also select Advanced Settings > 
Enable 32-Bit Applications and set to "True" 

 then click OK to save your settings, and OK to close the Add Application dialog. 

6 In the Connections pane, click the Default Web Site, in the far right pane, expand 
Manage Web Site, and click the Configure Limits… link. The Edit Web Site Limits 
dialog opens. 

7 Set the Connection Timeout field to 1200 (seconds), then click OK to save your change 
and close the Edit Web Site Limits dialog. 

8 In the Connections pane, click the Default Web Site, in the middle Default Web Site 
Home pane, in the IIS section, double-click the HTTP Response Headers icon.  The 
HTTP Response Headers pane opens. 

9 In the far right pane, click the Set Common Headers link.  The Set Common HTTP 
Response Headers dialog opens. 

10 Select Expire Web content, select Immediately, then click OK to save your changes and 
close the Set Common HTTP Response Headers dialog. 

11 Close the Internet Information Services (IIS) Manager window.  

Create TaskRun Folder and Set Up Security (Vista, Windows 2008) 
This procedure provides instructions on how to create the TaskRun processing folder required 
by Taskmaster Web.  This folder is where batches temporarily reside while they are being 
processed. 

IMPORTANT 

The TaskRun folder name is case-sensitive, must be named TaskRun, and must be created 
within the c:\Datacap folder structure at the same level as the tmweb.net folder. 

1 On the Workstation, start Windows Explorer, navigate to c:\Datacap, and create a folder 
named TaskRun. (Reminders: Folder name is case-sensitive; create this folder at the 
same level as the c:\Datacap\tmweb.net folder.) 

2 In Windows Explorer, right-click the TaskRun folder, and select Properties from the 
shortcut menu.  The TaskRun Properties dialog opens with the General tab displayed on 
top. 

3 Click the Security tab to display it. 

4 Add NETWORK SERVICE and set to allow Modify; add the local IUSR and set to 
allow Modify. 

5 Click OK to close the TaskRun Properties dialog. 

Set Up TaskRun Virtual Folder (Vista, Windows 2008) 
This procedure provides instructions on how to set up the TaskRun virtual folder required by 
Taskmaster Web. 

1 From the Workstation's Windows Start menu, select Control Panel, and on the Control 
Panel Home window, click System and Maintenance.  The System and Maintenance 
window opens. 

2 Click Administrative Tools.  The Administrative Tools window opens. 
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3 Double-click Internet Information Services.   
When UAC is on, the User Account Control window opens.  Click Continue. 
The Internet Information Services (IIS) Manager window opens with a Connections 
pane on the left. 

4 In the Connections pane, expand the computer on which the Taskmaster web site 
resides, and expand Sites, right-click the Default Web Site, and select Add Virtual 
Directory from shortcut menu.  The Add Virtual Directory dialog opens. 

5 Select or enter the following on the Add Virtual Directory dialog: 

 Alias:  TaskRun (case sensitive) 
 Physical path:  c:\Datacap\TaskRun (case sensitive)  

 then click OK to save your settings and close the Add Virtual Directory dialog. 

 

Install Crystal Reports Runtime (All OS) 
This procedure provides instructions on how to install the Crystal Reports Runtime files that 
are required by Taskmaster Web. 

1 On the Workstation, start Windows Explorer, navigate to c:\Datacap\install\tmweb7cr, 
and double-click the Setup.exe.   
When UAC is on, the User Account Control window opens.  Click Continue. 
The Welcome page of the Web Reports Setup wizard opens. 

2 Click Next.  The Select Installation Address page is displayed with default values in the 
Site and Virtual directory fields. 

3 Change the Virtual directory to tmweb.net, then click Next.  The Confirm Installation 
page is displayed. 

4 Click Next.  The Installing Web Reports page is displayed with progress messages and a 
progress indicator, and when complete, displays the Installation Complete window.  

5 Click Close to exit the installation process and close the wizard. 

Start or Ensure Taskmaster Server Service is Started (Vista) 
All configurations of Taskmaster (all components installed on a single Workstation or separate 
components installed on different machines) require that the Taskmaster Server Service be 
running before you can successfully start the application. 

This procedure provides instructions on how to start or ensure the Datacap Taskmaster Server 
Service is started when the operating system is Vista. 

1 From the Workstation's Windows Start menu, select All Programs, select Datacap, 
select Taskmaster Server, and click Taskmaster Server.   
When UAC is on, the User Account Control window is displayed - click Allow. 
The TMS Configuration window opens. 

2 When the Status: 

 Shows as Running, continue with the next step. 
 Shows as Stopped, click Start.  A Starting Service message is displayed.  The Status 

changes to Running when the service is started.  
3 Close the TMS Configuration window. 
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Configure and Test Internet Explorer 7 or 8 

This section provides the information you need to set up Internet Explorer 7 or 8 so you can 
use the Taskmaster Web Client for processing. 

Prerequisites 
1 Ensure you have met the prerequisites detailed in Chapter 2 Installation and 

Configuration Prerequisites. 

2 Complete the instructions to install all of the components on a single machine to which 
you have Administrative rights. 

3 From Datacap, obtain the password you need to use when logging in as the Taskmaster 
“admin” user. 

Configure Internet Explorer 7 or 8 
This procedure provides instructions on how to configure Internet Explorer 7 or 8 so it can 
communicate with Taskmaster Web.   

1 On the Workstation, start Internet Explorer 7 or 8 and display any web page. 

2 On the Tools menu, select Internet Options.  The Internet Options dialog opens with the 
General tab displayed on top. 

3 Click the Security tab to display it.  

4 Select the Trusted Sites icon and click the Sites button to open the Trusted sites dialog. 

5 Clear the Require server verification option. 

6 Enter the default IP address (http://127.0.0.1) in the Add this website to the zone field, 
then click the Add button.  The site is added to the Websites pane. 

7 Click Close.  The Internet Options dialog reappears with the Security tab displayed on 
top. 

8 Click the Custom level button.  The Security Settings dialog appears. 

9 Scroll down until the ActiveX controls and plug-ins settings are displayed. 

10 The following settings should be Enabled – if an option is not enabled, select its Enable 
option : 

 Download signed ActiveX controls 
 Download unsigned ActiveX controls 
 Initialize and script ActiveX controls not marked as safe for scripting 

11 Scroll down until the Miscellaneous setting are displayed. 

12 Enable (or ensure it is enabled), the Include local directory path when uploading files to 
a server option. 

13 Click OK.  A warning is displayed, asking you to confirm your changes. 

14 Click Yes.  The Internet Options dialog reappears with the Security tab on top. 

15 Click OK to close the Internet Options dialog. 
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Test Internet Explorer 7 or 8 
This procedure provides instructions on how to test your configuration of Internet Explorer 7 
or 8.  

1 Start Internet Explorer. 

2 Enter the default IP address (http://127.0.0.1) followed by the TMWeb.net virtual 
directory and the test page (http://127.0.0.1/TMWeb.net/ietest.aspx) then press <Enter>  
The IE Test page is displayed. 

3 Click Test.  The red Xs will change to green checkmarks when the test completes 
successfully. 

Run APT Taskmaster Web Client Application 

This section provides the information you need to run the Datacap Taskmaster foundation APT 
Taskmaster Web Client application “out of the box.”   

These instructions involve starting the Taskmaster Server Service, starting the Taskmaster 
Web Client, and running the default browser-based tasks to process pre-scanned images.  This 
section also provides instructions for running Taskmaster Web Client reports.  

Overview of APT Taskmaster Web Client 
The default shortcuts you run, and the sequence in which you run them using the APT 
Taskmaster Web Client are as follows: 

 

This shortcut Allows you to 
Scan Process sample, pre-scanned images. 

Upload Move scanned images to the Taskmaster Server Service for 
further processing 

Verify Perform data validation. 

NOTE 

To complete processing, the APT Batch Profiler and Export tasks must be run manually 
from the APT Taskmaster Client (thick client).  Or, in a client/server environment, the APT 
Batch Profiler and Export tasks can be run automatically as background tasks by either the 
Taskmaster Client Service or Datacap Rulerunner Quattro. 

Prerequisites 
1 Ensure you have met the prerequisites detailed in Chapter 2 Installation and 

Configuration Prerequisites. 

2 Complete the instructions provided to install all of the components and to configure 
Taskmaster Web on a single Vista Workstation on which you have Administrative 
rights. 

3 From Datacap, obtain the password you need to use when logging in as the Taskmaster 
“admin” user. 
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Start or Ensure Taskmaster Server Service is Started (Vista) 
All configurations of Taskmaster (all components installed on a single Workstation or separate 
components installed on different machines) require that the Taskmaster Server Service be 
running before you can successfully start the application. 

This procedure provides instructions on how to start or ensure the Datacap Taskmaster Server 
Service is started when the operating system is Vista. 

1 From the Workstation's Windows Start menu, select All Programs, select Datacap, 
select Taskmaster Server, and click Taskmaster Server.   
When UAC is on, the User Account Control window is displayed - click Allow. 
The TMS Configuration window opens. 

2 When the Status: 

 Shows as Running, continue with the next step. 
 Shows as Stopped, click Start.  A Starting Service message is displayed.  The Status 

changes to Running when the service is started.  
3 Close the TMS Configuration window. 

Access Taskmaster Web Login Page and Login 
This procedure provides instructions on how to login to the APT Taskmaster Web Client 
application using Internet Explorer. 

1 Open Internet Explorer, and enter the IP address of the Taskmaster Server Service 
followed by the alias you assigned to the website (http://127.0.0.1/tmweb.net). After a 
pause, the Taskmaster Login window is displayed. 
NOTE:  You may have to turn off Internet Explorer’s popup blocker the first time you 
display the Login page. 

’2 On the Taskmaster Web Login Page, enter the following: 

 

Field Value 
Application APT 

User ID admin 

Password password obtained from Datacap  

Station remote 

 

3 Click Login. The APT Taskmaster Web Client main window opens with the Operations 
pane and Available shortcuts displayed.  

Run APT Taskmaster Web Client Scan Task 
This procedure provides instructions on how to run the APT Taskmaster Web Client virtual 
scan task and begin processing the sample invoices. 

1 On the Workstation, in the Operations pane, click the Scan shortcut.  The list of 
available jobs is displayed. 
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2 Click the Web Demo shortcut.  The Web Demo Scan page is displayed.  The batch 
number assigned to this batch of documents is located in the upper left of the page. By 
default, the Multiple files option is selected. 

3 In the lower right of the page, if necessary change the Scan Into path – this path 
indicates the location into which the pre-scanned images are temporarily placed.  

4 Click Browse, navigate to the folder where the pre-scanned images are located 
(\APT\images), select the first one, then click Open.  The Web Demo Scan page is 
redisplayed with the path to the Source folder. 

5 If you don't want to process all of the sample invoices (four single-page invoices and 
one two-page invoice), change the number in the Expected pages field to the number of 
images (not documents) you want to process, then click Scan.  A window indicates that 
scanning is taking place.  The pages are scanned, images of the pages are displayed, the 
batch-specific name of the folder is appended to the Scan Into path and an End of scan 
message is displayed. 

6 Click OK.  The message box closes.   

7 The following table describes some of the things you can do on the Web Demo Scan 
dialog: 

 

To Do This 
Change sequence of pages Select either the image in the left pane, or 

the name of the image in the right page 
that you want to move, then click either 
the MoveUp or MoveDown arrow 

Delete all pages Click Remove All 

Delete a single page Select the image you want to delete, then 
click Remove 

Enlarge scanned images Click Zoom in 

Shrink scanned images Click Zoom out 

Rotate an image Click Rotate 900 

Complete the Scan Task processing 
of the batch 

Click Done 

Cancel the Scan Task processing of 
the batch; deletes batch and all batch 
data from system 

Click Cancel 

Put the batch on hold and end 
processing of the batch; batch 
remains available to same user  

Click Hold 

 

8 After all images have been scanned, click Done.  A message box is displayed indicating 
the Batch finished with a status of finished. 

9 Click OK.  A message box asks if you want to continue processing.   
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10 Click Stop. The message box closes and the Operations pane is redisplayed. 

11 When the Scan task finishes successfully, the source images have been collected into a 
batch and copied to the batch’s uniquely-numbered folder found in the Scan Into folder. 

12 Click the Monitor tab to view information about the batch.  To refresh the information 
displayed, press F5.  The Job, Task, and Status for this batch have been updated and are 
now Web Demo, Upload, pending. 

Run APT Taskmaster Web Client Upload Task 
This procedure provides instructions on how to run the APT Taskmaster Web Client upload 
task. 

1 On the Workstation, in the Operations pane, click the Upload shortcut.  The Upload 
window opens and A transferring the batch to server message is displayed briefly, then 
closes.  A message box is displayed indicating the batch has finished with a status of 
finished. 

2 Click OK.  A message box asks if you want to continue processing.   

3 Click Stop. The message box closes and the Operations pane is redisplayed. 

4 When the Upload task finishes successfully, the scanned images have been moved to 
the batch’s uniquely-numbered folder found in \APT\batches on the Workstation and 
ivscan and upload xml files have been created.  

5 Click the Monitor tab to view information about the batch.  To refresh the information 
displayed, press F5.  The Job, Task, and Status for this batch have been updated and are 
now Web Demo, Batch Profiler, pending. 

Start APT Taskmaster Client 
This procedure provides instructions on how to start the APT Taskmaster Client application.  If 
you have logged into the Taskmaster Client before, the information you entered previously is 
displayed. 

1 From the Workstation's Windows Start menu, select All Programs, select Datacap, 
select Applications, select APT, and click the APT Client icon.  The Select Taskmaster 
Server dialog opens. 

2 Enter or ensure the default server IP address of 127.0.0.1 is displayed, and click OK.  A 
Please login window opens. 

3 Ensure the User ID is admin, enter the password provided by Datacap, and ensure the 
Station is set to 1, then click OK. 

4 The APT main window opens with the Operations pane displayed. 

Run APT Taskmaster Client Batch Profiler Task (Background Shortcut) (Vista) 
This procedure provides instructions on how to run the APT Taskmaster Client Batch Profiler 
task. 

1 On the Workstation, in the Operations pane, double-click the Background shortcut.  A 
Task Monitor window opens and a Rulerunner window opens displaying a progress bar, 
then they both close.  This may take a few minutes, as Rulerunner is running a number 
of processing-intensive modules, including PageID, ImageFix, CreateDocs, Recognize, 
FindFingerprint, Locate, lookups, and others.  When processing is complete, a message 
box is displayed indicating the task has finished.   
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2 Click OK.  A message box asks if you want to continue processing. 

3 Click No.  The message box closes and the Operations pane is redisplayed.   
When the Batch Profiler task finishes successfully, the images have been organized into 
documents, copies (TIO) have been made of the original images, fingerprint (CCO) and 
page XML files have been created, along with a BatchProfiler.xml file in the batch's 
uniquely-numbered folder in \APT\batches. 

4 To refresh the information displayed in the Job Monitor window, click the Job 
Monitor's title bar and press F5.  The Job.Task and Status for this batch have been 
updated and are now Demo.Verify and pending. 

 

Run APT Taskmaster Web Client Verify Task 
This procedure provides instructions on how to run the Taskmaster Web Client Verify task. 

1 On the Workstation, in the Operations pane, click the Verify shortcut.  The verification 
panel opens with the first image displayed.  

2 The following table describes some of the things you can do on the verification panel: 

To Do This 
Move to the next data field Press <Tab> 

Move to the next low confidence 
character 

Click Next LC 
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To Do This 
Fill empty field with data using Click 
N Key 

Click in the empty data entry field, then 
do one of the following: 

Point at the field value on the image and 
click it, or, 

Click and drag the mouse to draw a 
rectangular box around the existing field 
data on the image 

Complete processing of image and 
display next image 

Click SuBmit 

Mark the document for deletion, 
rescanning, or review 

Select appropriate choice from Routing 
Instructions dropdown list 

Display the first page of the next 
document in the batch without 
submitting or revalidating data 

Click Next Page 

Display the first page of the previous 
document in the batch without 
submitting or revalidating data 

Click Previous Page 

Display the first page, next page, 
previous page, or last page of the 
current document 

Click the Page No |< 
> 
< 
or >| Browse button 

Display the details of the first line 
item, next line item, previous line 
item or last line item 

Click the Lineitem |< 
> 
< 
or >| Browse button 

For all detail lines, locate all field 
values for all fields 

Click Find Details 

Calculate missing numeric values 
using existing values and 
automatically fill blank numeric 
fields 

Click Calculate Blank 

Move to the next problem document 
in the batch 

Click Next Problem 

Move to the previous problem 
document in the batch 

Click Previous Problem 

Identify the type of invoice Select from Invoice Type dropdown list 

Display snippet associated with a 
field 

Select Disp snip 

Create new fingerprint for this 
invoice 

Select Yes from Add New Fingerprint 
dropdown list 
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To Do This 
Put entire batch on hold Click Hold 

Override an error  Select Override 

 

3 When you have finished with the last document and click SuBmit, a message box is 
displayed indicating all documents are complete. 

4 Click OK.  The message box closes and another message box is displayed indicating the 
task on the batch has finished with a status of finished. 

5 Click OK.  A message box asks if you want to continue processing.   

6 Click No.  The message box closes and the Operations pane is redisplayed. 

7 When the Verify task finishes successfully, page XML files have been updated (for 
example, when low confidence characters have been changed during Verify), and a 
Verify.xml file has been created in the batch’s uniquely-numbered folder found in 
\APT\batches on the Workstation. 

8 Click the Monitor tab to view information about the batch.  To refresh the information 
displayed, press F5.  The Job, Task, and Status for this batch have been updated and are 
now Web Demo, Export, pending. 

Run APT Taskmaster Client Export Task (Export Shortcut) (Vista) 
This procedure provides instructions on how to run the APT Taskmaster Client Export task. 

1 On the Workstation, in the Operations pane, double-click the Export shortcut.  A Task 
Monitor window opens and a Rulerunner window opens displaying a progress bar, then 
they both close.  A message box is displayed indicating that the Export task finished. 

2 Click OK.  A message box asks if you want to continue processing. 

3 Click No.  The message box closes and the Operations pane is redisplayed. 
When the Export task finishes successfully: 

• Export saves information about unknown invoices that were successfully 
validated  (creates new fingerprints) so that the next time Taskmaster APT “sees” 
the same invoice, it can identify the vendor and extract the field data using a 
process called Intellocate. 

• An Export XML file has been added to the batch’s uniquely-numbered folder 
found in \APT\batches. 

• Export outputs the field data to XML files.  The XML files and the image files 
are now ready to be input into a back-end application.  

• If you configured Taskmaster APT to send email notifications and then, during 
Verify, you marked an invoice for review or rescan, or deleted an invoice, Export 
also sends the appropriate emails with the marked or deleted image attached as a 
PDF file.  If you did not configure email notifications, the PDFs of the marked or 
deleted images stay in the batch's uniquely-numbered folder in \APT\batches; the 
images and information about the images are not exported.  
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4 To refresh the information displayed in the Job Monitor window, click the Job 
Monitor's title bar and press F5.  The Job.Task and Status for this batch have been 
updated and are now Demo.Export and Job Done.   

 
 

Generate APT Taskmaster Web Client Reports Manually 

This section provides the information you need to run the Datacap Taskmaster sample 
Taskmaster Web Client APT reports “out of the box.”   

Overview of APT Taskmaster Web Client Report Viewer 
The Taskmaster Web Client APT Report Viewer is built into the Taskmaster Web Client and 
you access it from the Reports link on the Monitor pane. 

Prerequisites 
1 Ensure you have met the prerequisites detailed in Chapter 2 Installation and 

Configuration Prerequisites. 

2 Complete the instructions provided to install and configure all of the components on a 
single machine on which you have Administrative rights. 

3 From Datacap, obtain the password you need to use when logging in as the Taskmaster 
“admin” user. 

4 To view actual data on one or more reports, run one or more of the Taskmaster Client or 
Taskmaster Web Client APT tasks. 

5 Ensure the Taskmaster Server Service is started.  
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Create Taskmaster Web Client Reports Manually 
This procedure provides instructions on how to generate Taskmaster Web Client reports 
manually. 

1 With the Taskmaster Web Client Operations window open, click Monitor.  The Job 
Monitor window opens. 

2 Click Reports to display the list of Available reports. 

3 Select the report you want to generate.  A Selected report details pane opens on the 
right.  In the: 

 Available filters portion of the dialog, select a filter (optional) 
 Date portion of the dialog, make changes to indicate the time period to be 

included on the report  
 then click Show Report.  The report is displayed. 

4 Use the buttons and fields on the toolbar as follows: 

 

To Do This 
Export data to PDF file 1 Click Export.  The Export the Report window opens. 

2 Select Acrobat Format (PDF) from the drop-down 
list.  If you want to export a subset of the pages, 
select Pages and enter the From and To page 
numbers. 

3 Click OK.   The report pages are displayed in an 
Adobe Acrobat viewer window. 

4 Click Save to save the report pages as a PDF file, or 
use the other buttons and fields on the toolbar as 
appropriate. 
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To Do This 
Export data to DOC, 
XLS, or RTF file 

1 Start the application (Microsoft Word, Microsoft 
Excel) into which you want to place the report data. 

2 Switch back to the Taskmaster Web Client report 
window, and click Export.  The Export the Report 
window opens. 

3 Select the appropriate file format from the drop-
down list.  If you want to export a subset of the 
pages, select Pages and enter the From and To page 
numbers. 

4 Click OK.  The report pages are displayed in a 
viewer window. 

5 Press <CTRL+ A> and then <CTRL + C> to select 
and copy the contents of the report pages to the 
Windows Clipboard. 

6 Switch to the other application (Microsoft Word, 
Microsoft Excel) and press <CTRL + V> to paste the 
contents of the report into that application. 

7 On the File menu, select Save As, then name and 
save the report in the application's file format.  

Print report 1 Click Print.  The Print the Report window opens.   

2 If you want to print a subset of the pages, select 
Pages and enter the From and To page numbers. 

3 Click OK.  The report pages are displayed in an 
Adobe Acrobat viewer window. 

4 Click Print.  The Windows Print window opens. 

5 Adjust the Windows Print controls as appropriate, 
then click OK to print the report pages.  

6 Close the viewer window. 

Show or Hide Group 
Tree 

Click Show/Hide Group Tree. 

Display first page of 
report 

Click First. 

Display previous page Click Prev. 

Display next page Click Next. 

Display last page of 
report 

Click Last. 

Display specific page Enter a page number then click Go To. 

Search for a string on 
the report 

Enter the string you want to search for, then click 
Find.  The string is highlighted on the report. 
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To Do This 
Resize (enlarge or 
shrink) the report 

Select the appropriate percentage from the drop-
down list. 

Close report and return 
to the list of Available 
reports 

Click << Back to Reports Selection. 

 

5 To close the report and return to the list of reports, click <<Back to Reports Selection.  
The list of Available reports is displayed. 

6 Logoff the Taskmaster Web Client. 

Run Datacap Studio Application 

This section provides the information you need to run the Datacap Studio application.  These 
instructions involve starting the Taskmaster Server Service, and starting Datacap Studio. 

Prerequisites 
1 Ensure you have met the prerequisites detailed in Chapter 2 Installation and 

Configuration Prerequisites. 

2 Complete the instructions provided to install all of the components on a single machine 
on which you have Administrative rights. 

3 From Datacap, obtain the password you need to use when logging in as the Taskmaster 
“admin” user. 

Start or Ensure Taskmaster Server Service is Started (Vista) 
All configurations of Taskmaster (all components installed on a single Workstation or separate 
components installed on different machines) require that the Taskmaster Server Service be 
running before you can successfully start the application. 

This procedure provides instructions on how to start or ensure the Datacap Taskmaster Server 
Service is started when the operating system is Vista. 

1 From the Workstation's Windows Start menu, select All Programs, select Datacap, 
select Taskmaster Server, and click Taskmaster Server.   
When UAC is on, the User Account Control window is displayed - click Allow. 
The TMS Configuration window opens. 

2 When the Status: 

 Shows as Running, continue with the next step. 
 Shows as Stopped, click Start.  A Starting Service message is displayed.  The Status 

changes to Running when the service is started.  
3 Close the TMS Configuration window. 

Start Up Datacap Studio 
This procedure provides instructions on how to start up Datacap Studio.  
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1 From the Workstation's Windows Start menu, select All Programs, select Datacap, 
select Datacap Studio, and select Datacap Studio again.  A Taskmaster Server dialog 
opens.  

2 Enter or ensure the Server name or address is 127.0.0.1, then click Next.  A Connection 
progress bar is displayed briefly, then the Select Application – Rulerunner Service 
dialog opens. 

3 Select the Work offline. Internal Rulerunner service option, then click Next.  The Select 
Application – Applications dialog opens. 

4 Select the appropriate application and click Next.  A Connection Progress window is 
displayed briefly, then the Select Application – Taskmaster Login dialog opens. 

5 Select the Taskmaster authentication option, and ensure the User ID is admin, enter the 
password provided by Datacap, and ensure the Station is set to 1, then click Finish.  The 
Datacap Studio main window opens with the Rulemanager tab displayed on top. 
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Chapter 4 
Install, Configure, and Run on Client and 

Server 

This chapter provides the information you need to install, configure, and run Datacap 
Taskmaster 7.6 Server, Web, various services, and Clients in a client/server, Windows desktop 
and/or web-based environment for development, test, and production purposes.  It also 
includes instructions that guide you through using the APT foundation application so you can 
see it process sample batches of documents. 

The server ("Server") hosts the Taskmaster Server, the applications, batch files, and databases. 
For the Server, these instructions cover Vista (which limits the number of users to five), as 
well as Windows 2000, Windows 2003, and Windows 2008.  

The workstation ("Workstation") hosts the thick clients (Taskmaster Client, Report Viewer, 
Datacap Studio, etc.) and the browser.  For the Workstation, these instructions cover Vista, and 
Internet Explorer 6, 7, and 8. 

An optional, separate server ("RRServer") hosts Rulerunner running as a web service.  For 
RRServer, these instructions cover Windows 2003. 

These instructions also include account settings for five types of users:  Developers with 
administrative rights on both Server and Workstation, the Taskmaster Server Service, 
Taskmaster Client Service, Rulerunner running as a web service, and end users.  

Following these instructions enables you to set up and run each of the Taskmaster software 
components "out of the box" in a client/server environment, including: 

• Taskmaster Server Service 

• Datacap Studio Application Wizard 

• Taskmaster Client APT processing 

• Taskmaster Client APT Report Viewer 

• Taskmaster Web 

• Taskmaster Web Client APT processing 

• Taskmaster Web Client APT report generation  

• Datacap Studio 

• Taskmaster Client Service 

• Running Taskmaster using Windows Authentication 

• Rulerunner running as a web service 
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The sections are sequenced deliberately, as some items in later sections depend on steps from 
the previous sections having been completed successfully. 

For a checklist of the account and configuration settings, see Appendix B Client/Server 
Setup Checklist. 

WARNINGS 

The steps for installing and configuring on more than one machine are significantly 
different than the steps for installing on a single machine.  For information on how to 
install on a single machine, see Chapter 3 Install, Configure, and Run on Single Vista 
Machine.  

While the installation package (Setup.exe) can be located anywhere (for example, on an 
accessible network drive, or in the Server's or Workstation's CD/DVD drive), the 
destination of the installed software must be on a physical hard drive of the machine 
from which you run the Setup.exe.   

Your initial Taskmaster software installation must be into the c:\Datacap folder on the 
Server and Workstation.  If you do not use this installation path, the foundation (APT, 
Flex) and sample (Survey, Express) applications will not function. 

Overview of Taskmaster Installation on Client and Server 

The Taskmaster installation, configuration, and run processes are performed in the following 
sequence (the foundation application, APT, is used as the example throughout this 
documentation): 

1 Ensure you have met the prerequisites detailed in Chapter 2 Installation and 
Configuration Prerequisites. 

2 Install the Taskmaster Server, Taskmaster Web, and Support Files software components 
on the Server. 

3 On Windows 2000 Server, also install the scripting program. 

4 Reboot the Server. 

5 Configure Taskmaster on the Server. 

6 Install the Taskmaster Client, Support Files, and Documentation software components 
on the Workstation. 

7 Reboot the Workstation. 

8 Configure Taskmaster Client on the Workstation. 

9 Copy the APT application to the Server. 

10 Complete Server configuration. 

11 Run Taskmaster Client. 

12 Configure Taskmaster Web on Server. 

13 Configure Internet Explorer on Workstation. 

14 Run Taskmaster Web Client. 

15 Configure Taskmaster Client Service. 
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16 Run Taskmaster Client Service. 

17 Configure Rulerunner as a web service. 

18 Run Taskmaster Client application using Rulerunner running as a web service. 

19 Configure Taskmaster to use Windows Authentication 

20 Run Taskmaster Client application using Windows Authentication 

Installation Instructions for Server 

This section provides the information you need to install the appropriate Datacap Taskmaster 
components on your Server.  

Ensure Prerequisites are Met 
Ensure you have met the prerequisites detailed in Chapter 2 Installation and Configuration 
Prerequisites.  

Install Taskmaster Server, Web, and Support Components on Server 
This procedure provides instructions on how to run the Taskmaster InstallShield Wizard on a 
Server to install the Taskmaster Server, Taskmaster Web, and Support software components, 
and then reboot the machine.  

These instructions apply to Vista (which limits the number of users to five), Windows 2003, 
and Windows 2008 Server.  If you are installing on Windows 2000 Server, follow these 
instructions and the instructions in Install Other Third-Party Software for installing the 
scripting program required by Taskmaster. 

WARNINGS 

The steps for installing and configuring on more than one machine are significantly 
different than the steps for installing on a single machine.  For information on how to 
install on a single Vista machine, see Chapter 3 Install, Configure, and Run on Single 
Vista Machine.  

While the installation package (Setup.exe) can be located anywhere (for example, on an 
accessible network drive, in the Server's CD/DVD drive), the destination of the 
installed software must be on a physical hard drive of the machine from which you run 
the Setup.exe.   

Your initial Taskmaster software installation must be into the c:\Datacap folder on the 
Server.  If you do not use this installation path, the foundation (APT, Flex) and sample 
(Survey, Express) applications will not function. 

1 Make the installation package available on your network, or insert the Taskmaster CD 
in the Server’s CD/DVD drive.  If the installation process does not start automatically, 
or if the package is on the network, open Windows Explorer, navigate to and double-
click the Setup.exe. 
When UAC is on, the User Account Control window opens.  Click Allow. 
The Taskmaster Setup InstallShield Wizard opens.   

2 If the Microsoft MSXML 6.0 Parser:  

 Is not yet installed on the Server, the window contains a message about this 
requirement:  Click Install.  A progress window is displayed and then closes. 
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 Is installed, the installation process continues to the next step. 
3 The InstallShield Wizard displays a Preparing to Install... window followed by the 

InstallShield Wizard Welcome window. 

4 Click Next. The License Agreement window opens. 

5 Click I accept the terms in the license agreement and click Next.  The Setup Type 
window is displayed with the Complete option selected. 

6 Select the Custom option, then click Next.  The Custom Setup window is displayed. 

7 Click the drive icon to the left of Taskmaster Client, and select This feature will not be 
available.  The drive icon is replaced by a red X. 

8 Click the drive icon to the left of Documentation, and select This feature will not be 
available.  The drive icon is replaced by a red X. 

9 Click Next.  The Ready to Install the Program window is displayed. 

10 Click Install.  The Installation Wizard displays progress messages and a progress 
indicator, and when complete, displays the InstallShield Wizard Complete window. 

11 Click Finish.  A prompt to reboot your machine is displayed. 

12 If you are installing on:  

 Windows 2000, click No, continue with the instructions below in Install Other 
Third-Party Software, and then reboot the Server.  

 Vista, Windows 2003, or Windows 2008, if you want to install one or more sets 
of scripting documentation, click No, and continue with the instructions in Install 
Other Third-Party Software, and then reboot the Server. 

 Otherwise, click Yes to reboot the Server. 

Install Other Third-Party Software 
When you are installing on Windows 2000, this procedure provides instructions on how to 
locate the instructions for installing the scripting program required by Taskmaster.  

When you are installing on Vista, Windows 2003, and Windows 2008, this procedure provides 
instructions on how to locate the instructions for installing one or more sets of scripting 
documentation. 

1 On the Server, open Windows Explorer, navigate to c:\Datacap\support\download, and 
open the readme.txt file. 

2 If you are installing on Windows 2000, follow the instructions in the readme.txt file to 
install the appropriate scripting program. 

3 Optionally, when installing on any operating system, follow the instructions in the 
Optional Utilities/Documents to Install section of the readme.txt file to install one or 
more sets of scripting documentation. 

4 Close the readme.txt file and Windows Explorer. 

Reboot Server after Install 
After completing the Taskmaster Installation process, reboot the Server. 
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Configure Taskmaster on Server 

This section provides the information you need to set up Taskmaster on the Server.  All of the 
Taskmaster components require the Taskmaster Server Service to function, and the appropriate 
folder and security permissions must be granted.  

Create or Ensure Account Exists for Taskmaster Server Service 
When you perform the default Datacap Taskmaster installation and configuration, the 
Taskmaster Server Service uses the Local System account to log onto the Server.  

In a client/server environment, create or ensure a specific domain account exists for the 
Taskmaster Server Service.  

Grant Taskmaster Server Service Log On as a Service Right 
This procedure provides instructions on how to ensure the domain account used by the 
Taskmaster Server Service has been granted the Log On as a Service right on the Server, and 
optionally, change the Service's start-up behavior when the Server is rebooted. 

1 From the Server's Windows Start menu, select Control Panel, on Vista select System 
and Maintenance, select Administrative Tools, and double-click Services. 
When UAC is on, the User Account Control window opens.  Click Continue. 
The Services window opens. 

2 Right-click Datacap Taskmaster Server Service and select Properties.  The Datacap 
Taskmaster Server Service Properties dialog opens with the General tab displayed on 
top. 

3 If you want the Taskmaster Server Service to start automatically when the Server is 
rebooted, change the Startup Type to Automatic and click Apply to save your change. 

4 Click the Log On tab to display it, then select This account.  The Browse button is 
enabled. 

5 Locate or enter the domain name, user name and password of the Taskmaster Server 
Service, and click Apply.  A message is displayed confirming the user was granted the 
Log On as a Service right. 

6 Click OK to close the message box. 

7 Click OK to close the Datacap Taskmaster Server Service Properties dialog. 

8 Close the Services window. 

Ensure Accounts Exist for End Users 
Ensure domain/Windows accounts exist for your end users.  

Share Datacap Folder and Set Sharing Permissions (Vista, Windows 2008) 
This procedure provides instructions on how to set up the appropriate sharing permissions for 
the c:\Datacap folder when the Server's operating system is Vista or Windows 2008. 

1 On the Server, start Windows Explorer, navigate to and right-click the c:\Datacap folder 
and select Properties.  The Properties dialog opens with the General tab displayed. 

2 Click the Sharing tab to display it, then click Advanced Sharing. 
When UAC is on, the User Account Control window is displayed.  Click Continue. 
The Advanced Sharing dialog opens. 
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3 Click Share this Folder and keep Datacap as the Share name.  

4 Click Permissions.  The Permissions for Datacap dialog is displayed. 

5 Add NETWORK SERVICE and add local IUSR and allow Full Control. 

6 Add/ensure Domain/Windows User IDs of developers are set to allow Full Control. 

7 Add/ensure Domain/Windows User ID of Taskmaster Server Service is set to allow Full 
Control. 

8 When Batches folders are staying on Server in c:\Datacap\Application, add/ensure 
Domain/Windows User IDs of Taskmaster end users are set to allow Full Control. 

Share Datacap Folder and Set Sharing Permissions (Windows 2000, Windows 2003) 
This procedure provides instructions on how to set up the appropriate sharing permissions for 
the c:\Datacap folder when the Server's operating system is Windows 2000 or Windows 2003. 

1 On the Server, start Windows Explorer, navigate to and right-click the c:\Datacap folder 
and select Sharing and Security.  The Sharing tab is displayed. 

2 Click Share this Folder and keep Datacap as the Share name.  

3 Click Permissions.  The Permissions for Datacap dialog is displayed. 

4 Add ASP.NET Machine Account (Server\ASPNET) and set to allow Full Control;  add 
Internet Guest Account (Server\IUSR_SERVER) and set to allow Full Control. 

5 Add/ensure Domain/Windows User IDs of developers are set to allow Full Control. 

6 Add/ensure Domain/Windows User ID of Taskmaster Server Service is set to allow Full 
Control. 

7 When Batches folders are staying on Server in c:\Datacap\Application path, add/ensure 
Domain/Windows User IDs of Taskmaster end users are set to allow Full Control. 

Set Up Security on Shared Folder (Vista, Windows 2008) 
This procedure provides instructions on how to set up the appropriate security for the 
c:\Datacap folder when the Server's operating system is Vista or Windows 2008. 

1 On the Server, start Windows Explorer, navigate to and right-click the c:\Datacap folder 
and select Properties.  The Properties dialog opens with the General tab displayed. 

2 Click the Security tab to display it, then click Edit. 
When UAC is on, the User Account Control window is displayed.  Click Continue. 
The Permissions for Datacap dialog opens. 

3 Add/ensure Domain/Windows User IDs of developers who can change existing 
Taskmaster applications are set to allow Read & Execute (this developer cannot create 
new applications). 

4 Add/ensure Domain/Windows User IDs of developers who can create new Taskmaster 
applications in the c:\Datacap folder are set to allow Full Control.  

5 Add/ensure Domain/Windows User ID of Taskmaster Server Service is set to allow 
Read & Execute. 

6 When Batches folders are staying on Server in c:\Datacap\Application path, add/ensure 
Domain/Windows User IDs of Taskmaster end users are set to allow Read & Execute. 
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Set Up Security on Shared Folder (Windows 2000, Windows 2003) 
This procedure provides instructions on how to set up the appropriate security for the 
c:\Datacap folder when the Server's operating system is Windows 2000 or Windows 2003. 

1 On the Server, start Windows Explorer, navigate to and right-click the c:\Datacap folder 
and select Sharing and Security.  The Sharing tab is displayed. 

2 Click the Security tab to display it. 

3 Add/ensure Domain/Windows User IDs of developers who can change existing 
Taskmaster applications are set to allow Read & Execute (this developer cannot create 
new applications). 

4 Add/ensure Domain/Windows User IDs of developers who can create new Taskmaster 
applications in the c:\Datacap folder are set to allow Full Control. 

5 Add/ensure Domain/Windows User ID of Taskmaster Server Service is set to allow 
Read & Execute.  

6 When Batches folders are staying on Server in c:\Datacap\Application path, add/ensure 
Domain/Windows User IDs of Taskmaster end users are set to allow Read & Execute. 

Ensure TMServer's Registry Points to TMServer 
Edit or ensure that the Server's Windows registry RRS\locations\rrs key reflects the UNC name 
of the TMServer (rather than C:\) and the path to the \\Server\Datacap\RRS folder. 

Regedit:  HKEY_LOCAL_MACHINE > SOFTWARE > DATACAP > RRS> locations > rrs 
should reflect:  \\Server\Datacap\RRS\ 

Start or Ensure Taskmaster Server Service is Started 
All configurations of Taskmaster (all components installed on a single Workstation or separate 
components installed on different machines) require that the Taskmaster Server Service be 
running before you can successfully start the application. 

This procedure provides instructions on how to start or ensure the Datacap Taskmaster Server 
Service is started on the Server. 

1 From the Server's Windows Start menu, select All Programs, select Datacap, select 
Taskmaster Server, and click Taskmaster Server.  The TMS Configuration window 
opens. 

2 When the Status: 

 Shows as Running, continue with the next step. 
 Shows as Stopped, click Start.  A Starting Service message is displayed.  The Status 

changes to Running when the service is started.  
If a Taskmaster Server Service error is displayed 
See the instructions in Configure Taskmaster on Server to re-grant Taskmaster Server 
Service Log On as a Service Right. 

3 Close the TMS Configuration window. 
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Installation Instructions for Workstation 

This section provides the information you need to install the appropriate Datacap Taskmaster 
components on your Workstation so you can run the Taskmaster Client, Report Viewer, 
AutoDelete client software, or Datacap Studio and other developer tools.  

Ensure Prerequisites are Met 
Ensure you have met the prerequisites detailed in Chapter 2 Installation and Configuration 
Prerequisites. 

Install Taskmaster Client, Support, and Documentation Components on Workstation 
This procedure provides instructions on how to run the Taskmaster InstallShield Wizard on a 
Workstation to install the Taskmaster Client, Support, and Documentation software 
components, and then reboot the machine.  

These instructions apply to Vista. 

WARNINGS 

The steps for installing and configuring on more than one machine are different than 
the steps for installing on a single machine.  For information on how to install on a 
single Vista machine, see Chapter 3 Install, Configure, and Run on Single Vista 
Machine.  

While the installation package (Setup.exe) can be located anywhere (for example, on an 
accessible network drive, in the Workstation's CD/DVD drive), the destination of the 
installed software must be on a physical hard drive of the machine from which you run 
the Setup.exe.   

Your initial Taskmaster software installation must be into the c:\Datacap folder on the 
Workstation.  If you do not use this installation path, the foundation (APT, Flex) and 
sample (Survey, Express) applications will not function. 

1 Make the installation package available on your network, or insert the Taskmaster CD 
in the Workstation’s CD/DVD drive.  If the installation process does not start 
automatically, or if the package is on the network, open Windows Explorer, navigate to 
and double-click the Setup.exe.  
When UAC is on, the User Account Control window opens.  Click Allow. 
The Taskmaster Setup InstallShield Wizard opens.  

2 The InstallShield Wizard displays a Preparing to Install... window followed by the 
InstallShield Wizard Welcome window. 

3 Click Next. The License Agreement window opens. 

4 Click I accept the terms in the license agreement and click Next.  The Setup Type 
window is displayed with the Complete option selected. 

5 Select the Custom option, then click Next.  The Custom Setup window is displayed. 

6 Click the drive icon to the left of Taskmaster Server, and select This feature will not be 
available.  The drive icon is replaced by a red X. 

7 Click the drive icon to the left of Taskmaster Web, and select This feature will not be 
available.  The drive icon is replaced by a red X. 
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8 Click Next.  The Ready to Install the Program window is displayed. 

9 Click Install.  The Installation Wizard displays progress messages and a progress 
indicator, and when complete, displays the InstallShield Wizard Complete window. 

10 Click Finish.  A prompt to reboot your machine is displayed. 

11 Click Yes to reboot the Workstation. 

Reboot Workstation after Install 
After completing the Taskmaster Installation process, reboot the Workstation. 

Install Scanner 
Install a scanner on the Workstation, and ensure the scanner works outside of Taskmaster. 

Note:  A physical scanner is not required for running the Datacap foundation or sample 
applications, as those applications can use the prescanned images included during installation. 

Prepare for Copying APT Application to Server 

If you have never run the APT Taskmaster Client application, skip the instructions in this 
section as the Workstation’s Windows Registry will not have been changed to locate the 
Server, there will not be any batches to delete, and the settings to access the application have 
not yet been established.  Continue with the instructions in Copy APT Application to Server. 

If you have run the APT Taskmaster Client application, this section provides the instructions 
you need to delete all test batches in preparation for copying the APT application from the 
Workstation to the Server so a clean copy of the application can be accessed by other 
workstations that are running the Taskmaster Client or Taskmaster Web Client.   

Start or Ensure Taskmaster Server Service is Started (Vista) 
All configurations of Taskmaster (all components installed on a single Workstation or separate 
components installed on different machines) require that the Taskmaster Server Service be 
running before you can successfully start the application. 

This procedure provides instructions on how to start or ensure the Datacap Taskmaster Server 
Service is started when the operating system is Vista. 

1 From the Workstation's Windows Start menu, select All Programs, select Datacap, 
select Taskmaster Server, and click Taskmaster Server.   
When UAC is on, the User Account Control window is displayed - click Allow. 
The TMS Configuration window opens. 

2 When the Status: 

 Shows as Running, continue with the next step. 
 Shows as Stopped, click Start.  A Starting Service message is displayed.  The Status 

changes to Running when the service is started.  
3 Close the TMS Configuration window. 

Start or Ensure Taskmaster Server Service is Started 
All configurations of Taskmaster (all components installed on a single Workstation or separate 
components installed on different machines) require that the Taskmaster Server Service be 
running before you can successfully start the application. 
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This procedure provides instructions on how to start or ensure the Datacap Taskmaster Server 
Service is started on the Server. 

1 From the Server's Windows Start menu, select All Programs, select Datacap, select 
Taskmaster Server, and click Taskmaster Server.  The TMS Configuration window 
opens. 

2 When the Status: 

 Shows as Running, continue with the next step. 
 Shows as Stopped, click Start.  A Starting Service message is displayed.  The Status 

changes to Running when the service is started.  
If a Taskmaster Server Service error is displayed 
See the instructions in Configure Taskmaster on Server to re-grant Taskmaster Server 
Service Log On as a Service Right. 

3 Close the TMS Configuration window. 

Start APT Taskmaster Client 
This procedure provides instructions on how to start the APT Taskmaster Client application.  If 
you have logged into the Taskmaster Client before, the information you entered previously is 
displayed. 

1 From the Workstation's Windows Start menu, select All Programs, select Datacap, 
select Applications, select APT, and click the APT Client icon (the target of this icon 
should be pointing to the local TMClient.exe with parameters pointing to the 
APTAdm.mdb and APTEng.mdb in the application's process folder on the \\Server).  
The Select Taskmaster Server dialog opens. 

2 Enter the Server name (without initial backslashes) or IP address of the Server hosting 
the application and click OK.  A Please login window opens. 

3 Ensure the User ID is admin, enter the password provided by Datacap, and ensure the 
Station is set to 1, then click OK. 

4 The APT main window opens with the Operations pane displayed. 

Delete All APT Batches 
This procedure provides instructions on how to delete existing batches and associated batch 
information in the APT Engine database using the Job Monitor window. 

1 On the Workstation, with the APT main window open, on the View menu, select Job 
Monitor.  The Job Monitor window opens with information about existing batches 
displayed. 

2 Select all of the rows displayed, and press <Del>.  A Deleting batches message box 
appears. 

3 Ensure the Delete Job Monitor records and all files option is selected, then click Yes.  A 
message box appears identifying the first batch folder to be deleted, and prompting you 
to confirm you want to continue with the deletion. 

4 Click OK to All.  The message boxes close. 

5 Press <F5> to refresh the Job Monitor window.  The window should now be empty; if it 
is not, go back and repeat from step 2 to delete all APT batches and batch information 
in the Engine database. 
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6 Close the APT window.  A message box prompts you to confirm you want to quit. 

7 Click Yes.  Taskmaster Client shuts down. 

Copy APT Application to Server 

Overview of Copying APT to Server 
This section provides the information you need to start the Datacap Studio Application Wizard, 
and copy the APT sample application from the Workstation to the Server so that the 
application can be accessed by other workstations that are running the Taskmaster Client or 
Taskmaster Web Client. 

If you want to access the copied application using the Taskmaster Web Client, additional setup 
instructions are included in the configuration instructions for Taskmaster Web. 

Start Datacap Studio to Use Application Wizard 
This procedure provides instructions on how to start Datacap Studio on the Workstation 
without opening an application.  

1 From the Workstation's Windows Start menu, select All Programs, select Datacap, 
select Datacap Studio, and select Datacap Studio again.  A Taskmaster Server dialog 
opens. 

2 Click Close.  An empty Datacap Studio main window opens with the Rulemanager tab 
displayed on top. 

Copy APT Application to Server 
This procedure provides instructions on how to copy the APT sample application from the 
Workstation to the Server using the Datacap Studio Application Wizard so local and remote 
clients can access it. 

1 On the Workstation, with an empty Datacap Studio main window open, click the 
Application Wizard button in the upper right.  The Application Wizard – Overview 
window is displayed. 

2 Click Next.  The Application Wizard – Wizard Mode window is displayed. 

3 Select the Copy an existing RRS application option, then click Next.  The Application 
Wizard – Copy an existing application window is displayed. 

4 Enter or use the browse button and Browse For Folder window to navigate to and select 
or create the following: 

 

Field Description Example 
Source RRS 
Application 
Library folder 

Location on the Workstation of 
the source application’s 
\RRS\Libs\AppName folder 

c:\Datacap\RRS\Libs\APT 

Libraries folder 
on target system 

Target location on the Server 
of the application’s \RRS\Libs 
folder 

\\Server\Datacap\RRS\Libs 
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Field Description Example 
Root folder on 
target system  

Target location on the Server 
where the new application 
folder will be created  

\\Server\Datacap 

Taskmaster 
folder on target 
system 

Location where the Taskmaster 
Client software is installed on 
the Workstation  

c:\Datacap 

tmweb.net 
folder path 

Location of the tmweb.net 
folder on the Server 

\\Server\Datacap\tmweb.net 

Rename Copy Indicates that you want the 
new application to have a 
different name than the original 
APT application 

N/A 

New Name Name of the new application N/A 

 

5 Click Next.  The Application Wizard – Finish window is displayed. 

6 Click Finish to begin the copying process.  The wizard makes a copy of the APT 
application in the new location on the Server, then performs search-and-replace 
operations throughout the application to make all required changes.  Messages and 
progress bars are displayed, and when the process is complete, the Application Wizard 
– Summary window is displayed with one or more of the following: 
Warnings – Indicate the wizard encountered something unexpected, but could continue. 
General – Lists the results completed successfully. 
Errors  – Indicate the wizard encountered a problem that must be corrected.   

7 Click View Logs to open the appwiz.log file found in the \\Server\Datacap\NewApp 
folder and search for "error" and "warning" to locate issues you need to address.  The 
appwiz.log contains a list of the changes to the application made by the wizard, 
including: 

Type of Change Information Logged 
Rename Databases Displays Before and After values 

Rename Files within Folders  Displays Before and After values 

Update Contents of Databases Displays messages identifying what was 
updated, Displays Before and After values 

Update Strings within Project Files Displays Before and After values 

Update Parameters in Rule Files 
(.rul) 

When changed: displays Before and After 
values  When not changed: displays 
Information Message – you decide if it needs 
to be changed, and if so, change it manually 

Updates Values in Collection.xml Displays Before and After values 

Updates Fingerprint Database 
Name  

Displays Application.xml 
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8 When the application copy is successful, a Taskmaster Client shortcut is created on the 
Workstation that runs the local (Workstation's) Taskmaster Client executable, and 
accesses the Admin and Engine databases and the newly created application on the 
Server.  The new application's Taskmaster Client shortcut is also placed in the new 
application's folder on the Server so that you can copy it to other Workstations where 
the Taskmaster Client component has been installed.    

9 Exit from Datacap Studio. 

Ensure Workstation's Registry Points to TMServer 
Edit or ensure that the Workstation's Windows registry RRS\locations\rrs key reflects the UNC 
name of the TMServer (rather than C:\) and the path to the \\Server\Datacap\RRS folder. 

Regedit:  HKEY_LOCAL_MACHINE > SOFTWARE > DATACAP > RRS> locations > rrs 
should reflect:  \\Server\Datacap\RRS\  

Create Shortcuts to Newly Created Application 
When the Datacap Studio Application Wizard is not successful in creating connection strings 
for the newly created application, it does not automatically create a Taskmaster Client 
application shortcut. 

WARNING 

Taskmaster uses connection strings in the Taskmaster Client shortcut, Report Viewer 
shortcut, AutoDelete shortcut, in ICP files, the Taskmaster Web Client APPS.INI file, and in 
many other places, and supports a number of different formats for connection strings.  
When you are creating shortcuts, be aware that ALL connection strings used within a 
Taskmaster application must be in the same format.   

Use the information in the Taskmaster Administrator's Guide, Appendix A - Connection 
Strings to create the shortcuts you need and to ensure all connection strings within the 
application have the same format. 

Complete Server Configuration 

This section provides the information you need to complete the configuration of your 
Taskmaster Server.  

Stop or Ensure Taskmaster Server Service is Stopped 
This procedure provides instructions on how to stop or ensure the Datacap Taskmaster Server 
Service is stopped on the Server. 

1 From the Server's Windows Start menu, select Programs, select Datacap, select 
Taskmaster Server, and click Taskmaster Server.  The TMS Configuration window 
opens. 

2 When the Status: 

 Shows as Stopped, continue with the next step. 
 Shows as Running, click Stop.  A Stopping Service message is displayed.  The 

Status changes to Stopped when the service is stopped.  
3 Close the TMS Configuration window. 



Installation & Configuration Guide 

Page 64 Confidential and Proprietary Information of Datacap Inc. 

 Copyright © 2010 Datacap Inc. 

Set Up Security on RRS\Libs Folder (Windows 2000, Windows 2003) 
This procedure provides instructions on how to set up the appropriate security permissions for 
the c:\Datacap\RRS\Libs folder on the Server when the Server's operating system is Windows 
2000 or Windows 2003. 

1 On the Server, start Windows Explorer, navigate to and right-click the 
c:\Datacap\RRS\Libs folder and select Sharing and Security.  The Sharing tab is 
displayed. 

2 Click the Security tab to display it. 

3 Add ASP.NET Machine Account (Server\ASPNET) and set to allow Read & Execute; 
add Internet Guest Account (Server\IUSR_SERVER) and set to allow Read & Execute.  

Set Up Security on RRS\Libs Folder (Vista, Windows 2008) 
This procedure provides instructions on how to set up the appropriate security permissions for 
the c:\Datacap\RRS\Libs folder on the Server when the Server's operating system is Vista or 
Windows 2008. 

1 On the Server, start Windows Explorer, navigate to and right-click the 
c:\Datacap\RRS\Libs folder and select Properties.  The Properties dialog opens with the 
General tab displayed. 

2 Click the Security tab to display it. 

3 Add NETWORK SERVICE and local IUSR and set to allow Read & Execute. 

Set Up Security on RRS\Libs\Application Folder (Windows 2000, Windows 2003) 
This procedure provides instructions on how to set up the appropriate security permissions for 
the c:\Datacap\RRS\Libs\Application folder on the Server when the Server's operating system 
is Windows 2000 or Windows 2003. 

Repeat these instructions for each c:\Datacap\RRS\Libs\Application folder on the Server - 
setting up these security permissions at this level allows you to grant access to different 
applications to specific developers and end users. 

1 On the Server, start Windows Explorer, navigate to and right-click the 
c:\Datacap\RRS\Libs\Application folder and select Sharing and Security.  The Sharing 
tab is displayed. 

2 Click the Security tab to display it. 

3 Add/ensure Domain/Windows User ID of developer is set to allow Full Control. 

4 Add/ensure Domain/Windows User ID of Taskmaster Server Service is set to allow Full 
Control. 

5 When Batches folders are staying on Server in c:\Datacap\Application path, add/ensure 
Domain/Windows User IDs of Taskmaster end users are set to allow Full Control. 

Set Up Security on RRS\Libs\Application Folder (Vista, Windows 2008) 
This procedure provides instructions on how to set up the appropriate security permissions for 
the c:\Datacap\RRS\Libs\Application folder on the Server when the Server's operating system 
is Vista or Windows 2008. 



Taskmaster 7.6 

Confidential and Proprietary Information of Datacap Inc. Page 65 
Copyright © 2010 Datacap Inc. 

Repeat these instructions for each c:\Datacap\RRS\Libs\Application folder on the Server - 
setting up these security permissions at this level allows you to grant access to different 
applications to specific developers and end users. 

1 On the Server, start Windows Explorer, navigate to and right-click the 
c:\Datacap\RRS\Libs\Application folder and select Properties.  The Properties dialog 
opens with the General tab displayed.  

2 Click the Security tab to display it. 

3 Add/ensure Domain/Windows User ID of developer is set to allow Full Control. 

4 Add/ensure Domain/Windows User ID of Taskmaster Server Service is set to allow Full 
Control. 

5 When Batches folders are staying on Server in c:\Datacap\Application path, add/ensure 
Domain/Windows User IDs of Taskmaster end users are set to allow Full Control. 

Set Up Security on Datacap\Application Folder (Windows 2000, Windows 2003) 
This procedure provides instructions on how to set up the appropriate security permissions for 
the c:\Datacap\Application folder on the Server when the Server's operating system is 
Windows 2000 or Windows 2003. 

Repeat these instructions for each c:\Datacap\Application folder - setting up these security 
permissions at this level allows you to grant access to different applications to specific 
developers and end users. 

1 On the Server, start Windows Explorer, navigate to and right-click the 
c:\Datacap\Application folder and select Sharing and Security.  The Sharing tab is 
displayed. 

2 Click the Security tab to display it. 

3 Add ASP.NET Machine Account (Server\ASPNET) and set to allow Full Control;  add 
Internet Guest Account (Server\IUSR_SERVER) and set to allow Full Control.  

4 Add/ensure Domain/Windows User ID of developer is set to allow Full Control. 

5 Add/ensure Domain/Windows User ID of Taskmaster Server Service is set to allow Full 
Control. 

6 When Batches folders are staying on Server in c:\Datacap\Application path, add/ensure 
Domain/Windows User IDs of Taskmaster end users are set to allow Full Control. 

Set Up Security on Datacap\Application Folder (Vista, Windows 2008) 
This procedure provides instructions on how to set up the appropriate security permissions for 
the c:\Datacap\Application folder on the Server when the Server's operating system is Vista or 
Windows 2008. 

Repeat these instructions for each c:\Datacap\Application folder on the Server - setting up 
these security permissions at this level allows you to grant access to different applications to 
specific developers and end users. 

1 On the Server, start Windows Explorer, navigate to and right-click the 
c:\Datacap\Application folder and select Properties.  The Properties dialog opens with 
the General tab displayed.  

2 Click the Security tab to display it. 
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3 Add NETWORK SERVICE and local IUSR are set to allow Full Control. 

4 Add/ensure Domain/Windows User ID of developer is set to allow Full Control. 

5 Add/ensure Domain/Windows User ID of Taskmaster Server Service is set to allow Full 
Control. 

6 When Batches folders are staying on Server in the c:\Datacap\Application path, 
add/ensure Domain/Windows User IDs of Taskmaster end users are set to allow Full 
Control. 

Create System DSNs for Newly Created Application 
When the source application contains actions that connect to databases, the Datacap Studio 
Application Wizard log will contain the following warning: 
WARNING! ! ! ! The following actions containing a connection string have been modified 
during the copy process: 
(actions are listed) 
Please review the updated parameters in DStudio.  If DSNs were used in the source 
application, they will have to be recreated for the new application if they don't exist 
yet. 

To ensure the newly created application will work, you must identify every System DSN (data 
source name) used in the application and then create a matching System DSN on every 
Workstation that is to access the newly created application. 

This procedure provides instructions on how to identify the need for System DSNs and how to 
create System DSNs on a Workstation for the newly created application.  

1 From the Workstation's Windows Start menu, select All Programs, select Datacap, 
select Datacap Studio, and select Datacap Studio again.  A Taskmaster Server dialog 
opens. 

2 Enter the Server name (without initial backslashes) or IP address of the Server hosting 
the newly created application, then click Next.  A Connection progress bar is displayed 
briefly, then the Select Application – Rulerunner Service dialog opens. 

3 Select the Work offline. Internal Rulerunner service option, then click Next.  The Select 
Application – Applications dialog opens. 

4 Select the newly created application and click Next.  The Taskmaster Login dialog 
opens. 

5 Enter the Admin User ID, Password, and Station ID, and click Finish.  The new 
application opens in the Datacap Studio main window with the Rulemanager tab 
displayed on top. 

6 In the new application, locate each of the actions that were listed in the Datacap Studio 
Application Wizard log warning message.  You can do one or more of the following: 

 Expand the branches in the Document Hierarchy tab, select a ruleset bound to an 
object, and click the Autosync Ruleset view to DCO view button. 

 Expand the branches in the Rulesets tab, select the action, and click the Autosync 
Ruleset view to Action Library view button  

 Expand the action libraries in the Action Library tab, select the action, and click 
the Autosync Action Library view to Ruleset view button  

7 When the action contains a parameter that references a DSN, follow the instructions in 
the next steps to create each of the System DSNs used in the newly created application 
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on every Workstation that is to access the application.  Otherwise, close Datacap 
Studio. 

8 On the Workstation's Windows Start menu, select Settings, select Control Panel, select 
System and Maintenance, select Administrative Tools, and double-click Data Sources 
(ODBC). 
When UAC is on, the User Account Control window opens.  Click Continue. 
The ODBC Data Source Administrator window opens. 

9 Click the System DSN tab to display it.  Existing data source names are listed. 

10 Click Add.  The Create New Data Source window opens. 

11 Scroll down and select the appropriate driver, then click Finish.  The ODBC Setup 
window for the driver opens. 

12 Enter the Data Source Name for the database referenced in the application, and a 
Description, then click Select.  The Select Database window opens. 

13 Navigate to the Process folder of the newly created application, select the appropriate 
database and click OK.  The ODBC Setup window is redisplayed with the database 
information displayed.  

14 Click OK.  The ODBC Setup window closes and the ODBC Data Source Administrator 
window is displayed with the newly created data source name. 

15 Repeat steps 10 - 14 for each DSN referenced in the new application, then click OK to 
close the ODBC Data Source Administrator window.  

16 Close the Administrative Tools window. 

17 Close Datacap Studio. 

Run APT Taskmaster Client Application 

This section provides the information you need to run the Datacap Taskmaster foundation APT 
application “out of the box.”  These instructions involve starting the Taskmaster Server 
Service, starting the APT Taskmaster Client application, and running the default APT tasks to 
process sample, pre-scanned images.   

Instructions for running the default APT Taskmaster Web Client tasks are provided after the 
Configure Taskmaster Web on Vista, Windows 2008, IIS 7 Server instructions. 

Overview of Taskmaster APT 
Taskmaster APT is delivered with several different pre-configured “jobs.” A job is a collection 
of tasks to perform and rules to run that process invoices.  The default shortcuts you see when 
you start APT allow you to start and run various job-task combinations.  APT’s pre-configured 
jobs include:   

• Demo 

• Demo-Dot Matrix 

• Demo-Multipage TIFF 

• Web Demo 

• Web Demo-Dot Matrix 
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• Web Main  

• Web Main-Dot Matrix 

(Note that Taskmaster APT also includes Main Job and Main Job-Dot Matrix, however these 
jobs are only displayed after your Datacap Implementation Specialist has customized the 
configuration to your particular scanners.) 

The Demo and Web Demo jobs are the examples used in this documentation.  When running 
the Demo jobs, the default shortcuts you run, and the sequence in which you run them using 
the Taskmaster APT Client are as follows: 

 

This shortcut Does this 
Scan Allows you to select the Demo job, and run the VScan (virtual 

scan) task to bring the sample invoice images into Taskmaster 
APT.  

Background Starts the Batch Profiler task that performs many image 
processing functions including: identification of pages, image 
cleaning (e.g. despeckling), image rotation (if necessary), full page 
character recognition, and more. It also attempts to identify the 
invoice by comparing it to a library of known invoices. 

Verify Starts the Verify task that displays the sample invoice images and 
the data that has been recognized in the Verify window so you can 
ensure the data is complete and correct.  When an invoice is not a 
known invoice, the Verify window allows you to identify the fields 
and data on it, and to save its fingerprint so it will be recognized 
the next time.  

Export (or 
Background) 

Starts the Export task that completes processing of images, saves 
information about the invoices, and exports field data to XML files 
for input into your Accounts Payable, document imaging, or ERP 
system.  (Depending on the available batches and their current 
statuses, clicking the Background shortcut will run either the 
Batch Profiler task or the Export task.)  

Prerequisites 
1 Ensure you have met the prerequisites detailed in Chapter 2 Installation and 

Configuration Prerequisites. 

2 Complete the instructions to install and configure all of the components on the Server 
and the Workstation, to copy the application to the Server, and to complete the Server 
configuration,. 

3 From Datacap, obtain the password you need to use when logging in as the Taskmaster 
“admin” user. 

 

Start or Ensure Taskmaster Server Service is Started 
All configurations of Taskmaster (all components installed on a single Workstation or separate 
components installed on different machines) require that the Taskmaster Server Service be 
running before you can successfully start the application. 
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This procedure provides instructions on how to start or ensure the Datacap Taskmaster Server 
Service is started on the Server. 

1 From the Server's Windows Start menu, select All Programs, select Datacap, select 
Taskmaster Server, and click Taskmaster Server.  The TMS Configuration window 
opens. 

2 When the Status: 

 Shows as Running, continue with the next step. 
 Shows as Stopped, click Start.  A Starting Service message is displayed.  The Status 

changes to Running when the service is started.  
If a Taskmaster Server Service error is displayed 
See the instructions in Configure Taskmaster on Server to re-grant Taskmaster Server 
Service Log On as a Service Right. 

3 Close the TMS Configuration window. 

Start APT Taskmaster Client for the First Time (Vista) 
This procedure provides instructions on how to start the APT Taskmaster Client application on 
the Workstation for the first time when the Workstation’s operating system is Vista.  Note that 
after the first time you log into the Taskmaster Client, it remembers and displays what you 
entered the previous time. 

1 From the Workstation's Windows Start menu, select All Programs, select Datacap, 
select Applications, select APT, and click the APT Client icon.  The Select Taskmaster 
Server dialog opens with a blank Server name (address) field. 

2 Enter the Server's name (without initial backslashes) or the IP address of the Server 
hosting the application and click OK.  A Station ID is missing in the profile message is 
displayed. 

3 Click OK. An invalid login name or password message is displayed. 

4 Click OK.  The Please login window opens with your Window User ID and the name of 
your computer displayed.  

5 Replace your Windows User ID with admin, use the password provided by Datacap, 
and replace your computer name with the number 1, then click OK.  The APT 
Taskmaster Client main window opens with the Operations pane displayed. 
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Set Up Taskmaster Application to Use Scanner 
Install a scanner on the Workstation, and ensure the scanner works outside of Taskmaster 
before starting these instructions to define the scanner to Taskmaster. 

This procedure provides instructions on how to define your scanner to a specific Taskmaster 
Client application.   

Note:  A physical scanner is not required for running the Datacap applications out-of-the-box, 
as these applications can use the prescanned sample images included during installation. 

1 On the Workstation, with the Taskmaster Client application main window displayed, on 
the Settings menu, select Workflow.  The Taskmaster Administrator dialog opens with 
the Workflow tab displayed on top. 

2 In the left pane, expand the workflow, and select one of the scan jobs to expand its 
contents. 

3 In the left pane, select the scan task.  The task information in the right pane displays 
information about the scan task. 

4 In the right pane, click Setup.  The Scan Setup – Taskmaster window opens.   

5 If a Scan flatbed message box appears, click Cancel.  When the message box closes, 
another message may appear that indicates a scanner is not currently selected. 

6 Click OK.  A blank Scan Setup window is displayed. 

7 On the File menu, select Quit. The Taskmaster Administrator dialog is redisplayed. 

8 Click Setup again.  The Scan Setup – Taskmaster window opens.  If the message 
indicating that a scanner is not currently selected appears, click OK. 

9 Click OK.  A filled-in Scan Setup window is displayed. 
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10 Click Select Scanner.  A Loading Driver message box is briefly displayed, then the 
Scanner Selection window opens. 

11 Select the scanner you want to use, then click OK.  The Configure Device Settings 
window opens. 

12 Click OK.  Both windows close and the Scan Setup – Taskmaster window is 
redisplayed. 

13 Click Done.  The Scan Setup – Taskmaster window closes. 

14 Click Apply to save your scanner setup settings.  

15 Click Done. The Taskmaster Administrator dialog window closes. 

Run APT Taskmaster Client VScan Task (Scan Shortcut) (Vista) 
This procedure provides instructions on how to run the APT Taskmaster Client VScan task to 
process pre-scanned images. 

1 On the Workstation, in the Operations pane, double-click the Scan shortcut, select the 
Demo job and click OK.   

 
A Task Monitor window opens and a Rulerunner window opens displaying a progress 
bar, then they both close.  A message box is displayed indicating the task has finished. 

2 Click OK. A message box asks if you want to continue processing. 

3 Click No.  The message box closes and the Operations pane is redisplayed. 
When the VScan task finishes successfully, APT has picked up the images from the 
\APT\images\Input folder and created a Taskmaster “batch,” which is a collection of 
document images to be processed.  Taskmaster has assigned a batch ID and created a 
uniquely-numbered folder with the name of the batch ID in \APT\batches (on the 
Server).  This folder holds all of the document image processing results for this batch of 
invoices, including the newly-created rrsvscan.xml file.  

4 To view information about the batch, click the View menu and select Job Monitor to 
open the Job Monitor window. 

5 To refresh the information displayed in the Job Monitor window, click the Job 
Monitor's title bar and press F5.  The Job.Task and Status for this batch have been 
updated and are now Demo.Batch Profiler and pending. 
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Run APT Taskmaster Client Batch Profiler Task (Background Shortcut) (Vista) 
This procedure provides instructions on how to run the APT Taskmaster Client Batch Profiler 
task. 

1 On the Workstation, in the Operations pane, double-click the Background shortcut.  A 
Task Monitor window opens and a Rulerunner window opens displaying a progress bar, 
then they both close.  This may take a few minutes, as Rulerunner is running a number 
of processing-intensive modules, including PageID, ImageFix, CreateDocs, Recognize, 
FindFingerprint, Locate, lookups, and others.  When processing is complete, a message 
box is displayed indicating the task has finished.   

2 Click OK.  A message box asks if you want to continue processing. 

3 Click No.  The message box closes and the Operations pane is redisplayed.   
When the Batch Profiler task finishes successfully, the images have been organized into 
documents, copies (TIO) have been made of the original images, fingerprint (CCO) and 
page XML files have been created, along with a BatchProfiler.xml file in the batch's 
uniquely-numbered folder in \APT\batches (on the Server). 

4 To refresh the information displayed in the Job Monitor window, click the Job 
Monitor's title bar and press F5.  The Job.Task and Status for this batch have been 
updated and are now Demo.Verify and pending. 
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Run APT Taskmaster Client Verify Task (Verify Shortcut) (Vista) 
This procedure provides instructions on how to run the APT Taskmaster Client Verify task. 

1 On the Workstation, in the Operations pane, double-click the Verify shortcut.  A Task 
Monitor window opens and a Rulerunner window opens, then the Verify - Batch Pilot 
window opens. 
 
Note that for demonstration purposes only, all invoices are deliberately set to be 
displayed in the Verify window.  In a production environment, you decide whether 
you want every invoice to be displayed to the Verify Operator, or only those invoices 
where recognition results are low confidence and data validation rules are violated.  
 
The Verify window displays the first invoice in the batch and the details for the first 
line item on that invoice.   The left side of the window displays fields, recognized data, 
snippets, and a number of buttons, with invoice “header” information displayed on top, 
and line item detail on the bottom.  The right side of the window displays the scanned 
invoice. 
 
When there are errors or low confidence results, the cursor is placed in the first problem 
field and the field is outlined in red.  In addition, the background color of a data field 
indicates:  

• Blue:  No data validation errors or low confidence recognition results 

• Yellow:  Low confidence recognition results (low confidence characters are 
displayed in red) 

• Red: Data validation error 
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2 The following table describes some of the things you can do using buttons and hot-key 

combinations on the APT Verify window; for additional instructions on using the 
Verify window, see the section in the Taskmaster APT Quick Start Guide titled:  Verify 
Window Instructions. 

To Do this  
Move to the next data field Press <Tab> 
Move to next low confidence character Press <Alt+L> 
Fill empty field with data using Click N 
Key 

Click in an empty data entry field, then do one 
of the following: 
Point at the field value on the document image 
and click it, or,  
Click and drag the mouse to draw a rectangular 
box around the existing field data on the image, 
or, 
Press and hold <Alt>, click and drag the mouse 
to draw a rectangular box that encompasses 
additional blank space (to leave room for 
additional characters ), or, 
Press and hold <Shift>, click a field that has 
already been defined and drag the mouse to 
extend the field.   

Invoke validation rules for entire invoice Press <Alt+V> 
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To Do this  
Delete the document that is currently 
displayed 

Press <Alt+D> 

Mark the document for review Press <F2> 
Display the next document in the batch Press <Ctrl+Shift+N> 
Display the previous document in the 
batch. 

Press <Ctrl+Shift+P> 

Move to the next problem document in the 
batch 

Press <Ctrl+N> or 

Click    
Move to the previous problem document 
in the batch 

Press <Ctrl+P> or  

Click    
Lookup and select vendor (either when 
blank or when incorrect vendor is 
displayed) 

Enter at least the first character of the vendor’s 
name and the Remittance_Zip, then click  

  
Identify type of invoice Select from dropdown list  

  
Display original version of scanned image 
(with lines, noise, etc.), display cleaned up 
version of image (toggles from TIO to 
TIF) 

Click   or    

Create new fingerprint for this invoice 
Click    

Display previous page of invoice, display 
next page of invoice 

Click    
Display contents of previous line item, 
display contents of next line item 

Click    
Add line before current (displayed) line,  
add line after current line Click    
View all detail lines (opens separate 
window) Click    

For all detail lines, locate all field values 
for all fields Click    

Calculate missing numeric values using 
existing values and automatically fill blank 
numeric fields 

Click    

Delete current (displayed) line 
Click    
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To Do this  
Display or hide the scanned image On the View menu, select Image View, 

or press <Ctrl+Alt+I> 
Move the image Click and drag the image 

3 Using <Tab>, <Alt+L>, <Alt+V>and other keys described above, review and validate 
each sample document.  When the data has been validated, an End of Page Reached 
message will be displayed. 

4 Click Yes to go to the next document.  When you have finished processing the last 
invoice in the batch, a message box indicates that no additional problems were found. 

5 Click Yes to finish the batch.  A message box is displayed indicating the task has 
finished.   

6 Click OK.  A message box asks if you want to continue processing. 

7 Click No.  The message box closes and the Operations pane is redisplayed.  
When the Verify task finishes successfully, page XML files have been updated (for 
example, when low confidence characters have been changed during Verify), and a 
Verify.xml file has been created in the batch's uniquely-numbered folder in 
\APT\batches (on the Server). 

8 To refresh the information displayed in the Job Monitor window, click the Job 
Monitor's title bar and press F5.  The Job.Task and Status for this batch have been 
updated and are now Demo.Export and pending. 

 

Run APT Taskmaster Client Export Task (Export Shortcut) (Vista) 
This procedure provides instructions on how to run the APT Taskmaster Client Export task. 
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1 On the Workstation, in the Operations pane, double-click the Export shortcut.  A Task 
Monitor window opens and a Rulerunner window opens displaying a progress bar, then 
they both close.  A message box is displayed indicating that the Export task finished. 

2 Click OK.  A message box asks if you want to continue processing. 

3 Click No.  The message box closes and the Operations pane is redisplayed. 
When the Export task finishes successfully: 

• Export saves information about unknown invoices that were successfully 
validated  (creates new fingerprints) so that the next time Taskmaster APT “sees” 
the same invoice, it can identify the vendor and extract the field data using a 
process called Intellocate. 

• An Export XML file has been added to the batch’s uniquely-numbered folder 
found in \APT\batches (on the Server). 

• Export outputs the field data to XML files.  The XML files and the image files 
are now ready to be input into a back-end application.  

• If you configured Taskmaster APT to send email notifications and then, during 
Verify, you marked an invoice for review or rescan, or deleted an invoice, Export 
also sends the appropriate emails with the marked or deleted image attached as a 
PDF file.  If you did not configure email notifications, the PDFs of the marked or 
deleted images stay in the batch's uniquely-numbered folder in \APT\batches (on 
the Server); the images and information about the images are not exported.  

4 To refresh the information displayed in the Job Monitor window, click the Job 
Monitor's title bar and press F5.  The Job.Task and Status for this batch have been 
updated and are now Demo.Export and Job Done.   
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Generate APT Taskmaster Client Reports Manually 

This section provides the information you need to run the sample APT Taskmaster Client 
reports. 

Overview of APT Taskmaster Client Report Viewer 
The APT Taskmaster Client Report Viewer is a separate utility program that can produce a set 
of standard reports "out of the box."  The Report Viewer is installed when you install the 
Taskmaster Client software.  A shortcut is automatically created on your Windows Start menu 
by the installation process. 

Prerequisites 
1 Ensure you have met the prerequisites detailed in Chapter 2 Installation and 

Configuration Prerequisites. 

2 Complete the instructions to install and configure all of the components on the Server 
and the Workstation, to copy the application to the Server, and to complete the Server 
configuration. 

3 From Datacap, obtain the password you need to use when logging in as the Taskmaster 
“admin” user. 

4 Ensure the Taskmaster Server Service is started. 

5 To view actual data on one or more reports, run one or more of the APT Taskmaster 
Client or Taskmaster Web Client tasks. 

Ensure APT Report Viewer Shortcut is Pointing at Server 
This procedure provides instructions on how to update the target of the Report Viewer shortcut 
on the Workstation so it points at the correct APT rptview.ini file. 

1 From the Workstation's Windows Start menu, select All Programs, select Datacap, 
select Applications, select APT, right-click the APT Report Viewer icon and select 
Properties.  The APT Report Viewer Properties dialog opens. 

2 Change the contents of the Target field to reflect the appropriate path to the Server for 
the rptview.ini, and the databases. 

3 Click Apply to save your changes, then click OK to close the APT Report Viewer 
Properties dialog. 

Start APT Taskmaster Client Report Viewer 
This procedure provides instructions on how to start up the APT Taskmaster Client Report 
Viewer.  Exit the Taskmaster Client on the Workstation before starting Report Viewer on that 
Workstation. 

Note that after the first time you log into Report Viewer, it remembers and displays what you 
entered the previous time. 

1 From the Workstation’s Windows Start menu, select All Programs, select Datacap, 
select Applications, select APT, and click the APT Report Viewer icon.  A Select 
Taskmaster Server dialog opens. 

2 Enter the Server name (without initial backslashes) or IP address of the Server hosting 
the application, then click OK.  The Report Viewer Login window is displayed. 
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3 Enter User Name of admin, enter the password provided by Datacap, and ensure the 
Station ID is set to 1, then click OK.  The Report Viewer main window opens. 

Create APT Taskmaster Client Reports Manually 
This procedure provides instructions on how to create a APT Taskmaster Client report 
manually.  

1 With the Report Viewer main window open, on the Report menu, select Open.  The 
Open Report dialog is displayed. 

2 In the:  

 Date portion of the dialog, make changes to indicate the time period to be 
included on the report  

 Report portion of the dialog, select the report you want to view 
 Filters portion of the dialog, select a filter (optional) 

 then click Open.  The report is displayed. 

3 Use the buttons and fields on the report toolbar as follows: 

 

To Do This 
Set up the printer on 
which you want to print 
your reports 

1 On the Report menu, click Print Report.  The Print 
Setup window opens. 

2 Clear the No Printer checkbox and select the printer 
you want to use from the drop-down list and adjust 
the other Windows Print controls as appropriate. 

3 Click OK.  The Windows Print window opens. 

4 Click Cancel.  The Windows Print window closes. 

5 On the Report menu, click Close.  The report 
window closes. 

Export data to PDF file 

(You must have an Adobe 
Acrobat printer driver 
installed to "print" the 
report to a PDF file) 

1 On the Report menu, click Print Report.  The Print 
Setup window opens. 

2 If necessary, clear the No Printer checkbox and 
select the Adobe Acrobat printer driver from the 
drop-down list and adjust the other Windows Print 
controls as appropriate. 

3 Click OK.  The report pages are printed to a PDF 
file. 

4 Depending on your Adobe Acrobat settings, the PDF 
file may open automatically. 

5 On the Report menu, click Close.  The report 
window closes. 
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To Do This 
Print report 1 Click Print.  The Windows Print window opens. 

2 Adjust the Windows Print controls as appropriate, 
then click OK to print the report pages.  

3 On the Report menu, click Close.  The report 
window closes. 

Refresh the contents of 
the report 

Click Refresh. 

Show or Hide Group Tree Click Toggle Group Tree. 

Resize (enlarge or shrink) 
the report 

Select the appropriate percentage from the drop-
down list. 

Display first page Click Go to First Page. 

Display previous page Click Go to Previous Page. 

Display specific page Enter a page number then press <ENTER>. 

Display next page Click Go to Next Page. 

Display last page Click Go to Last Page. 

Search for a string on the 
report 

1 Click Search Text.  The Search dialog opens. 

2 Enter the string you want to search for, then click 
Find Next.  The string is highlighted on the report. 

3 To close the Search dialog, click Cancel.  The Search 
dialog closes. 

Close report On the Report menu, click Close.  The report window 
closes. 

 

4 Close the Report Viewer window. 

Review Default Installation Results 

This section is optional.  The instructions provided allow you to review the Taskmaster Client 
database connections, and groups, users, and stations installed by the default installation 
process. 

Prerequisites 
1 Ensure you have met the prerequisites detailed in Chapter 2 Installation and 

Configuration Prerequisites. 

2 Complete the instructions to install and configure all of the components on the Server 
and the Workstation, to copy the application to the Server, and to complete the Server 
configuration. 

3 From Datacap, obtain the password you need to use when logging in as the Taskmaster 
“admin” user. 
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View Default Database Connections (Vista) 
When you perform the default Datacap Taskmaster installation, it automatically sets up 
Microsoft Access databases and ODBC connections for the default Datacap Taskmaster 
foundation and sample application databases. 

This procedure provides instructions on how to view the ODBC connections that were set up 
automatically by the installation process. 

1 From the Workstation's Windows Start menu, select Control Panel, select System and 
Maintenance, select Administrative Tools, and double-click Data Sources (ODBC). 
When UAC is on, the User Account Control window opens.  Click Continue. 
The ODBC Data Source Administrator window opens. 

2 Click the System DSN tab to display it.  The data sources for the databases are listed. 

3 Click Cancel to close the ODBC Data Source Administrator window.  

Start or Ensure Taskmaster Server Service is Started 
All configurations of Taskmaster (all components installed on a single Workstation or separate 
components installed on different machines) require that the Taskmaster Server Service be 
running before you can successfully start the application. 

This procedure provides instructions on how to start or ensure the Datacap Taskmaster Server 
Service is started on the Server. 

1 From the Server's Windows Start menu, select All Programs, select Datacap, select 
Taskmaster Server, and click Taskmaster Server.  The TMS Configuration window 
opens. 

2 When the Status: 

 Shows as Running, continue with the next step. 
 Shows as Stopped, click Start.  A Starting Service message is displayed.  The Status 

changes to Running when the service is started.  
If a Taskmaster Server Service error is displayed 
See the instructions in Configure Taskmaster on Server to re-grant Taskmaster Server 
Service Log On as a Service Right. 

3 Close the TMS Configuration window. 

View APT Taskmaster Client Groups, Users, Stations 
When you perform the default Datacap Taskmaster installation and configuration, some 
Datacap Taskmaster groups, users and passwords, and stations are automatically set up for you 
in the APT foundation application. 

Start APT Taskmaster Client 
This procedure provides instructions on how to start the APT Taskmaster Client application.  If 
you have logged into the Taskmaster Client before, the information you entered previously is 
displayed. 

1 From the Workstation's Windows Start menu, select All Programs, select Datacap, 
select Applications, select APT, and click the APT Client icon (the target of this icon 
should be pointing to the local TMClient.exe with parameters pointing to the 
APTAdm.mdb and APTEng.mdb in the application's process folder on the \\Server).  
The Select Taskmaster Server dialog opens. 
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2 Enter the Server name (without initial backslashes) or IP address of the Server hosting 
the application and click OK.  A Please login window opens. 

3 Ensure the User ID is admin, enter the password provided by Datacap, and ensure the 
Station is set to 1, then click OK. 

4 The APT main window opens with the Operations pane displayed. 

View APT Taskmaster Client Groups 
This procedure provides instructions on how to view the default user security group delivered 
as part of the APT Taskmaster Client. 

1 With the Taskmaster Client main window open, on the Settings menu, select Groups. 
The Taskmaster Administrator dialog opens with the Groups tab displayed on top, and 
the Groups listed in the left pane. 

2 Select a group in the left pane. 

3 In the right pane, completely expand the Privileges, Permissions, and Users branches to 
view the options set for this group.  For example, the "Scanners" group has been 
granted permission to the iVScan and Upload tasks for the Web Demo, Web Demo 
Dot-Matrix, Web Main, and Web Main Dot-Matrix jobs. 

4 Then, do one of the following:  

 Click the Users tab and continue with step 2 in the View APT Taskmaster Client 
Users procedure. 

 Click the Stations tab and continue with step 2 in the View APT Taskmaster 
Client Stations procedure. 

 Click Done to close the Taskmaster Administrator dialog. 
5 If you are finished viewing groups, users, or stations, close the Taskmaster Client 

window.  A confirmation message box is displayed.  Click Yes to close the Taskmaster 
Client window. 

View APT Taskmaster Client Users 
This procedure provides instructions on how to view the default user permissions delivered as 
part of the APT Taskmaster Client. 

1 With the Taskmaster Client main window open, on the Settings menu, select Users. The 
Taskmaster Administrator dialog opens with the Users tab displayed on top and the 
Users listed in the left pane. 

2 Select a user in the left pane. 

3 In the right pane, completely expand the Privileges, Permissions, and Groups branches 
to view the options assigned to this user.  For example, the "scan1" user is part of the 
Scanners group, and has been granted the permissions that were granted to the group. 

4 Then do one of the following:  

 Click the Groups tab and continue with step 2 in the View APT Taskmaster 
Client Groups procedure.  

 Click the Stations tab and continue with step 2 in the View APT Taskmaster 
Client Stations procedure. 

 Click Done to close the Taskmaster Administrator dialog. 
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5 If you are finished viewing groups, users, or stations, close the Taskmaster Client 
window.  A confirmation message box is displayed.  Click Yes to close the Taskmaster 
Client window. 

View APT Taskmaster Client Stations 
This procedure provides instructions on how to view the default station permissions delivered 
as part of the APT Taskmaster Client. 

1 With the Taskmaster Client main window open, on the Settings menu, select Stations. 
The Taskmaster Administrator dialog opens with the Stations tab displayed on top. 

2 Select a station in the left pane. 

3 In the right pane, completely expand the Permissions branches to view the specific 
Tasks this station has permission to run.  For example, the "remote" station has been 
granted permissions to run iVScan, Upload, and Verify tasks. 

4 Do one of the following:  

 Click the Groups tab and continue with step 2 in the View APT Taskmaster 
Client Groups procedure.  

 Click the Users tab and continue with step 2 in the View APT Taskmaster Client 
Users procedure. 

 Click Done to close the Taskmaster Administrator dialog. 
5 If you are finished viewing groups, users, or stations, close the Taskmaster Client 

window.  A confirmation message box is displayed.  Click Yes to close the Taskmaster 
Client window. 

Configure Taskmaster Web on Windows 2000, IIS 5 Server 

This section provides the information you need to set up Taskmaster Web on a Windows 2000 
server with IIS 5 so you can use the Taskmaster Web Client for processing. 

Prerequisites 
1 Ensure you have met the prerequisites detailed in Chapter 2 Installation and 

Configuration Prerequisites. 

2 Complete the instructions to install and configure all of the components on the Server 
and the Workstation, to copy the application to the Server, and to complete the Server 
configuration,. 

3 From Datacap, obtain the password you need to use when logging in as the Taskmaster 
“admin” user. 

Stop or Ensure Taskmaster Server Service is Stopped 
This procedure provides instructions on how to stop or ensure the Datacap Taskmaster Server 
Service is stopped on the Server. 

1 From the Server's Windows Start menu, select Programs, select Datacap, select 
Taskmaster Server, and click Taskmaster Server.  The TMS Configuration window 
opens. 

2 When the Status: 

 Shows as Stopped, continue with the next step. 
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 Shows as Running, click Stop.  A Stopping Service message is displayed.  The 
Status changes to Stopped when the service is stopped.  

3 Close the TMS Configuration window. 

Add or Ensure Application Information in APPS.INI is Correct (All OS) 
When you have installed an application separately (for example, Taskmaster 7.6 for Medical 
Claims), or have used the Datacap Studio Application Wizard to create or copy an application 
from a Workstation to the Server, and you want to access that application using the Taskmaster 
Web Client, you must ensure the application information in the APPS.INI file that is on the 
Server is complete and correct. 

This procedure provides instructions on how to ensure the information is correct in and how to 
make all required changes to the APPS.INI file.   

1 On the Server, start up Windows Explorer, navigate to and open the application's 
process folder so you can see the names of the application's databases. 

2 On the Server, start up another instance of Windows Explorer, navigate to and use a text 
editor such as Notepad to open the c:\Datacap\tmweb.net\apps.ini file. 

3 Locate the section that contains information about the application (by default, apps.ini 
contains information about all of the applications shipped with Taskmaster). 

4 To change information about an application that was copied to the Server, edit the 
application's section so that it reflects the correct: 

 Application name (this is the name of the application folder on the Server) 
 Server UNC name (without initial backslashes) or IP address   
 Administration and Engine database names 
 Paths to the various databases 

5 To add information about a newly-created application, copy the entire section for an 
existing application (such as [APT]) and paste it below the original section but above 
the last line: 

 ;;; End of Apps.ini entries - Do not remove this line.  

 and then edit the copied section so that it reflects the new application's: 

 Application name (this is the name of the application folder on the Server) 
 Server UNC name (without initial backslashes) or IP address   
 Administration and Engine database names 
 Paths to the various databases 

6 Save the APPS.INI file, close the text editor, and close Windows Explorer. 

Add or Ensure Upload Limit Setting is Large Enough in web.config (All OS) 
Depending on the usual size of the images that will be uploaded from the Taskmaster Web 
Client to the Server, you should adjust the upload limit setting found in the web.config file that 
is on the Server when the Server operating system is Windows 2000, Windows 2003, Vista, or 
Windows 2008. 

This procedure provides instructions on how to locate and change the setting in the web.config 
file that affects upload speed.  
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1 On the Server, start Windows Explorer, navigate to and open the c:\Datacap\tmweb.net 
folder, scroll down to the web.config file and open it in a text editor such as Notepad. 

2 Within the <system.web> element, locate or add the   
<httpRuntime maxRequestLength="52428" />  
element - this parameter is expressed in kilobytes. 

3 Depending on the usual size of the images that are being uploaded, you can increase the 
size, for example: 
<httpRuntime maxRequestLength="102400" /> 

4 When you have made changes, save and close the file. 

Create and Share (Nested) Virtual Directory for Taskmaster Web (Windows 2000, 
Windows 2003) 
These instructions assume you will create a virtual directory for Taskmaster Web nested within 
the Server's Default Web Site. 

This procedure provides instructions on how to create a virtual directory for the Taskmaster 
Web site. 

1 From the Server's Windows Start menu, select Settings, select Control Panel, select 
Administrative Tools, and double-click Internet Information Services.  The Internet 
Information Services window opens. 

2 Expand the computer on which you want to create the virtual directory, expand its Web 
Sites folder, right-click the Default Web Site, and on the shortcut menu, select New, 
then select Virtual Directory.  The Welcome page of the Virtual Directory Creation 
Wizard opens. 

3 Click Next. The Virtual Directory Alias page is displayed. 

4 Enter tmweb.net as the alias, then click Next.  The Web Site Content Directory page is 
displayed. 

5 Enter the full path or use the Browse button to navigate to and select the 
c:\Datacap\tmweb.net folder, then click OK.  The Web Site Content Directory page 
reappears with the full path to the tmweb.net folder displayed. 

6 Click Next. The Access Permissions page is displayed. 

7 Select the Read, Run scripts, and Execute options, then click Next.  The completion 
page of the Virtual Directory Creation Wizard is displayed. 

8 Click Finish.  The Wizard closes and the new tmweb.net virtual directory is displayed in 
the Internet Information Services window. 

Create TaskRun Folder, Set Up Web Sharing and Security Settings (Windows 2000, 
Windows 2003) 
This procedure provides instructions on how to create the TaskRun processing folder on the 
Server that is required by Taskmaster Web.  This folder is where batches temporarily reside 
while they are being processed. 

IMPORTANT 

The TaskRun folder name is case-sensitive, must be named TaskRun, and must be created 
within the c:\Datacap folder structure at the same level as the tmweb.net folder. 
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1 On the Server, start Windows Explorer, navigate to c:\Datacap, and create a folder 
named TaskRun. (Reminders: Folder name is case-sensitive; create this folder at the 
same level as the c:\Datacap\tmweb.net folder.) 

2 In Windows Explorer, right-click the TaskRun folder, and select Properties from the 
shortcut menu.  The TaskRun Properties dialog opens with the General tab displayed on 
top. 

3 Click the Web Sharing tab to display it. 

4 Select the Share this folder option.  The Edit Alias dialog opens displaying the folder 
name in the Alias field. 

5 In the Application permissions group box, select the None option, and in the Access 
permissions group box, select Write in addition to the Read option, then click OK.  The 
Web Sharing tab reappears with TaskRun displayed as an alias.  

6 Click Apply to save your changes. 

7 Click the Security tab to display it. 

8 Add ASPNET Machine Account (Server\ASPNET) and set to allow Modify; add 
Internet Guest Account (Server\IUSR_SERVER) and set to allow Modify. 

9 Click OK to close the TaskRun Properties dialog. 

Set Up TaskRun Virtual Folder (Windows 2000, Windows 2003) 
This procedure provides instructions on how to set the appropriate IIS parameters for the 
TaskRun virtual folder required by Taskmaster Web. 

1 From the Server's Windows Start menu, select Settings, select Control Panel, select 
Administrative Tools, and double-click Internet Information Services to open the 
Internet Information Services window. 

2 Expand the computer, the Web Sites folder and the Default Web Site.  If the virtual 
TaskRun folder is not displayed, refresh the window as many times as it takes for the 
TaskRun folder to appear. 

3 Right-click the TaskRun folder, select Properties from the shortcut menu.  The TaskRun 
Properties window opens with the Virtual Directory tab displayed on top. 

4 Click the Remove button.  The Application name field is protected, and the Remove 
button label changes to Create.  

5 Click the Documents tab to display it. 

6 If the default.aspx document is not displayed, add it and click Apply to save your 
change. 

7 Click the Directory Security tab to display it. 

8 Click the top Edit button to edit the Anonymous access and authentication control 
settings.  The Authentication Methods dialog opens. 

9 Select the Anonymous access checkbox and clear the Integrated Windows 
authentication checkbox, then click OK.  The Authentication Methods dialog closes and 
the Directory Security tab is redisplayed. 

10 Click the ASP.NET tab to display it.  
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 If the ASP.NET version displayed is version 2.0.5nnnn, continue with the next 
step. 

 If the ASP.NET version displayed is blank but the field is active, click the 
dropdown arrow, select the 2.0.5nnnn entry from the list, and continue to the next 
step. 

 If the ASP.NET version displayed is blank or earlier than 2.0.5nnnn and you 
cannot select the correct entry (the field is protected), you cannot continue with 
this procedure.  To recover, ensure that you installed Taskmaster:  
o If you did not, begin this process over again with the correct version of the 

Taskmaster software. 
o If you did, refer to Chapter 2 Installation and Configuration Prerequisites and 

follow the instructions to Run aspnet_regiis.exe to update the ASP.NET 
application script maps.  

11 Click Apply to save any changes. 

12 Click the HTTP Headers tab to display it. 

13 Select the Enable Content Expiration option to activate the expiration fields. 

14 Select the Expire Immediately option, then click Apply to save the change and then OK 
to close the TaskRun Properties dialog. The Internet Information Services window is 
redisplayed – the TaskRun folder's icon has changed. 

Install Crystal Reports Runtime (All OS) 
This procedure provides instructions on how to install the Crystal Reports Runtime files that 
are required by Taskmaster Web. 

1 On the Server, start Windows Explorer, navigate to c:\Datacap\install\tmweb7cr, and 
double-click the Setup.exe.   
When UAC is on, the User Account Control window opens.  Click Continue. 
The Welcome page of the Web Reports Setup wizard opens. 

2 Click Next.  The Select Installation Address page is displayed with default values in the 
Site and Virtual directory fields. 

3 Change the Virtual directory to tmweb.net, then click Next.  The Confirm Installation 
page is displayed. 

4 Click Next.  The Installing Web Reports page is displayed with progress messages and a 
progress indicator, and when complete, displays the Installation Complete window.  

5 Click Close to exit the installation process and close the wizard. 

Confirm Server.INI Points to TaskRun (All OS) 
This procedure provides instructions on how to ensure that the Server.ini file contains the 
correct value for the setting that Taskmaster Web uses to locate the TaskRun folder. 

1 On the Server, start Windows Explorer, navigate to and use a text editor such as 
Notepad to open the c:\Datacap\tmweb.net\server.ini file. 

2 The server.ini’s TempFolder= setting should be set to TempFolder=/TaskRun/ (folder 
name is case-sensitive) and if it is not, change it, save it, and close the file. 
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Change SSL Setting in Server.INI (All OS) 
If you are using Secure Socket Layer to encrypt communications between Taskmaster Web 
and Taskmaster Web Clients, this procedure provides instructions on how to change the value 
of the SSL setting in the Server.ini file that controls Taskmaster Web's SSL behavior. 

1 On the Server, start Windows Explorer, navigate to and use a text editor such as 
Notepad to open the c:\Datacap\tmweb.net\server.ini file. 

2 Change the server.ini’s UseSSL=0 setting to UseSSL=1, save it, and close the file. 

Start or Ensure Taskmaster Server Service is Started 
All configurations of Taskmaster (all components installed on a single Workstation or separate 
components installed on different machines) require that the Taskmaster Server Service be 
running before you can successfully start the application. 

This procedure provides instructions on how to start or ensure the Datacap Taskmaster Server 
Service is started on the Server. 

1 From the Server's Windows Start menu, select All Programs, select Datacap, select 
Taskmaster Server, and click Taskmaster Server.  The TMS Configuration window 
opens. 

2 When the Status: 

 Shows as Running, continue with the next step. 
 Shows as Stopped, click Start.  A Starting Service message is displayed.  The Status 

changes to Running when the service is started.  
If a Taskmaster Server Service error is displayed 
See the instructions in Configure Taskmaster on Server to re-grant Taskmaster Server 
Service Log On as a Service Right. 

3 Close the TMS Configuration window. 

Configure Taskmaster Web on Windows 2003, IIS 6 Server 

This section provides the information you need to set up Taskmaster Web on a Windows 2003, 
IIS 6 Server so you can use the Taskmaster Web Client for processing. 

Prerequisites 
1 Ensure you have met the prerequisites detailed in Chapter 2 Installation and 

Configuration Prerequisites. 

2 Complete the instructions to install and configure all of the components on the Server 
and the Workstation, to copy the application to the Server, and to complete the Server 
configuration. 

3 From Datacap, obtain the password you need to use when logging in as the Taskmaster 
“admin” user. 

Stop or Ensure Taskmaster Server Service is Stopped 
This procedure provides instructions on how to stop or ensure the Datacap Taskmaster Server 
Service is stopped on the Server. 
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1 From the Server's Windows Start menu, select Programs, select Datacap, select 
Taskmaster Server, and click Taskmaster Server.  The TMS Configuration window 
opens. 

2 When the Status: 

 Shows as Stopped, continue with the next step. 
 Shows as Running, click Stop.  A Stopping Service message is displayed.  The 

Status changes to Stopped when the service is stopped.  
3 Close the TMS Configuration window. 

Add or Ensure Application Information in APPS.INI is Correct (All OS) 
When you have installed an application separately (for example, Taskmaster 7.6 for Medical 
Claims), or have used the Datacap Studio Application Wizard to create or copy an application 
from a Workstation to the Server, and you want to access that application using the Taskmaster 
Web Client, you must ensure the application information in the APPS.INI file that is on the 
Server is complete and correct. 

This procedure provides instructions on how to ensure the information is correct in and how to 
make all required changes to the APPS.INI file.   

1 On the Server, start up Windows Explorer, navigate to and open the application's 
process folder so you can see the names of the application's databases. 

2 On the Server, start up another instance of Windows Explorer, navigate to and use a text 
editor such as Notepad to open the c:\Datacap\tmweb.net\apps.ini file. 

3 Locate the section that contains information about the application (by default, apps.ini 
contains information about all of the applications shipped with Taskmaster). 

4 To change information about an application that was copied to the Server, edit the 
application's section so that it reflects the correct: 

 Application name (this is the name of the application folder on the Server) 
 Server UNC name (without initial backslashes) or IP address   
 Administration and Engine database names 
 Paths to the various databases 

5 To add information about a newly-created application, copy the entire section for an 
existing application (such as [APT]) and paste it below the original section but above 
the last line: 

 ;;; End of Apps.ini entries - Do not remove this line.  

 and then edit the copied section so that it reflects the new application's: 

 Application name (this is the name of the application folder on the Server) 
 Server UNC name (without initial backslashes) or IP address   
 Administration and Engine database names 
 Paths to the various databases 

6 Save the APPS.INI file, close the text editor, and close Windows Explorer. 
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Add or Ensure Upload Limit Setting is Large Enough in web.config (All OS) 
Depending on the usual size of the images that will be uploaded from the Taskmaster Web 
Client to the Server, you should adjust the upload limit setting found in the web.config file that 
is on the Server when the Server operating system is Windows 2000, Windows 2003, Vista, or 
Windows 2008. 

This procedure provides instructions on how to locate and change the setting in the web.config 
file that affects upload speed.  

1 On the Server, start Windows Explorer, navigate to and open the c:\Datacap\tmweb.net 
folder, scroll down to the web.config file and open it in a text editor such as Notepad. 

2 Within the <system.web> element, locate or add the   
<httpRuntime maxRequestLength="52428" />  
element - this parameter is expressed in kilobytes. 

3 Depending on the usual size of the images that are being uploaded, you can increase the 
size, for example: 
<httpRuntime maxRequestLength="102400" /> 

4 When you have made changes, save and close the file. 

Add or Ensure File Transfer Limit Setting is Large Enough (Windows 2003) 
Depending on the usual size of the images that will be uploaded from the Taskmaster Web 
Client to the Server, you should adjust the default File Transfer Limit setting found in the 
METABASE.XML file that is on the Server. 

This procedure provides instructions on how to locate and change the File Transfer Limit 
setting in the METABASE.XML file when the Server’s operating system is Windows 2003.  

1 Before editing the METABASE.XML file, enable the metabase edit-while-running 
feature using IIS Manager on the Server, otherwise you will not be able to save your 
changes.  To do this:  In IIS Manager, right-click the local computer, click Properties, 
select the Enable Direct Metabase Edit option, click Apply, then click OK. 

2 On the Server, start Windows Explorer, navigate to and open the 
\windows\system32\inetsrv folder, scroll down to the metabase.xml file and open it in a 
text editor such as Notepad. 

3 Locate and change the value (expressed in bytes) for AspMaxRequestEntityAllowed= 
for example, from 204800 to 10238976. 

4 When you have made changes, save and close the file. 

5 After saving your changes, disable/clear the Direct Metabase Edit option in IIS 
Manager. 

Create and Share (Nested) Virtual Directory for Taskmaster Web (Windows 2000, 
Windows 2003) 
These instructions assume you will create a virtual directory for Taskmaster Web nested within 
the Server's Default Web Site. 

This procedure provides instructions on how to create a virtual directory for the Taskmaster 
Web site. 
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1 From the Server's Windows Start menu, select Settings, select Control Panel, select 
Administrative Tools, and double-click Internet Information Services.  The Internet 
Information Services window opens. 

2 Expand the computer on which you want to create the virtual directory, expand its Web 
Sites folder, right-click the Default Web Site, and on the shortcut menu, select New, 
then select Virtual Directory.  The Welcome page of the Virtual Directory Creation 
Wizard opens. 

3 Click Next. The Virtual Directory Alias page is displayed. 

4 Enter tmweb.net as the alias, then click Next.  The Web Site Content Directory page is 
displayed. 

5 Enter the full path or use the Browse button to navigate to and select the 
c:\Datacap\tmweb.net folder, then click OK.  The Web Site Content Directory page 
reappears with the full path to the tmweb.net folder displayed. 

6 Click Next. The Access Permissions page is displayed. 

7 Select the Read, Run scripts, and Execute options, then click Next.  The completion 
page of the Virtual Directory Creation Wizard is displayed. 

8 Click Finish.  The Wizard closes and the new tmweb.net virtual directory is displayed in 
the Internet Information Services window. 

Set Other Parameters for (Nested) Taskmaster Web Site (Windows 2003) 
This procedure provides instructions on how to set additional parameters required by 
Taskmaster Web when Taskmaster Web is installed in a Windows 2003, IIS 6 environment. 

1 From the Server's Windows Start menu, select Settings, select Control Panel, select 
Administrative Tools, and double-click Internet Information Services to open the 
Internet Information Services window. 

2 Expand the computer, the Web Sites folder and the Default Web Site, right-click the 
tmweb.net web site, and select Properties from shortcut menu.  The tmweb.net 
Properties dialog opens with the Virtual Directory tab displayed on top. 

3 Click the Configuration button.  The Application Configuration window opens. 

4 Click the Options tab to display it. 

5 Select the Enable session state option and set the Session timeout field to 20 minutes. 

6 Select the Enable parent paths option, ensure or set the Default ASP language to 
VBScript, and set the ASP Script timeout field to 1200 seconds. 

7 Click OK to close the Application Configuration window. 

8 Click the Documents tab to display it. 

9 If  the default.aspx document is not displayed, add it and click Apply to save your 
change. 

10 Click the ASP.NET tab to display it. 

11 Click the Edit Configuration button. The ASP.NET Configuration Settings window 
opens with the General tab displayed on top. 

12 Click the Application tab to display it. 
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13 Set the Request execution timeout field to 1200 seconds, then click Apply. 

14 Click State Management tab to display it. 

15 Set the Session timeout field to 20 minutes, then click Apply. 

16 Click OK to close the local Settings window. 

17 Click OK to save and close the tmweb.net Properties dialog. 

Set Web Site Isolation Mode (Windows 2003) 
This procedure provides instructions on how to set the service to run in IIS 5.0 Isolation Mode 
on a Windows 2003 IIS 6 Server. 

1 With the Internet Information Services window open, expand the computer on which 
you created the virtual directory, right-click Web Sites, and on the shortcut menu, select 
Properties.  The Web Site Properties dialog opens. 

2 Click the Service tab to display it. 

3 Select Isolation Mode:  Run WWW Service in IIS 5.0 Isolation Mode, click Apply and 
click Yes when you are prompted to restart IIS. 

4 Click OK to close the Web Site Properties dialog. 

Select Web Service Extensions (Windows 2003) 
This procedure provides instructions on how to allow Active Server Page extensions on a 
Windows 2003 IIS 6 Server. 

1 On the Server, with the Internet Information Services window open, expand the 
computer on which you created the virtual directory, and select Web Service 
Extensions.  The Web Service Extension options are displayed in the right pane. 

2 Select/ensure Active Server Pages, ASP.NET v2.0.50727, and Server Side includes are 
Allowed. 

3 Close the Internet Information Services window. 

Create TaskRun Folder, Set Up Web Sharing and Security Settings (Windows 2000, 
Windows 2003) 
This procedure provides instructions on how to create the TaskRun processing folder on the 
Server that is required by Taskmaster Web.  This folder is where batches temporarily reside 
while they are being processed. 

IMPORTANT 

The TaskRun folder name is case-sensitive, must be named TaskRun, and must be created 
within the c:\Datacap folder structure at the same level as the tmweb.net folder. 

1 On the Server, start Windows Explorer, navigate to c:\Datacap, and create a folder 
named TaskRun. (Reminders: Folder name is case-sensitive; create this folder at the 
same level as the c:\Datacap\tmweb.net folder.) 

2 In Windows Explorer, right-click the TaskRun folder, and select Properties from the 
shortcut menu.  The TaskRun Properties dialog opens with the General tab displayed on 
top. 

3 Click the Web Sharing tab to display it. 
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4 Select the Share this folder option.  The Edit Alias dialog opens displaying the folder 
name in the Alias field. 

5 In the Application permissions group box, select the None option, and in the Access 
permissions group box, select Write in addition to the Read option, then click OK.  The 
Web Sharing tab reappears with TaskRun displayed as an alias.  

6 Click Apply to save your changes. 

7 Click the Security tab to display it. 

8 Add ASPNET Machine Account (Server\ASPNET) and set to allow Modify; add 
Internet Guest Account (Server\IUSR_SERVER) and set to allow Modify. 

9 Click OK to close the TaskRun Properties dialog. 

Set Up TaskRun Virtual Folder (Windows 2000, Windows 2003) 
This procedure provides instructions on how to set the appropriate IIS parameters for the 
TaskRun virtual folder required by Taskmaster Web. 

1 From the Server's Windows Start menu, select Settings, select Control Panel, select 
Administrative Tools, and double-click Internet Information Services to open the 
Internet Information Services window. 

2 Expand the computer, the Web Sites folder and the Default Web Site.  If the virtual 
TaskRun folder is not displayed, refresh the window as many times as it takes for the 
TaskRun folder to appear. 

3 Right-click the TaskRun folder, select Properties from the shortcut menu.  The TaskRun 
Properties window opens with the Virtual Directory tab displayed on top. 

4 Click the Remove button.  The Application name field is protected, and the Remove 
button label changes to Create.  

5 Click the Documents tab to display it. 

6 If the default.aspx document is not displayed, add it and click Apply to save your 
change. 

7 Click the Directory Security tab to display it. 

8 Click the top Edit button to edit the Anonymous access and authentication control 
settings.  The Authentication Methods dialog opens. 

9 Select the Anonymous access checkbox and clear the Integrated Windows 
authentication checkbox, then click OK.  The Authentication Methods dialog closes and 
the Directory Security tab is redisplayed. 

10 Click the ASP.NET tab to display it.  

 If the ASP.NET version displayed is version 2.0.5nnnn, continue with the next 
step. 

 If the ASP.NET version displayed is blank but the field is active, click the 
dropdown arrow, select the 2.0.5nnnn entry from the list, and continue to the next 
step. 

 If the ASP.NET version displayed is blank or earlier than 2.0.5nnnn and you 
cannot select the correct entry (the field is protected), you cannot continue with 
this procedure.  To recover, ensure that you installed Taskmaster:  
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o If you did not, begin this process over again with the correct version of the 
Taskmaster software. 

o If you did, refer to Chapter 2 Installation and Configuration Prerequisites and 
follow the instructions to Run aspnet_regiis.exe to update the ASP.NET 
application script maps.  

11 Click Apply to save any changes. 

12 Click the HTTP Headers tab to display it. 

13 Select the Enable Content Expiration option to activate the expiration fields. 

14 Select the Expire Immediately option, then click Apply to save the change and then OK 
to close the TaskRun Properties dialog. The Internet Information Services window is 
redisplayed – the TaskRun folder's icon has changed. 

Install Crystal Reports Runtime (All OS) 
This procedure provides instructions on how to install the Crystal Reports Runtime files that 
are required by Taskmaster Web. 

1 On the Server, start Windows Explorer, navigate to c:\Datacap\install\tmweb7cr, and 
double-click the Setup.exe.   
When UAC is on, the User Account Control window opens.  Click Continue. 
The Welcome page of the Web Reports Setup wizard opens. 

2 Click Next.  The Select Installation Address page is displayed with default values in the 
Site and Virtual directory fields. 

3 Change the Virtual directory to tmweb.net, then click Next.  The Confirm Installation 
page is displayed. 

4 Click Next.  The Installing Web Reports page is displayed with progress messages and a 
progress indicator, and when complete, displays the Installation Complete window.  

5 Click Close to exit the installation process and close the wizard. 

Confirm Server.INI Points to TaskRun (All OS) 
This procedure provides instructions on how to ensure that the Server.ini file contains the 
correct value for the setting that Taskmaster Web uses to locate the TaskRun folder. 

1 On the Server, start Windows Explorer, navigate to and use a text editor such as 
Notepad to open the c:\Datacap\tmweb.net\server.ini file. 

2 The server.ini’s TempFolder= setting should be set to TempFolder=/TaskRun/ (folder 
name is case-sensitive) and if it is not, change it, save it, and close the file. 

Change SSL Setting in Server.INI (All OS) 
If you are using Secure Socket Layer to encrypt communications between Taskmaster Web 
and Taskmaster Web Clients, this procedure provides instructions on how to change the value 
of the SSL setting in the Server.ini file that controls Taskmaster Web's SSL behavior. 

1 On the Server, start Windows Explorer, navigate to and use a text editor such as 
Notepad to open the c:\Datacap\tmweb.net\server.ini file. 

2 Change the server.ini’s UseSSL=0 setting to UseSSL=1, save it, and close the file. 
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Start or Ensure Taskmaster Server Service is Started 
All configurations of Taskmaster (all components installed on a single Workstation or separate 
components installed on different machines) require that the Taskmaster Server Service be 
running before you can successfully start the application. 

This procedure provides instructions on how to start or ensure the Datacap Taskmaster Server 
Service is started on the Server. 

1 From the Server's Windows Start menu, select All Programs, select Datacap, select 
Taskmaster Server, and click Taskmaster Server.  The TMS Configuration window 
opens. 

2 When the Status: 

 Shows as Running, continue with the next step. 
 Shows as Stopped, click Start.  A Starting Service message is displayed.  The Status 

changes to Running when the service is started.  
If a Taskmaster Server Service error is displayed 
See the instructions in Configure Taskmaster on Server to re-grant Taskmaster Server 
Service Log On as a Service Right. 

3 Close the TMS Configuration window. 

Configure Taskmaster Web on Vista, Windows 2008, IIS 7 Server 

This section provides the information you need to set up Taskmaster Web on either a Vista 
machine (which limits the number of users to five) or a Windows 2008, IIS 7 Server so you 
can use the Taskmaster Web Client for processing. 

Prerequisites 
1 Ensure you have met the prerequisites detailed in Chapter 2 Installation and 

Configuration Prerequisites. 

2 Complete the instructions to install and configure all of the components on the Server 
and the Workstation, to copy the application to the Server, and to complete the Server 
configuration. 

3 From Datacap, obtain the password you need to use when logging in as the Taskmaster 
“admin” user. 

Stop or Ensure Taskmaster Server Service is Stopped 
This procedure provides instructions on how to stop or ensure the Datacap Taskmaster Server 
Service is stopped on the Server. 

1 From the Server's Windows Start menu, select Programs, select Datacap, select 
Taskmaster Server, and click Taskmaster Server.  The TMS Configuration window 
opens. 

2 When the Status: 

 Shows as Stopped, continue with the next step. 
 Shows as Running, click Stop.  A Stopping Service message is displayed.  The 

Status changes to Stopped when the service is stopped.  
3 Close the TMS Configuration window. 
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Add or Ensure Application Information in APPS.INI is Correct (All OS) 
When you have installed an application separately (for example, Taskmaster 7.6 for Medical 
Claims), or have used the Datacap Studio Application Wizard to create or copy an application 
from a Workstation to the Server, and you want to access that application using the Taskmaster 
Web Client, you must ensure the application information in the APPS.INI file that is on the 
Server is complete and correct. 

This procedure provides instructions on how to ensure the information is correct in and how to 
make all required changes to the APPS.INI file.   

1 On the Server, start up Windows Explorer, navigate to and open the application's 
process folder so you can see the names of the application's databases. 

2 On the Server, start up another instance of Windows Explorer, navigate to and use a text 
editor such as Notepad to open the c:\Datacap\tmweb.net\apps.ini file. 

3 Locate the section that contains information about the application (by default, apps.ini 
contains information about all of the applications shipped with Taskmaster). 

4 To change information about an application that was copied to the Server, edit the 
application's section so that it reflects the correct: 

 Application name (this is the name of the application folder on the Server) 
 Server UNC name (without initial backslashes) or IP address   
 Administration and Engine database names 
 Paths to the various databases 

5 To add information about a newly-created application, copy the entire section for an 
existing application (such as [APT]) and paste it below the original section but above 
the last line: 

 ;;; End of Apps.ini entries - Do not remove this line.  

 and then edit the copied section so that it reflects the new application's: 

 Application name (this is the name of the application folder on the Server) 
 Server UNC name (without initial backslashes) or IP address   
 Administration and Engine database names 
 Paths to the various databases 

6 Save the APPS.INI file, close the text editor, and close Windows Explorer. 

Add or Ensure Upload Limit Setting is Large Enough in web.config (All OS) 
Depending on the usual size of the images that will be uploaded from the Taskmaster Web 
Client to the Server, you should adjust the upload limit setting found in the web.config file that 
is on the Server when the Server operating system is Windows 2000, Windows 2003, Vista, or 
Windows 2008. 

This procedure provides instructions on how to locate and change the setting in the web.config 
file that affects upload speed.  

1 On the Server, start Windows Explorer, navigate to and open the c:\Datacap\tmweb.net 
folder, scroll down to the web.config file and open it in a text editor such as Notepad. 

2 Within the <system.web> element, locate or add the   
<httpRuntime maxRequestLength="52428" />  
element - this parameter is expressed in kilobytes. 
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3 Depending on the usual size of the images that are being uploaded, you can increase the 
size, for example: 
<httpRuntime maxRequestLength="102400" /> 

4 When you have made changes, save and close the file. 

Ensure Required IIS Components are Installed (Vista) 
This procedure provides instructions on how to ensure that the appropriate components have 
been installed in Internet Information Services when the Server’s operating system is Vista. 

1 From the Server’s Windows Start menu, select Control Panel, and on the Control Panel 
Home window, select Programs, and double-click Programs and Features.  The 
Programs and Features window opens with a Tasks pane on the left. 

2 In the Tasks pane, select Turn Windows features on or off. 
When UAC is on, the User Account Control window opens.  Click Continue. 
The Windows Features window opens and displays a list of features. 

3 Expand Internet Information Services, expand Web Management Tools, expand IIS 6 
Management Compatibility, and select or ensure IIS Metabase and IIS 6 configuration 
compatibility is selected. 

4 Scroll down and expand World Wide Web Services, expand Application Development 
Features, and select or ensure both ASP and ASP.NET are selected (selecting these 
options ensures other prerequisite features are selected).  

5 Click OK to save your changes.  Windows applies any changes you have made, then 
closes the Windows Features window. 

6 Close the Programs and Features window. 

Ensure Required IIS Components are Installed (Windows 2008) 
This procedure provides instructions on how to ensure that the appropriate components have 
been installed in Internet Information Services when the Server’s operating system is Windows 
2008. 

1 From the Server's Windows Start menu, select Control Panel, and on the Control Panel 
Home window, select Administrative Tools, and then select Server Manager. The 
Server Manager window opens. 

2 In the Server Manager hierarchy pane, expand Roles, and then select Web Server (IIS).  
The Web Server (IIS) window opens. 

3 In the Web Server (IIS) pane, scroll down to the Role Services section, and under 
Application Development, ensure the ASP.NET and ASP modules are installed (other 
modules will also be installed). 

4 In the Web Server (IIS) pane, scroll down to the Management Tools section, and ensure 
IIS 6 Management Compatibility is installed and that under it, IIS Metabase 
Compatibility is installed. 

5 Close the Server Manager window. 

Set IIS ASP Request Size Limit (Vista, Windows 2008) 
Depending on the usual size of the images that will be uploaded from the Taskmaster Web 
Client to the Server, you should adjust the default Maximum Requesting Entity Body Limit 
(maxRequestEntityAllowed).  
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This procedure provides instructions on how to locate and change the Maximum Requesting 
Entity Body Limit when the operating system is Vista or Windows 2008.  

1 From the Server's Windows Start menu, select Control Panel, and on the Control Panel 
Home window, click System and Maintenance.  The System and Maintenance window 
opens. 

2 Click Administrative Tools.  The Administrative Tools window opens. 

3 Double-click Internet Information Services.   
When UAC is on, the User Account Control window opens.  Click Continue. 
The Internet Information Services (IIS) Manager window opens. 

4 In the Connections pane, select the Server.  The Server’s Home pane is displayed. 

5 In the Home pane, scroll down to the IIS area and double-click ASP.   
If ASP is not displayed, ensure it was installed, then restart IIS and the ASP icon should 
be displayed.   
The ASP properties pane is displayed. 

6 In the Behavior section, expand Limits Properties.  Additional properties are displayed. 

7 Locate Maximum Requesting Entity Body Limit (maxRequestEntityAllowed), change 
the value (expressed in number of bytes) to reflect the appropriate size; for example, 
from 200000 (200 kb) to 10238976 (10MB), then tab out.  The Apply button in the 
Actions pane is enabled. 

8 In the Actions pane, click Apply.  A message box indicates the change was saved. 

9 Close the Internet Information Services (IIS) Manager window. 

Create (Nested) Taskmaster Web Site (Vista, Windows 2008) 
This procedure provides instructions on how to create the Taskmaster web site and set the 
parameters required by Taskmaster Web when Taskmaster Web is installed in a Vista or 
Windows 2008 IIS 7 environment. 

1 From the Server's Windows Start menu, select Control Panel, and on the Control Panel 
Home window, click System and Maintenance.  The System and Maintenance window 
opens. 

2 Click Administrative Tools.  The Administrative Tools window opens. 

3 Double-click Internet Information Services.   
When UAC is on, the User Account Control window opens.  Click Continue. 
The Internet Information Services (IIS) Manager window opens with a Connections 
pane on the left. 

4 In the Connections pane, expand the computer on which the web site will reside, and 
expand Sites, right-click the Default Web Site, and select Add Application from 
shortcut menu.  The Add Application dialog opens. 

5 Select or enter the following on the Add Application dialog: 

 Alias:  tmweb.net 
 Application pool: Classic .NET AppPool 
 Physical path:  c:\Datacap\tmweb.net 
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 When running on Windows 2008 x64 (64-Bit), also select Advanced Settings > 
Enable 32-Bit Applications and set to "True" 

 then click OK to save your settings, and OK to close the Add Application dialog. 

6 In the Connections pane, click the Default Web Site, in the far right pane, expand 
Manage Web Site, and click the Configure Limits… link. The Edit Web Site Limits 
dialog opens. 

7 Set the Connection Timeout field to 1200 (seconds), then click OK to save your change 
and close the Edit Web Site Limits dialog. 

8 In the Connections pane, click the Default Web Site, in the middle Default Web Site 
Home pane, in the IIS section, double-click the HTTP Response Headers icon.  The 
HTTP Response Headers pane opens. 

9 In the far right pane, click the Set Common Headers link.  The Set Common HTTP 
Response Headers dialog opens. 

10 Select Expire Web content, select Immediately, then click OK to save your changes and 
close the Set Common HTTP Response Headers dialog. 

11 Close the Internet Information Services (IIS) Manager window.  

Create TaskRun Folder and Set Up Security (Vista, Windows 2008) 
This procedure provides instructions on how to create the TaskRun processing folder required 
by Taskmaster Web.  This folder is where batches temporarily reside while they are being 
processed. 

IMPORTANT 

The TaskRun folder name is case-sensitive, must be named TaskRun, and must be created 
within the c:\Datacap folder structure at the same level as the tmweb.net folder. 

1 On the Server, start Windows Explorer, navigate to c:\Datacap, and create a folder 
named TaskRun. (Reminders: Folder name is case-sensitive; create this folder at the 
same level as the c:\Datacap\tmweb.net folder.) 

2 In Windows Explorer, right-click the TaskRun folder, and select Properties from the 
shortcut menu.  The TaskRun Properties dialog opens with the General tab displayed on 
top. 

3 Click the Security tab to display it. 

4 Add NETWORK SERVICE and set to allow Modify; add the local IUSR and set to 
allow Modify. 

5 Click OK to close the TaskRun Properties dialog. 

Set Up TaskRun Virtual Folder (Vista, Windows 2008) 
This procedure provides instructions on how to set up the TaskRun virtual folder required by 
Taskmaster Web. 

1 From the Server's Windows Start menu, select Control Panel, and on the Control Panel 
Home window, click System and Maintenance.  The System and Maintenance window 
opens. 

2 Click Administrative Tools.  The Administrative Tools window opens. 
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3 Double-click Internet Information Services.   
When UAC is on, the User Account Control window opens.  Click Continue. 
The Internet Information Services (IIS) Manager window opens with a Connections 
pane on the left. 

4 In the Connections pane, expand the computer on which the Taskmaster web site 
resides, and expand Sites, right-click the Default Web Site, and select Add Virtual 
Directory from shortcut menu.  The Add Virtual Directory dialog opens. 

5 Select or enter the following on the Add Virtual Directory dialog: 

 Alias:  TaskRun (case sensitive) 
 Physical path:  c:\Datacap\TaskRun (case sensitive)  

 then click OK to save your settings and close the Add Virtual Directory dialog. 

Install Crystal Reports Runtime (All OS) 
This procedure provides instructions on how to install the Crystal Reports Runtime files that 
are required by Taskmaster Web. 

1 On the Server, start Windows Explorer, navigate to c:\Datacap\install\tmweb7cr, and 
double-click the Setup.exe.   
When UAC is on, the User Account Control window opens.  Click Continue. 
The Welcome page of the Web Reports Setup wizard opens. 

2 Click Next.  The Select Installation Address page is displayed with default values in the 
Site and Virtual directory fields. 

3 Change the Virtual directory to tmweb.net, then click Next.  The Confirm Installation 
page is displayed. 

4 Click Next.  The Installing Web Reports page is displayed with progress messages and a 
progress indicator, and when complete, displays the Installation Complete window.  

5 Click Close to exit the installation process and close the wizard. 

Confirm Server.INI Points to TaskRun (All OS) 
This procedure provides instructions on how to ensure that the Server.ini file contains the 
correct value for the setting that Taskmaster Web uses to locate the TaskRun folder. 

1 On the Server, start Windows Explorer, navigate to and use a text editor such as 
Notepad to open the c:\Datacap\tmweb.net\server.ini file. 

2 The server.ini’s TempFolder= setting should be set to TempFolder=/TaskRun/ (folder 
name is case-sensitive) and if it is not, change it, save it, and close the file. 

Change SSL Setting in Server.INI (All OS) 
If you are using Secure Socket Layer to encrypt communications between Taskmaster Web 
and Taskmaster Web Clients, this procedure provides instructions on how to change the value 
of the SSL setting in the Server.ini file that controls Taskmaster Web's SSL behavior. 

1 On the Server, start Windows Explorer, navigate to and use a text editor such as 
Notepad to open the c:\Datacap\tmweb.net\server.ini file. 

2 Change the server.ini’s UseSSL=0 setting to UseSSL=1, save it, and close the file. 
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Start or Ensure Taskmaster Server Service is Started 
All configurations of Taskmaster (all components installed on a single Workstation or separate 
components installed on different machines) require that the Taskmaster Server Service be 
running before you can successfully start the application. 

This procedure provides instructions on how to start or ensure the Datacap Taskmaster Server 
Service is started on the Server. 

1 From the Server's Windows Start menu, select All Programs, select Datacap, select 
Taskmaster Server, and click Taskmaster Server.  The TMS Configuration window 
opens. 

2 When the Status: 

 Shows as Running, continue with the next step. 
 Shows as Stopped, click Start.  A Starting Service message is displayed.  The Status 

changes to Running when the service is started.  
If a Taskmaster Server Service error is displayed 
See the instructions in Configure Taskmaster on Server to re-grant Taskmaster Server 
Service Log On as a Service Right. 

3 Close the TMS Configuration window. 

Configure and Test Internet Explorer 

Configure and Test Internet Explorer 6 
This section provides the information you need to set up Internet Explorer 6 so you can use the 
Taskmaster Web Client for processing. 

Prerequisites 
1 Ensure you have met the prerequisites detailed in Chapter 2 Installation and 

Configuration Prerequisites. 

2 Complete the instructions to install and configure all of the components on the Server 
and the Workstation, to copy the application to the Server, to complete the Server 
configuration, and to configure Taskmaster Web on the Server. 

3 From Datacap, obtain the password you need to use when logging in as the Taskmaster 
“admin” user. 

Configure Internet Explorer 6 
This procedure provides instructions on how to configure Internet Explorer 6 so it can 
communicate with Taskmaster Web.  

Use these instructions to configure Internet Explorer 6 on any machine from which you want 
to run the Taskmaster Web Client, including:  When you have all components installed on a 
single machine, on the Server itself for testing purposes in a client/server environment, and on 
each Workstation that will run Taskmaster Web Client in a client/server environment. 

1 Start Internet Explorer 6 and display any web page. 

2 On the Tools menu, select Internet Options.  The Internet Options dialog opens with the 
General tab displayed on top. 

3 Click the Security tab to display it.  
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4 Select the Trusted Sites icon and click the Sites button to open the Trusted sites dialog. 

5 Clear the Require server verification option. 

6 Enter the URL of the Server as it is defined in your network's DNS (http://Server or 
https://Server) in the Add this website to the zone field, then click the Add button.  The 
site is added to Websites pane. 

7 Click OK or click Close.  The Internet Options dialog reappears with the Security tab 
displayed on top. 

8 Click the Custom level button.  The Security Settings dialog appears. 

9 Scroll down until the ActiveX controls and plug-ins settings are displayed. 

10 The following settings should be Enabled – if an option is not enabled, select its Enable 
option : 

 Download signed ActiveX controls 
 Download unsigned ActiveX controls 
 Initialize and script ActiveX controls not marked as safe for scripting 

11 Click OK.  A warning is displayed, asking you to confirm your change. 

12 Click Yes.  The Internet Options dialog reappears with the Security tab on top. 

13 Click OK to close the Internet Options dialog. 

Test Internet Explorer 6 
This procedure provides instructions on how to test your configuration of Internet Explorer 6.  

1 Start Internet Explorer 6. 

2 Enter either the default IP address of the Taskmaster Server Service or the URL of the 
Server followed by the tmweb.net virtual directory and the test page 
(http://127.0.0.1/tmweb.net/ietest.aspx, http://Server/tmweb.net/ietest.aspx, or  
https://Server/tmweb.net/ietest.aspx).  The IE Test page is displayed. 

3 Click Test.  The red Xs will change to green checkmarks when the test completes 
successfully. 

Configure and Test Internet Explorer 7 or 8 
This section provides the information you need to set up Internet Explorer 7 or 8 so you can 
use the Taskmaster Web Client for processing. 

Prerequisites 
1 Ensure you have met the prerequisites detailed in Chapter 2 Installation and 

Configuration Prerequisites. 

2 Complete the instructions to install and configure all of the components on the Server 
and the Workstation, to copy the application to the Server, to complete the Server 
configuration, and to configure Taskmaster Web on the Server. 

3 From Datacap, obtain the password you need to use when logging in as the Taskmaster 
“admin” user. 
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Configure Internet Explorer 7 or 8 
This procedure provides instructions on how to configure Internet Explorer 7 or 8 so it can 
communicate with Taskmaster Web.  You can configure Internet Explorer on the Server for 
testing purposes, and you must configure Internet Explorer on each Workstation that will run 
Taskmaster Web Client. 

1 On the Server, start Internet Explorer 7 or 8 and display any web page. 

2 On the Tools menu, select Internet Options.  The Internet Options dialog opens with the 
General tab displayed on top. 

3 Click the Security tab to display it.  

4 Select the Trusted Sites icon and click the Sites button to open the Trusted sites dialog. 

5 Clear the Require server verification option. 

6 Enter either the default IP address of the Taskmaster Server Service  (http://127.0.0.1),  
or the URL of the Server as it is defined in your network's DNS (http://Server or  
https://Server) in the Add this website to the zone field, then click the Add button.  The 
site is added to the Websites pane. 

7 Click Close.  The Internet Options dialog reappears with the Security tab displayed on 
top. 

8 Click the Custom level button.  The Security Settings dialog appears. 

9 Scroll down until the ActiveX controls and plug-ins settings are displayed. 

10 The following settings should be Enabled – if an option is not enabled, select its Enable 
option : 

 Download signed ActiveX controls 
 Download unsigned ActiveX controls 
 Initialize and script ActiveX controls not marked as safe for scripting 

11 Scroll down until the Miscellaneous setting are displayed. 

12 Enable (or ensure it is enabled), the Include local directory path when uploading files to 
a server option. 

13 Click OK.  A warning is displayed, asking you to confirm your changes. 

14 Click Yes.  The Internet Options dialog reappears with the Security tab on top. 

15 Click OK to close the Internet Options dialog. 

Test Internet Explorer 7 or 8 
This procedure provides instructions on how to test your configuration of Internet Explorer 7 
or 8.  

1 Start Internet Explorer. 

2 Enter either the default IP address of the Taskmaster Server Service or the URL of the 
Server as it is defined in your network's DNS followed by the tmweb.net virtual 
directory and the test page (http://127.0.0.1/tmweb.net/ietest.aspx, or 
http://Server/tmweb.net/ietest.aspx, or https://Server/tmweb.net/ietest.aspx).   
When UAC is on, the User Account Control window opens.  Click Continue as many 
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times as necessary. 
The IE Test page is displayed. 

3 Click Test.  The red Xs will change to green checkmarks when the test completes 
successfully. 

Run APT Taskmaster Web Client Application 

This section provides the information you need to run the Datacap Taskmaster foundation APT 
Taskmaster Web Client application “out of the box.”   

These instructions involve starting the Taskmaster Server Service, starting the Taskmaster 
Web Client, and running the default browser-based tasks to process pre-scanned images.  This 
section also provides instructions for running Taskmaster Web Client reports.  

Overview of APT Taskmaster Web Client 
The default shortcuts you run, and the sequence in which you run them using the APT 
Taskmaster Web Client are as follows: 

 

This shortcut Allows you to 
Scan Process sample, pre-scanned images. 

Upload Move scanned images to the Taskmaster Server Service for 
further processing 

Verify Perform data validation. 

NOTE 

To complete processing, the APT Batch Profiler and Export tasks must be run manually 
from the APT Taskmaster Client (thick client).  Or, in a client/server environment, the APT 
Batch Profiler and Export tasks can be run automatically as background tasks by either the 
Taskmaster Client Service or Datacap Rulerunner Quattro. 

Prerequisites 
1 Ensure you have met the prerequisites detailed in Chapter 2 Installation and 

Configuration Prerequisites. 

2 Complete the instructions to install and configure all of the components on the Server 
and the Workstation, to copy the application to the Server, to complete the Server 
configuration, to configure Taskmaster Web on the Server, and to configure Internet 
Explorer and test the connection to Taskmaster Web. 

3 From Datacap, obtain the password you need to use when logging in as the Taskmaster 
“admin” user. 

Start or Ensure Taskmaster Server Service is Started (Vista) 
All configurations of Taskmaster (all components installed on a single Workstation or separate 
components installed on different machines) require that the Taskmaster Server Service be 
running before you can successfully start the application. 

This procedure provides instructions on how to start or ensure the Datacap Taskmaster Server 
Service is started when the operating system is Vista. 
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1 From the Workstation's Windows Start menu, select All Programs, select Datacap, 
select Taskmaster Server, and click Taskmaster Server.   
When UAC is on, the User Account Control window is displayed - click Allow. 
The TMS Configuration window opens. 

2 When the Status: 

 Shows as Running, continue with the next step. 
 Shows as Stopped, click Start.  A Starting Service message is displayed.  The Status 

changes to Running when the service is started.  
3 Close the TMS Configuration window. 

Confirm Scanner is Available to Taskmaster Web Client (Vista) 
This procedure provides instructions on how to confirm your scanner is available to the 
Taskmaster Web Client when the Workstation's operating system is Vista. 

Note:  For running the Datacap sample or foundation applications, a physical scanner is not 
required as those applications can use the prescanned images included during installation. 

1 From the Workstation's Windows Start menu, select Settings, select Control Panel, 
select Hardware and Sound, and double-click Scanners and Cameras.  The Scanners and 
Cameras window opens. 

2 When your scanner is listed in the Scanners and Cameras window, it is available to the 
Taskmaster Web Client. 

Access Taskmaster Web Login Page and Login 
This procedure provides instructions on how to login to the APT Taskmaster Web Client 
application using Internet Explorer. 

’1 Open Internet Explorer, and enter the IP address of the Taskmaster Server Service 
followed by the alias you assigned to the website (for example: 
http://127.0.0.1/tmweb.net, http://Server/tmweb.net, or https://Server/tmweb.net).  After 
a pause, the Taskmaster Login window is displayed. 
NOTE:  You may have to turn off Internet Explorer’s popup blocker the first time you 
display the Login page. 

2 On the Taskmaster Web Login Page, enter the following: 

 

Field Value 
Application APT 

User ID admin 

Password password obtained from Datacap  

Station remote 

 

3 Click Login. The APT Taskmaster Web Client main window opens with the Operations 
pane and Available shortcuts displayed.  
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Run APT Taskmaster Web Client Scan Task 
This procedure provides instructions on how to run the APT Taskmaster Web Client virtual 
scan task and begin processing the sample invoices. 

1 On the Workstation, in the Operations pane, click the Scan shortcut.  The list of 
available jobs is displayed. 

2 Click the Web Demo shortcut.  The Web Demo Scan page is displayed.  The batch 
number assigned to this batch of documents is located in the upper left of the page. By 
default, the Multiple files option is selected. 

3 In the lower right of the page, if necessary change the Scan Into path – this path 
indicates the location into which the pre-scanned images are temporarily placed.  

4 Click Browse, navigate to the folder where the pre-scanned images are located 
(\\Server\Datacap\APT\images), select the first one, then click Open.  The Web Demo 
Scan page is redisplayed with the path to the Source folder. 

5 If you don't want to process all of the sample invoices (four single-page invoices and 
one two-page invoice), change the number in the Expected pages field to the number of 
images (not documents) you want to process, then click Scan.  A window indicates that 
scanning is taking place.  The pages are scanned, images of the pages are displayed, the 
batch-specific name of the folder is appended to the Scan Into path and an End of scan 
message is displayed. 

6 Click OK.  The message box closes.   

7 The following table describes some of the things you can do on the Web Demo Scan 
dialog: 

 

To Do This 
Change sequence of pages Select either the image in the left pane, or the 

name of the image in the right page that you 
want to move, then click either the MoveUp 
or MoveDown arrow 

Delete all pages Click Remove All 

Delete a single page Select the image you want to delete, then click 
Remove 

Enlarge scanned images Click Zoom in 

Shrink scanned images Click Zoom out 

Rotate an image Click Rotate 900 

Complete the Scan Task 
processing of the batch 

Click Done 

Cancel the Scan Task processing 
of the batch; deletes batch and all 
batch data from system 

Click Cancel 
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To Do This 
Put the batch on hold and end 
processing of the batch; batch 
remains available to same user  

Click Hold 

 

8 After all images have been scanned, click Done.  A message box is displayed indicating 
the Batch finished with a status of finished. 

9 Click OK.  A message box asks if you want to continue processing.   

10 Click Stop. The message box closes and the Operations pane is redisplayed. 

11 When the Scan task finishes successfully, the source images have been collected into a 
batch and copied to the batch’s uniquely-numbered folder found in the Scan Into folder. 

12 Click the Monitor tab to view information about the batch.  To refresh the information 
displayed, press F5.  The Job, Task, and Status for this batch have been updated and are 
now Web Demo, Upload, pending. 

Run APT Taskmaster Web Client Upload Task 
This procedure provides instructions on how to run the APT Taskmaster Web Client upload 
task. 

1 On the Workstation, in the Operations pane, click the Upload shortcut.  The Upload 
window opens and A transferring the batch to server message is displayed briefly, then 
closes.  A message box is displayed indicating the batch has finished with a status of 
finished. 

2 Click OK.  A message box asks if you want to continue processing.   

3 Click Stop. The message box closes and the Operations pane is redisplayed. 

4 When the Upload task finishes successfully, the scanned images have been moved to 
the batch’s uniquely-numbered folder found in \APT\batches on the Server and ivscan 
and upload xml files have been created.  

5 Click the Monitor tab to view information about the batch.  To refresh the information 
displayed, press F5.  The Job, Task, and Status for this batch have been updated and are 
now Web Demo, Batch Profiler, pending. 

Start APT Taskmaster Client 
This procedure provides instructions on how to start the APT Taskmaster Client application.  If 
you have logged into the Taskmaster Client before, the information you entered previously is 
displayed. 

1 From the Workstation's Windows Start menu, select All Programs, select Datacap, 
select Applications, select APT, and click the APT Client icon (the target of this icon 
should be pointing to the local TMClient.exe with parameters pointing to the 
APTAdm.mdb and APTEng.mdb in the application's process folder on the \\Server).  
The Select Taskmaster Server dialog opens. 

2 Enter the Server name (without initial backslashes) or IP address of the Server hosting 
the application and click OK.  A Please login window opens. 
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3 Ensure the User ID is admin, enter the password provided by Datacap, and ensure the 
Station is set to 1, then click OK. 

4 The APT main window opens with the Operations pane displayed. 

Run APT Taskmaster Client Batch Profiler Task (Background Shortcut) (Vista) 
This procedure provides instructions on how to run the APT Taskmaster Client Batch Profiler 
task. 

1 On the Workstation, in the Operations pane, double-click the Background shortcut.  A 
Task Monitor window opens and a Rulerunner window opens displaying a progress bar, 
then they both close.  This may take a few minutes, as Rulerunner is running a number 
of processing-intensive modules, including PageID, ImageFix, CreateDocs, Recognize, 
FindFingerprint, Locate, lookups, and others.  When processing is complete, a message 
box is displayed indicating the task has finished.   

2 Click OK.  A message box asks if you want to continue processing. 

3 Click No.  The message box closes and the Operations pane is redisplayed.   
When the Batch Profiler task finishes successfully, the images have been organized into 
documents, copies (TIO) have been made of the original images, fingerprint (CCO) and 
page XML files have been created, along with a BatchProfiler.xml file in the batch's 
uniquely-numbered folder in \APT\batches (on the Server). 

4 To refresh the information displayed in the Job Monitor window, click the Job 
Monitor's title bar and press F5.  The Job.Task and Status for this batch have been 
updated and are now Demo.Verify and pending. 

 

Run APT Taskmaster Web Client Verify Task 
This procedure provides instructions on how to run the Taskmaster Web Client Verify task. 
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1 On the Workstation, in the Operations pane, click the Verify shortcut.  The verification 
panel opens with the first image displayed.  

2 The following table describes some of the things you can do on the verification panel: 

To Do This 
Move to the next data field Press <Tab> 

Move to the next low confidence 
character 

Click Next LC 

Fill empty field with data using Click 
N Key 

Click in the empty data entry field, then 
do one of the following: 

Point at the field value on the image and 
click it, or, 

Click and drag the mouse to draw a 
rectangular box around the existing field 
data on the image 

Complete processing of image and 
display next image 

Click SuBmit 

Mark the document for deletion, 
rescanning, or review 

Select appropriate choice from Routing 
Instructions dropdown list 

Display the first page of the next 
document in the batch without 
submitting or revalidating data 

Click Next Page 

Display the first page of the previous 
document in the batch without 
submitting or revalidating data 

Click Previous Page 

Display the first page, next page, 
previous page, or last page of the 
current document 

Click the Page No |< 
> 
< 
or >| Browse button 

Display the details of the first line 
item, next line item, previous line 
item or last line item 

Click the Lineitem |< 
> 
< 
or >| Browse button 

For all detail lines, locate all field 
values for all fields 

Click Find Details 

Calculate missing numeric values 
using existing values and 
automatically fill blank numeric 
fields 

Click Calculate Blank 

Move to the next problem document 
in the batch 

Click Next Problem 

Move to the previous problem 
document in the batch 

Click Previous Problem 
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To Do This 
Identify the type of invoice Select from Invoice Type dropdown list 

Display snippet associated with a 
field 

Select Disp snip 

Create new fingerprint for this 
invoice 

Select Yes from Add New Fingerprint 
dropdown list 

Put entire batch on hold Click Hold 

Override an error  Select Override 

 

3 When you have finished with the last document and click SuBmit, a message box is 
displayed indicating all documents are complete. 

4 Click OK.  The message box closes and another message box is displayed indicating the 
task on the batch has finished with a status of finished. 

5 Click OK.  A message box asks if you want to continue processing.   

6 Click No.  The message box closes and the Operations pane is redisplayed. 

7 When the Verify task finishes successfully, page XML files have been updated (for 
example, when low confidence characters have been changed during Verify), and a 
Verify.xml file has been created in the batch’s uniquely-numbered folder found in 
\APT\batches on the Server. 

8 Click the Monitor tab to view information about the batch.  To refresh the information 
displayed, press F5.  The Job, Task, and Status for this batch have been updated and are 
now Web Demo, Export, pending. 

Run APT Taskmaster Client Export Task (Export Shortcut) (Vista) 
This procedure provides instructions on how to run the APT Taskmaster Client Export task. 

1 On the Workstation, in the Operations pane, double-click the Export shortcut.  A Task 
Monitor window opens and a Rulerunner window opens displaying a progress bar, then 
they both close.  A message box is displayed indicating that the Export task finished. 

2 Click OK.  A message box asks if you want to continue processing. 

3 Click No.  The message box closes and the Operations pane is redisplayed. 
When the Export task finishes successfully: 

• Export saves information about unknown invoices that were successfully 
validated  (creates new fingerprints) so that the next time Taskmaster APT “sees” 
the same invoice, it can identify the vendor and extract the field data using a 
process called Intellocate. 

• An Export XML file has been added to the batch’s uniquely-numbered folder 
found in \APT\batches (on the Server). 

• Export outputs the field data to XML files.  The XML files and the image files 
are now ready to be input into a back-end application.  

• If you configured Taskmaster APT to send email notifications and then, during 
Verify, you marked an invoice for review or rescan, or deleted an invoice, Export 
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also sends the appropriate emails with the marked or deleted image attached as a 
PDF file.  If you did not configure email notifications, the PDFs of the marked or 
deleted images stay in the batch's uniquely-numbered folder in \APT\batches (on 
the Server); the images and information about the images are not exported.  

4 To refresh the information displayed in the Job Monitor window, click the Job 
Monitor's title bar and press F5.  The Job.Task and Status for this batch have been 
updated and are now Demo.Export and Job Done.   

 

Generate APT Taskmaster Web Client Reports Manually 

This section provides the information you need to run the Datacap Taskmaster sample 
Taskmaster Web Client APT reports “out of the box.”   

Overview of APT Taskmaster Web Client Report Viewer 
The Taskmaster Web Client APT Report Viewer is built into the Taskmaster Web Client and 
you access it from the Reports link on the Monitor pane. 

Prerequisites 
1 Ensure you have met the prerequisites detailed in Chapter 2 Installation and 

Configuration Prerequisites. 

2 Complete the instructions to install and configure all of the components on the Server 
and the Workstation, to copy the application to the Server, to complete the Server 
configuration, to configure Taskmaster Web on the Server, and to configure Internet 
Explorer and test the connection to Taskmaster Web. 

3 From Datacap, obtain the password you need to use when logging in as the Taskmaster 
“admin” user. 
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4 To view actual data on one or more reports, run one or more of the Taskmaster Client or 
Taskmaster Web Client APT tasks. 

5 Ensure the Taskmaster Server Service is started.  

Create Taskmaster Web Client Reports Manually 
This procedure provides instructions on how to generate Taskmaster Web Client reports 
manually. 

1 With the Taskmaster Web Client Operations window open, click Monitor.  The Job 
Monitor window opens. 

2 Click Reports to display the list of Available reports. 

3 Select the report you want to generate.  A Selected report details pane opens on the 
right.  In the: 

 Available filters portion of the dialog, select a filter (optional) 
 Date portion of the dialog, make changes to indicate the time period to be 

included on the report  
 then click Show Report.  The report is displayed. 

4 Use the buttons and fields on the toolbar as follows: 

 

To Do This 
Export data to PDF file 1 Click Export.  The Export the Report window opens. 

2 Select Acrobat Format (PDF) from the drop-down 
list.  If you want to export a subset of the pages, select 
Pages and enter the From and To page numbers. 

3 Click OK.   The report pages are displayed in an 
Adobe Acrobat viewer window. 

4 Click Save to save the report pages as a PDF file, or 
use the other buttons and fields on the toolbar as 
appropriate. 
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To Do This 
Export data to DOC, 
XLS, or RTF file 

1 Start the application (Microsoft Word, Microsoft 
Excel) into which you want to place the report data. 

2 Switch back to the Taskmaster Web Client report 
window, and click Export.  The Export the Report 
window opens. 

3 Select the appropriate file format from the drop-down 
list.  If you want to export a subset of the pages, select 
Pages and enter the From and To page numbers. 

4 Click OK.  The report pages are displayed in a viewer 
window. 

5 Press <CTRL+ A> and then <CTRL + C> to select 
and copy the contents of the report pages to the 
Windows Clipboard. 

6 Switch to the other application (Microsoft Word, 
Microsoft Excel) and press <CTRL + V> to paste the 
contents of the report into that application. 

7 On the File menu, select Save As, then name and save 
the report in the application's file format.  

Print report 1 Click Print.  The Print the Report window opens.   

2 If you want to print a subset of the pages, select Pages 
and enter the From and To page numbers. 

3 Click OK.  The report pages are displayed in an 
Adobe Acrobat viewer window. 

4 Click Print.  The Windows Print window opens. 

5 Adjust the Windows Print controls as appropriate, 
then click OK to print the report pages.  

6 Close the viewer window. 

Show or Hide Group 
Tree 

Click Show/Hide Group Tree. 

Display first page of 
report 

Click First. 

Display previous page Click Prev. 

Display next page Click Next. 

Display last page of 
report 

Click Last. 

Display specific page Enter a page number then click Go To. 

Search for a string on the 
report 

Enter the string you want to search for, then click 
Find.  The string is highlighted on the report. 
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To Do This 
Resize (enlarge or 
shrink) the report 

Select the appropriate percentage from the drop-down 
list. 

Close report and return to 
the list of Available 
reports 

Click << Back to Reports Selection. 

 

5 To close the report and return to the list of reports, click <<Back to Reports Selection.  
The list of Available reports is displayed. 

6 Logoff the Taskmaster Web Client. 

Run Datacap Studio Application 

This section provides the information you need to run the Datacap Studio application.  These 
instructions involve starting the Taskmaster Server Service, and starting Datacap Studio. 

Prerequisites 
1 Ensure you have met the prerequisites detailed in Chapter 2 Installation and 

Configuration Prerequisites. 

2 Complete the instructions provided to install and configure all of the components on the 
Server and the Workstation, to copy the application to the Server, and to complete the 
Server configuration. 

2 From Datacap, obtain the password you need to use when logging in as the Taskmaster 
“admin” user. 

Start or Ensure Taskmaster Server Service is Started 
All configurations of Taskmaster (all components installed on a single Workstation or separate 
components installed on different machines) require that the Taskmaster Server Service be 
running before you can successfully start the application. 

This procedure provides instructions on how to start or ensure the Datacap Taskmaster Server 
Service is started on the Server. 

1 From the Server's Windows Start menu, select All Programs, select Datacap, select 
Taskmaster Server, and click Taskmaster Server.  The TMS Configuration window 
opens. 

2 When the Status: 

 Shows as Running, continue with the next step. 
 Shows as Stopped, click Start.  A Starting Service message is displayed.  The Status 

changes to Running when the service is started.  
If a Taskmaster Server Service error is displayed 
See the instructions in Configure Taskmaster on Server to re-grant Taskmaster Server 
Service Log On as a Service Right. 

3 Close the TMS Configuration window. 
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Start Up Datacap Studio 
This procedure provides instructions on how to start up Datacap Studio.  

1 From the Workstation's Windows Start menu, select All Programs, select Datacap, 
select Datacap Studio, and select Datacap Studio again.  A Taskmaster Server dialog 
opens. 

2 Enter the Server name (without initial backslashes) or IP address of the Server hosting 
the application and click OK, then click Next.  A Connection progress bar is displayed 
briefly, then the Select Application - Rulerunner Service dialog opens. 

3 Select the Work offline. Internal Rulerunner service option, then click Next.  The Select 
Application – Applications dialog opens. 

4 Select the appropriate application and click Next.  A Connection Progress window is 
displayed briefly, then the Select Application – Taskmaster Login dialog opens. 

5 Select the Taskmaster authentication option, and ensure the User ID is admin, enter the 
password provided by Datacap, and ensure the Station is set to 1, then click Finish.  The 
Datacap Studio main window opens with the Rulemanager tab displayed on top. 

Set Up Schedule for Automatic APT Report Generation 

This section provides the information you need to set up a schedule for automatically 
generating one or more APT Taskmaster Client reports. 

Overview of Taskmaster Client Report Scheduling 
To generate and print Taskmaster Client reports automatically, you must:  

• Set up a report schedule 

• Define the printer on which the reports are to be printed 

• Leave Taskmaster Client Report Viewer running  

Prerequisites 
1 Ensure you have met the prerequisites detailed in Chapter 2 Installation and 

Configuration Prerequisites. 

2 Complete the instructions to install and configure all of the components on the Server 
and the Workstation, to copy the application to the Server, to complete the Server 
configuration, to configure Taskmaster Web on the Server, and to configure Internet 
Explorer and test the connection to Taskmaster Web. 

3 From Datacap, obtain the password you need to use when logging in as the Taskmaster 
“admin” user. 

4 To view actual data on one or more reports, run one or more of the APT Taskmaster 
Client or Taskmaster Web Client tasks. 

5 Exit the Taskmaster Client on the Workstation before starting Report Viewer on the 
Workstation. 

6 The reports and custom filters you want to use must exist.  For assistance with creating 
or customizing reports and filters, contact your Datacap Implementation Specialist. 
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Start or Ensure Taskmaster Server Service is Started 
All configurations of Taskmaster (all components installed on a single Workstation or separate 
components installed on different machines) require that the Taskmaster Server Service be 
running before you can successfully start the application. 

This procedure provides instructions on how to start or ensure the Datacap Taskmaster Server 
Service is started on the Server. 

1 From the Server's Windows Start menu, select All Programs, select Datacap, select 
Taskmaster Server, and click Taskmaster Server.  The TMS Configuration window 
opens. 

2 When the Status: 

 Shows as Running, continue with the next step. 
 Shows as Stopped, click Start.  A Starting Service message is displayed.  The Status 

changes to Running when the service is started.  
If a Taskmaster Server Service error is displayed 
See the instructions in Configure Taskmaster on Server to re-grant Taskmaster Server 
Service Log On as a Service Right. 

3 Close the TMS Configuration window. 

Start Taskmaster Client Report Viewer 
This procedure provides instructions on how to start up the Taskmaster Client Report Viewer.  
Exit the Taskmaster Client on the Workstation before starting Report Viewer on the 
Workstation. 

Note that after the first time you log into Report Viewer, it remembers and displays what you 
entered the previous time. 

1 From the Workstation's Windows Start menu, select All Programs, select Datacap, 
select Applications, select APT, and click the APT Report Viewer icon.  A Select 
Taskmaster Server dialog opens. 

2 Enter the Server name (without initial backslashes) or IP address of the Server hosting 
the application and click OK.  The Report Viewer Login window is displayed. 

3 Enter User ID of admin, enter the password provided by Datacap, and ensure the Station 
ID is set to 1, then click OK.  The Report Viewer main window opens. 

Set Up Taskmaster Client Report Schedule 
This procedure provides instructions on how to set up a schedule for running Taskmaster 
Client reports automatically.  

1 With the Report Viewer main window open, on the View menu, select Settings.  The 
Settings dialog is displayed. 

2 Select Run On StartUp (this ensures Report Viewer is started every time the 
Workstation is started), and select Run Schedule (this enables automated report 
scheduling), then click OK.  The Settings dialog closes. 

3 On the View menu, select Schedule.  The Schedule dialog is displayed. 

4 Click Add.  A blank row is added to the Schedule dialog. 
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5 Select Run, then click in each field and select, enter, or change the values that define 
how frequently the report runs, what time the report runs, which report is run, and 
which report filter is used when the report runs. 

6 Repeat the previous step for each occurrence of each report that you want to schedule. 

7 When you have added rows for each occurrence of each report that you want to 
generate, click OK.  The Schedule dialog closes. 

Define Report Printer 
This procedure provides instructions on how to define the printer on which the reports are to be 
printed.  A report must be displayed before you can define the printer;  the report can be any 
report, and it does not have to contain data. 

1 With the Report Viewer main window open, on the Report menu, select Open.  The 
Open Report dialog is displayed with the Background Tasks report selected. 

2 Click Open.  The empty report is displayed. 

3 On the Report menu, click Print Report.  The Print Setup window opens. 

4 Clear the No Printer checkbox and select the appropriate printer from the drop-down 
list, and adjust the other Windows Print controls as appropriate. 

5 Click OK.  The Windows Print window opens. 

6 Click Cancel.  The Windows Print window closes. 

7 On the Report menu, click Close.  The report window closes. 

Produce Reports 
Once the report schedule has been set up and the report printer has been defined, for reports to 
be produced automatically, the printer must be active, the Taskmaster Client Report Viewer 
must be running, and the Taskmaster Client must not be running on that machine during the 
report production schedule. 

Install and Configure Taskmaster Client Service 

All Taskmaster’s Windows- or browser-based software tasks can be run manually.  In addition, 
the Taskmaster Client Service can be configured to run tasks that do not require human 
intervention (background tasks) on a separate workstation or server.  Depending on what you 
want to accomplish, and on your current Taskmaster application(s) and client/server 
environment, running the Taskmaster Client Service on a separate machine may offer 
significant processing advantages.  Be sure to contact your Datacap Implementation Specialist 
or Support before configuring the Taskmaster Client Service. 

This section provides the information you need to set up the Taskmaster Client Service on a 
separate, unattended workstation or server (referred to as the "TCSServer") to run one 
application's background tasks automatically.   

Optional instructions are also provided to configure the Taskmaster Client Service to use 
Windows Authentication rather than standard Taskmaster Authentication. 

This section assumes that you have a working Taskmaster client/server environment with at 
least one Workstation and one Server. 
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Overview of Taskmaster Client Service Set Up 
To set up and use the Taskmaster Client Service to run background tasks, you must:  

• Determine which Datacap application and tasks you want the Taskmaster Client Service to 
process 

• Create a domain account for the Taskmaster Client Service  

• Configure Taskmaster Server Service to Use Windows Authentication (optional) 

• Start the Taskmaster Server Service  

• Start the application's Taskmaster Client, add a group, user, and station for the Taskmaster 
Client Service to use, and identify which tasks in which jobs the Taskmaster Client 
Service is to run 

• Install and configure the Taskmaster Client Service on the Taskmaster Client Service 
(TCSServer) server 

• Test the Taskmaster Client Service  

• Leave Taskmaster Client Service running  

Prerequisites 
1 Ensure you have met the prerequisites detailed in Chapter 2 Installation and 

Configuration Prerequisites. 

2 Complete the instructions to install, configure, and test all components of your 
client/server Taskmaster system. 

3 From Datacap, obtain the password you need to use when logging in as the Taskmaster 
“admin” user. 

4 The Taskmaster workflow, jobs, and tasks that this Taskmaster Client Service is 
responsible for processing must already exist and must work when a user runs them 
manually from a Workstation. 

Determine Which Datacap Application to Process 
Before you set up the Taskmaster Client Service, you need to determine which Datacap 
application contains background tasks suitable for Taskmaster Client Service processing.  
Typically, these will be Rulerunner and export tasks, but can be any tasks that do not require 
human interaction. 

Create or Ensure Account Exists for Taskmaster Client Service 
Create or ensure a specific domain account exists for the Taskmaster Client Service. 

If you are using Windows Authentication, ensure the Taskmaster Client Service account has 
been added to the appropriate Taskmaster-specific AD/LDAP security group or groups.  For 
more information, see Configure Windows Authentication for Taskmaster. 

Stop or Ensure Taskmaster Server Service is Stopped 
This procedure provides instructions on how to stop or ensure the Datacap Taskmaster Server 
Service is stopped on the Server. 
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1 From the Server's Windows Start menu, select Programs, select Datacap, select 
Taskmaster Server, and click Taskmaster Server.  The TMS Configuration window 
opens. 

2 When the Status: 

 Shows as Stopped, continue with the next step. 
 Shows as Running, click Stop.  A Stopping Service message is displayed.  The 

Status changes to Stopped when the service is stopped.  
3 Close the TMS Configuration window. 

Configure Taskmaster Server Service to use Windows Authentication 
This procedure provides instructions on how to configure Taskmaster Server Service to use 
Windows Authentication. 

1 With the TMS Configuration window open, click the Taskmaster tab to display it. 

2 Click Show advanced to display Advanced Settings. 

3 Depending on the type of user lookup syntax your organization is using, enter one of the 
following strings in the LDAP template (requires restart) field.  For: 

 Native AD authentication, enter: 
WinNT://<%domain%>/<%user%>  

 Typical LDAP authentication, enter:  
LDAP://CN=<%user%>,CN=Users,DC=<%domain%>,dc=Com 

 then click Save.   

4 Click the Service tab to display it. 

5 Click Start to start Taskmaster Server Service.  A Starting Service message is displayed.  
The Status changes to Running when the service is started. 

6 Close the TMS Configuration window. 

Start or Ensure Taskmaster Server Service is Started 
All configurations of Taskmaster (all components installed on a single Workstation or separate 
components installed on different machines) require that the Taskmaster Server Service be 
running before you can successfully start the application. 

This procedure provides instructions on how to start or ensure the Datacap Taskmaster Server 
Service is started on the Server. 

1 From the Server's Windows Start menu, select All Programs, select Datacap, select 
Taskmaster Server, and click Taskmaster Server.  The TMS Configuration window 
opens. 

2 When the Status: 

 Shows as Running, continue with the next step. 
 Shows as Stopped, click Start.  A Starting Service message is displayed.  The Status 

changes to Running when the service is started.  
If a Taskmaster Server Service error is displayed 
See the instructions in Configure Taskmaster on Server to re-grant Taskmaster Server 
Service Log On as a Service Right. 
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3 Close the TMS Configuration window. 

Start Taskmaster Client Application 
This procedure provides instructions on how to start the Taskmaster Client for a Datacap 
application.  If you have logged into the application's Taskmaster Client before, the 
information you entered previously is displayed. 

1 From the Workstation's Windows Start menu, select All Programs, select Datacap, 
select Applications, select the application you want to start, and click the application's 
Client icon.  The Select Taskmaster Server dialog opens  

2 Enter the Server name (without initial backslashes) or IP address of the Server hosting 
the application and click OK.  A Please login window opens. 

3 Enter your User ID, Password, and Station, then click OK. 

4 The application's main window opens with the Operations pane displayed. 

Add Group, User, and Station for Taskmaster Client Service 
This procedure provides instructions on how to add a Taskmaster Client Service group, user, 
and station to your Taskmaster application so the Taskmaster Client Service group has the 
Permissions and Privileges it needs for processing.   

If you are using Windows Authentication, see Configure Windows Authentication for 
Taskmaster for information on naming this group. 

1 On the Workstation, with the application's main window open, on the Settings menu, 
select Groups.  The Taskmaster Administrator dialog opens with the Groups tab 
displayed on top and the existing Groups listed in the left pane. 

2 Click Add, and enter a Group ID and description for the Taskmaster Client Service 
Group, then click Apply. A message box indicates the new settings will apply after 
currently signed on users log off and log back on again. 

3 Click OK to close the message box.  The Privileges, Permissions, and Users pane is 
enabled. 

4 Expand the Privileges branch, expand the Client(s) item, select Taskmaster Sub (Client 
Service), then click Apply.  A message box indicates the new settings will apply after 
currently signed on users log off and log back on again. 

5 Click OK to close the message box, and in the Permissions branch, clear the All option, 
and select the background tasks within every job that you want the Taskmaster Client 
Service to process (typically Rulerunner and export tasks, but can be any tasks that do 
not require human interaction), then click Apply.  A message box indicates the new 
settings will apply after currently signed on users log off and log back on again. 

6 If you are using Windows Authentication, skip to step 11, otherwise, click OK to close 
the message box, then click the Users tab to display it. 

7 Click Add, and enter the User ID of the Taskmaster Client Service domain account, 
then click Set Password, and enter the password of the Taskmaster Client Service 
domain account, and then click OK and Apply. A message box indicates the new 
settings will apply after currently signed on users log off and log back on again. 

8 Click OK to close the message box.  The Privileges, Permissions, and Groups pane is 
enabled.  
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9 In the Privileges branch, expand the Client(s) item, select Taskmaster Sub (Client 
Service), then click Apply.  A message box indicates the new settings will apply after 
currently signed on users log off and log back on again. 

10 Click OK to close the message box, then scroll down to the Groups branch, and, at a 
minimum, add the user to the Taskmaster Client Service group, then click Apply.  A 
message box indicates the new settings will apply after currently signed on users log off 
and log back on again. 

11 Click OK to close the message box and click the Stations tab to display it.  

12 Click Add, and enter a Station ID and description for the Taskmaster Client Service 
station, then click Apply. A message box indicates the new settings will apply after 
currently signed on users log off and log back on again. 

13 Click OK to close the message box, and in the Permissions branch, clear the All option, 
and select the background tasks within every job that you want this station to process, 
then click Apply.  A message box indicates the new settings will apply after currently 
signed on users log off and log back on again. 

14 Click OK to close the message box, then click Done to close the Taskmaster 
Administrator dialog. 

Install Taskmaster Client on Taskmaster Client Service Machine 
Follow the instructions in Installation Instructions for Workstation to install the Taskmaster 
Client component on the TCSServer, but do not configure it. 

Ensure Taskmaster Client Service Machine's Registry Points to TMServer 
Edit or ensure that the TCSServer's Windows registry RRS\locations\rrs key reflects the UNC 
name of the Taskmaster Server hosting the application you want the Taskmaster Client Service 
to process and the path to the \\Server\Datacap\RRS folder.  

Regedit:  HKEY_LOCAL_MACHINE > SOFTWARE > DATACAP > RRS> locations > rrs 
should reflect:  \\Server\Datacap\RRS\. 

Create System DSNs Required by Taskmaster Client Service 
When you install the Taskmaster Client Service on the TCSServer so it can process an 
application's background tasks, when that application uses System DSNs to access databases 
(for example a fingerprint database or a lookup database), you must create those same System 
DSNs on the TCSServer so it can connect to the correct databases during processing. 

This procedure provides instructions on how to identify an application's System DSNs and 
how to create the exact same System DSNs on the TCSServer. 

1 On a Workstation on which the Taskmaster Client component has been installed and on 
which you have successfully run all of the application's tasks (this implies the correct 
System DSNs have already been set up on this Workstation), on the Windows Start 
menu, select Settings, select Control Panel, select Administrative Tools, and double-
click Data Sources (ODBC) to open the ODBC Data Source Administrator window. 

2 Click the System DSN tab to display it.  Existing data sources are listed, and you should 
be able to tell by the DSN names which DSNs are related to the application.  The names 
should reflect the application name and the type of database, for example: 
APTFingerprint, APTLook, or ExpressRule. 
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3 For each of the application's DSNs, make a note of the Driver, then select it, and click 
Configure.  The ODBC Setup window for the driver opens. 

4 Make an exact note of the Data Source Name (this is the name you must use on the 
TCSServer when you create the DSN) and then click the Select button.  The Select 
Database window opens. 

5 Use the information in this window to make a note of the full UNC path to the 
application's Process folder and the name of the database, then click Cancel to close the 
window.  

6 Click Cancel to close the ODBC Setup window. 

7 Repeat steps 3 - 6 for each DSN referenced in the application, then click OK to close 
the ODBC Data Source Administrator window.  

8 Close the Administrative Tools window on the Workstation. 

9 On the TCSServer’s Windows Start menu, select Settings, select Control Panel, select 
Administrative Tools, and double-click Data Sources (ODBC) to open the ODBC Data 
Source Administrator window. 

10 Click the System DSN tab to display it.  Existing data source names and drivers are 
listed. 

11 Click Add.  The Create New Data Source window opens. 

12 Scroll down and select the appropriate driver, then click Finish.  The ODBC Setup 
window for the driver opens. 

13 Enter the Data Source Name for the database referenced in the application, and a 
Description, then click Select.  The Select Database window opens. 

14 Navigate to the Process folder of the application on the Server, select the appropriate 
database and click OK.  The ODBC Setup window is redisplayed with the database 
information displayed.  

15 Click OK.  The ODBC Setup window closes and the ODBC Data Source Administrator 
window is displayed with the newly created data source name. 

16 Repeat steps 11 - 15 for each DSN referenced in the application, then click OK to close 
the ODBC Data Source Administrator window.  

17 Close the Administrative Tools window on the TCSServer. 

Grant Taskmaster Client Service Log On as a Service Right 
This procedure provides instructions on how to ensure the domain account used by the 
Taskmaster Client Service has been granted the Log On as a Service right on the TCSServer 
(this allows the service to log on automatically when the TCSServer is restarted). 

1 From the TCSServer's Windows Start menu, select Settings, select Control Panel, select 
Administrative Tools, select Services, right-click Datacap Taskmaster Client Service 
and select Properties.  The Datacap Taskmaster Client Service Properties dialog opens 
with the General tab displayed on top. 

2 Click the Log On tab to display it, then select This account.  The Browse button is 
enabled. 
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3 Locate or enter the domain name, user name and password of the Taskmaster Client 
Service, and click Apply.  A message is displayed confirming the user was granted the 
Log On as a Service right. 

4 Click OK to close the message box, then close the Services window. 

Add Taskmaster Client Service Account on Taskmaster Client Service Machine 
Add the Taskmaster Client Service domain account to the TCSServer’s Administrators group 
so that the account has local administrator rights on the machine. 

If your corporate policy restricts Administrators group privileges, or precludes granting 
administrator rights to the Taskmaster Client Service, you must grant the Taskmaster Client 
Service account a number of permissions using DCOM Config. 

On the TCSServer, in Administrative Tools > Component Services  > Computers > My 
Computer > DCOM Config, change the following TaskMaster.RunTask properties on the 
Security tab: 

• Launch and Activation Permissions: Select Customize, click Edit, add the Taskmaster 
Client Service account and allow Local Launch, Remote Launch, Local Activation, 
Remote Activation. 

• Access Permissions: Select Customize, click Edit, add the Taskmaster Client Service 
account and allow Local Access and Remote Access. 

• Configuration Permissions: Select Customize, click Edit, add the Taskmaster Client 
Service account and allow Full Control. 

Set Up Datacap Folder Sharing for Taskmaster Client Service (Vista, Windows 2008) 
This procedure provides instructions on how to set up the appropriate Taskmaster Client 
Service sharing permissions for the Server's c:\Datacap folder when the Server's operating 
system is Vista or Windows 2008. 

1 On the Server, start Windows Explorer, navigate to and right-click the c:\Datacap folder 
and select Properties.  The Properties dialog opens with the General tab displayed. 

2 Click the Sharing tab to display it, then click Advanced Sharing. 
When UAC is on, the User Account Control window is displayed.  Click Continue. 
The Advanced Sharing dialog opens. 

3 Click Share this Folder and keep Datacap as the Share name.  

4 Click Permissions.  The Permissions for Datacap dialog is displayed. 

5 Add/ensure Domain/Windows User ID for Taskmaster Client Service is set to allow 
Full Control. 

6 Click Apply, then OK to save your changes and close the Datacap Properties dialog. 

Set Up Datacap Folder Sharing for Taskmaster Client Service (Windows 2000, Windows 
2003) 
This procedure provides instructions on how to set up the appropriate Taskmaster Client 
Service sharing permissions for the Server's c:\Datacap folder when the Server's operating 
system is Windows 2000 or Windows 2003. 
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1 On the Server, start Windows Explorer, navigate to and right-click the c:\Datacap folder 
and select Properties.  The Datacap Properties dialog opens with the General tab 
displayed. 

2 On the Sharing tab, click Permissions. The Permissions for Datacap dialog is displayed. 

3 Add/ensure Domain/Windows User ID for Taskmaster Client Service is set to allow 
Full Control. 

4 Click Apply, then OK to save your changes and close the Datacap Properties dialog. 

Set Up Security on Shared Folder for Taskmaster Client Service (All OS) 
This procedure provides instructions on how to set up the appropriate Taskmaster Client 
Service security permissions for the Server's Datacap folder when the Server's operating 
system is Windows 2000, Windows 2003, Vista, or Windows 2008. 

1 On the Server, start Windows Explorer, navigate to and right-click the c:\Datacap folder 
and select Properties.  The Datacap Properties dialog opens with the General tab 
displayed. 

2 Click the Security tab to display it. 

3 Add/ensure Domain/Windows User ID for Taskmaster Client Service is set to allow 
Read & Execute. 

4 Click Apply, then OK to save your changes and close the Datacap Properties dialog. 

Set Up Security on RRS\Libs\Application Folder for Taskmaster Client Service (All OS) 
This procedure provides instructions on how to set up the appropriate Taskmaster Client 
Service security permissions at the application level on the Server when the Server's operating 
system is Windows 2000, Windows 2003, Vista, or Windows 2008. 

Repeat these instructions for each c:\Datacap\RRS\Libs\Application folder on the Server - 
setting up these security permissions at this level allows you to grant Taskmaster Client 
Service access to specific applications. 

1 On the Server, start Windows Explorer, navigate to and right-click the 
c:\Datacap\RRS\Libs\Application folder and select Properties.  The application's 
Properties dialog opens with the General tab displayed. 

2 Click the Security tab to display it. 

3 Add/ensure Domain/Windows User ID for Taskmaster Client Service is set to allow 
Full Control. 

4 Click Apply, then OK to save your changes and close the Properties dialog. 

Set Up Security on Datacap\Application Folder for Taskmaster Client Service (All OS) 
This procedure provides instructions on how to set up the appropriate Taskmaster Client 
Service security permissions at the application level on the Server when the Server's operating 
system is Windows 2000, Windows 2003, Vista, or Windows 2008. 

Repeat these instructions for each c:\Datacap\Application folder on the Server - setting up 
these security permissions at this level allows you to grant Taskmaster Client Service access to 
specific applications. 
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1 On the Server, start Windows Explorer, navigate to and right-click the 
c:\Datacap\Application folder and select Properties.  The application's Properties dialog 
opens with the General tab displayed. 

2 Click the Security tab to display it. 

3 Add/ensure Domain/Windows User ID for Taskmaster Client Service is set to allow 
Full Control. 

4 Click Apply, then OK to save your changes and close the Properties dialog. 

Configure Taskmaster Client Service 
This procedure provides instructions on how to configure the Taskmaster Client Service on the 
TCSServer so it processes background tasks for an application automatically.   

1 From the TCSServer's Windows Start menu, select All Programs, select Datacap, select 
Taskmaster Client and click Taskmaster Client Service.  The Taskmaster Client Service 
Settings window opens with the TM Sub tab displayed on top. 

2 Confirm that the Taskmaster Client Service is Stopped. 

3 Click the Taskmaster Server tab to display it and select the Explanations option at the 
bottom left to display more information. 

4 Enter the Server name (without initial backslashes) or IP address of the Server hosting 
the application and click Connect.  The button label changes to Disconnect, and the 
Server name or IP address field is protected. 

5 Click the Admin/Engine tab.  The Admin database tab is displayed on top. 

6 Select the appropriate Database type and click the Browse button to navigate to and 
select the application's Admin database on the Server hosting the application.  

7 Click the Engine database tab.   

8 Select the appropriate Database type and click the Browse button to navigate to and 
select the application's Eng database on the Server hosting the application. 

9 Click Connect.  The button label changes to Disconnect, and the information on both 
tabs is protected. 

10 Click the Login tab to display it. 

11 If you are using: 

 Taskmaster authentication, select the Taskmaster Standard authentication option, 
enter the Taskmaster Client Service’s domain User ID, password and Station ID, 
then click Login.   

 Windows Authentication, select the Windows authentication option, enter the 
Taskmaster Client Service’s Station ID, and then click Login. 

 The button label changes to Log off and the Login information is protected. 

12 Click the Workflow:Job:Task tab to display it. 

13 Expand the application's workflow, expand each of the Jobs within the workflow, then 
select or ensure the tasks in each job that this Taskmaster Client Service is responsible 
for running are selected.  Choose only those tasks that do not require human 
intervention. 
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14 Clear Stop on Abort, select Mixed queuing, clear Write to Debug, change the Sleep and 
Task Instances settings if appropriate, then click Save. 

15 Click the Logging tab to display the System event log and Datacap log tabs. 

16 If appropriate, change the logging settings on either or both tabs, and click Save. 

17 Click the Taskmaster Server tab to display it, and click Disconnect.  The button label 
changes to Connect. 

18 Click the TM Sub tab to display it, and click Start.  The Status changes to Running. 

19 Click Close to close the Taskmaster Client Service Settings window.  

20 From the Windows Start menu, select Settings, select Control Panel, select 
Administrative Tools, and double-click Services to open the Services window. 

21 Scroll down to the Datacap Taskmaster Client Service entry, select it, right-click, and 
select Properties from the shortcut menu.  The Datacap Taskmaster Client Service 
Properties dialog is displayed with the General tab displayed on top. 

22 Change the Startup Type to Automatic, click Apply to save your changes, then click OK 
to close the Datacap Taskmaster Client Service Properties dialog.  

23 Close the Services window. 

Test Taskmaster Client Service by Running Application 
The way to test whether you have set up the Taskmaster Client Service correctly for your 
application is to start up your  Taskmaster Client application and run the application's tasks 
that should trigger the Taskmaster Client Service.   

For example, if you have an application with Scan, PageID and Recognition tasks, and you 
have set up the Taskmaster Client Service to automatically run the PageID and Recognition 
tasks, running a scan job should automatically trigger the Page ID and Recognition tasks.  If 
results from these jobs show up in the application's Batches folder, you know you have set up 
the Taskmaster Client Service correctly.  

Test Taskmaster Client Service and View Processing 
Another method for testing your set up of the Taskmaster Client Service allows you to start 
and run the Taskmaster Client Service so that it displays processing dialogs as it processes 
batches.  Since only one instance of the Taskmaster Client Service can run on a machine at a 
time, these instructions include stopping the service before starting it in display mode.  

Stop or Ensure the Taskmaster Client Service is Stopped 
This procedure provides instructions on how to stop or ensure the Datacap Taskmaster Client 
Service is stopped on the TCSServer. 

1 From the TCSServer's Windows Start menu, select Settings, select Control Panel, select 
Administrative Tools, double-click Services, and scroll down to the Datacap 
Taskmaster Client Service entry.   

2 When the Status: 

 Is blank, the service is stopped.  Continue with the next step. 
 Shows as Started, click Stop the Service.  A Stopping Service message is  

displayed.  The Status changes to a blank when the service is stopped.  
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3 Close the Services window. 

View Taskmaster Client Service Processing 
This procedure provides instructions on how to start and run the Taskmaster Client Service so 
that it displays processing dialogs as it processes batches. 

1 From the TCSServer's Windows Start menu, select Run.  The Run dialog opens. 

2 Enter the following command line:  

 c:\Datacap\tmclient\tmsub.exe 

 then click OK to start the Taskmaster Client Service.  After a brief delay, the 
Taskmaster Client Service icon appears in your system tray. 

3 When you run the application's Scan task, processing dialogs appear briefly as each 
batch is processed. 

4 Check the Batches and Export folders for results. 

Stop Taskmaster Client Service when in Display Mode 
This procedure provides instructions on how to stop the Taskmaster Client Service when it is 
running in display mode.  

1 On the TCSServer, right-click the Taskmaster Client Service icon in the system tray, 
and from the shortcut menu, select Stop and Exit.  A message box prompts you to 
confirm that you want to stop the service. 

2 Click Yes.  The message box closes, the Taskmaster Client Service stops after it has 
finished any current processing, and the icon is removed from your system tray. 

Configure Windows Authentication for Taskmaster 

This section provides the information you need to configure Taskmaster 7.5 or later to use 
either Windows Active Directory (AD) or any Lightweight Directory Access Protocol (LDAP) 
provider rather than maintaining individual users in Taskmaster itself and using Taskmaster 
authentication.   

This section includes information related to your domain, Taskmaster-specific AD/LDAP 
security groups, domain/Windows accounts for Taskmaster users, as well as configuring 
Taskmaster Server Service to use Windows Authentication, adding a Taskmaster group to the 
application that has the exact same name as the AD/LDAP security group and domain, and 
updating all Taskmaster Client icons to use Windows Authentication.   

No changes are required to your Taskmaster Web Client as it always attempts to use Windows 
Authentication first.  

To set up Taskmaster Client Service using Windows Authentication, follow the instructions in 
Configure Taskmaster Client Service. 

Overview of Taskmaster Windows Authentication Processing 
Taskmaster Client, Taskmaster Web Client, and Taskmaster Client Service support enterprise 
management of users in groups using either native Active Directory (AD) or any Lightweight 
Directory Access Protocol (LDAP) provider.  This feature replaces the “NT Authentication” 
method provided in earlier versions of Taskmaster. 
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Once the components of Taskmaster 7.5 or later have been configured to use Windows 
Authentication and a user logs onto Windows with a Windows ID that exists in  the AD/LDAP 
directory, when that same user logs onto Taskmaster, Taskmaster attempts to locate the user in 
the AD/LDAP directory. 

If Taskmaster locates the user in the AD/LDAP directory, it retrieves a list of all of the domain 
groups that this user belongs to, and attempts to find a Taskmaster Group that matches an 
AD/LDAP Group.   

If authentication fails, Taskmaster presents its standard login dialog and the user can log onto 
Taskmaster using Taskmaster authentication (which uses the user entries in the Taskmaster 
Administration database for authentication). 

If a match is found, the user is authenticated and granted the permissions and privileges 
defined for the matching Taskmaster Group – limited by the permissions and privileges of the 
Station in use.   

When the user belongs to other AD/LDAP Groups that also have corresponding Taskmaster 
groups, the user is granted the Taskmaster permissions and privileges of those groups as well. 

Overview of Windows Authentication Configuration Process 
The procedures in this section apply to Taskmaster 7.5 or later.  The configuration process 
includes the following steps: 

1 Create Domain, Security Groups, Domain Accounts 

2 Configure Taskmaster Server Service to use Windows Authentication 

3 Add Taskmaster Group to Application 

4 Update Authentication Parameter in Taskmaster Client Application Shortcut  

Create or Ensure Domain Exists 
Create or ensure a domain exists in which Taskmaster-specific Active Directory (AD) or 
Lightweight Directory Access Protocol (LDAP) security groups can be created. 

Ensure you know the exact spelling of the domain, as you will need it when you configure 
Taskmaster to use Windows Authentication. 

Create or Ensure AD/LDAP Security Group Exists 
Create or ensure at least one Taskmaster-specific AD/LDAP security group exists within the 
domain.   

Depending on your Datacap applications, you can create separate groups to limit what your 
Taskmaster users can do in Taskmaster.  

Create or Ensure Accounts Exist and are Part of Security Group 
Create or ensure a domain/Windows account exists for each Taskmaster Client user and, 
optionally, for the Taskmaster Client Service, and ensure each account has been added to the 
appropriate Taskmaster-specific AD/LDAP security group or groups. 

Stop or Ensure Taskmaster Server Service is Stopped 
This procedure provides instructions on how to stop or ensure the Datacap Taskmaster Server 
Service is stopped on the Server. 
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1 From the Server's Windows Start menu, select Programs, select Datacap, select 
Taskmaster Server, and click Taskmaster Server.  The TMS Configuration window 
opens. 

2 When the Status: 

 Shows as Stopped, continue with the next step. 
 Shows as Running, click Stop.  A Stopping Service message is displayed.  The 

Status changes to Stopped when the service is stopped.  
3 Close the TMS Configuration window. 

Configure Taskmaster Server Service to use Windows Authentication 
This procedure provides instructions on how to configure Taskmaster Server Service to use 
Windows Authentication. 

1 With the TMS Configuration window open, click the Taskmaster tab to display it. 

2 Click Show advanced to display Advanced Settings. 

3 Depending on the type of user lookup syntax your organization is using, enter one of the 
following strings in the LDAP template (requires restart) field.  For: 

 Native AD authentication, enter: 
WinNT://<%domain%>/<%user%>  

 Typical LDAP authentication, enter:  
LDAP://CN=<%user%>,CN=Users,DC=<%domain%>,dc=Com 

 then click Save.   

4 Click the Service tab to display it. 

5 Click Start to start Taskmaster Server Service.  A Starting Service message is displayed.  
The Status changes to Running when the service is started. 

6 Close the TMS Configuration window. 

Ensure Workstation's Registry Points to TMServer 
Edit or ensure that the Workstation's Windows registry RRS\locations\rrs key reflects the UNC 
name of the TMServer (rather than C:\) and the path to the \\Server\Datacap\RRS folder. 

Regedit:  HKEY_LOCAL_MACHINE > SOFTWARE > DATACAP > RRS> locations > rrs 
should reflect:  \\Server\Datacap\RRS\  

Start Taskmaster Client Application 
This procedure provides instructions on how to start the Taskmaster Client for a Datacap 
application.  If you have logged into the application's Taskmaster Client before, the 
information you entered previously is displayed. 

1 From the Workstation's Windows Start menu, select All Programs, select Datacap, 
select Applications, select the application you want to start, and click the application's 
Client icon.  The Select Taskmaster Server dialog opens  

2 Enter the Server name (without initial backslashes) or IP address of the Server hosting 
the application and click OK.  A Please login window opens. 

3 Enter your User ID, Password, and Station, then click OK. 
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4 The application's main window opens with the Operations pane displayed. 

Add Taskmaster Group to Application 
This procedure provides instructions on how to add a Taskmaster group to your Taskmaster 
application to support your Windows Authentication configuration. 

1 On the Workstation, with the application's main window open, on the Settings menu, 
select Groups.  The Taskmaster Administrator dialog opens with the Groups tab 
displayed on top and the existing Groups listed in the left pane. 

2 Click Add, and enter a Group ID that is a concatenation of: 
--Your Taskmaster-specific security group name 
--A dot 
--The domain to which your Taskmaster-specific security group belongs.  
For example, for a security group called TMUsers in the XYZ Company's domain, the 
Taskmaster Group ID would be: 
TMUsers.XYZ 

3 Click Apply.  A message box indicates the new settings will apply after currently signed 
on users log off and log back on again. 

4 Click OK to close the message box.  The Privileges, Permissions, and Users pane is 
enabled. 

5 Since you are using this group to grant specific privileges to a specific group of 
Taskmaster Client users for this application, expand the Privileges branch and select the 
appropriate privileges, then click Apply.  A message box indicates the new settings will 
apply after currently signed on users log off and log back on again. 

6 Click OK to close the message box. 

7 Since you are using this group to grant permissions to a specific group of Taskmaster 
Client users for this application, expand the Permissions branch and select the 
appropriate permissions, then click Apply.  A message box indicates the new settings 
will apply after currently signed on users log off and log back on again. 

8 Click OK to close the message box.  

9 Click Apply, and then Done.  The Taskmaster Administrator dialog closes. 

10 Close the Taskmaster Client window.  A message box prompts you to confirm you want 
to quit. 

11 Click Yes.  Taskmaster Client shuts down. 

Update Authentication Parameter in Taskmaster Client Application Shortcut 
In order to use Windows Authentication whenever a user starts the Taskmaster Client using an 
application shortcut, the shortcut's authentication parameter must be changed.  Taskmaster 
Client application shortcuts can be located on the desktop, in the Datacap folder of shortcuts 
installed on the desktop, and in the Workstation’s Windows Start menu.  When shortcuts are 
first installed, they may or may not contain an authentication parameter. 

This procedure provides instructions on how to change a Taskmaster Client shortcut so it 
contains the authentication parameter that indicates Windows Authentication should be used. 

1 Right-click the appropriate Taskmaster Client shortcut and select Properties.  The 
application’s Client properties dialog opens with the contents of the Target field 
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selected.  The Admin and Engine database connection strings are both enclosed in 
quotes, for example (line breaks added for readability): 

 C:\Datacap\tmclient\tmclient.exe 
 -ad"PROVIDER=MSACCESS;DSN=C:\Datacap\1040ez\process\1040adm.mdb;CATALOG=;DBNTA=;" 
 -ed"PROVIDER=MSACCESS;DSN=C:\Datacap\1040ez\process\1040eng.mdb;CATALOG=;DBNTA=;"  

2 Press <End> to move the cursor to the end of the Target field.  There may or may not be 
an authentication parameter (either -tma or -nta). 

 a) If an authentication parameter appears, change it to or ensure it is -nta 

 b) If no authentication parameter appears, after the last closing quote, add a space, then 
   -nta 
The Target field should look like this (line breaks added for readability): 

 C:\Datacap\tmclient\tmclient.exe 
 -ad"PROVIDER=MSACCESS;DSN=C:\Datacap\1040ez\process\1040adm.mdb;CATALOG=;DBNTA=;" 
 -ed"PROVIDER=MSACCESS;DSN=C:\Datacap\1040ez\process\1040eng.mdb;CATALOG=;DBNTA=;"  
 -nta 

3 Click Apply, then OK to close the Client properties dialog.  

Configure Rulerunner as a Web Service 

In addition to Taskmaster Rulerunner running locally, it can also be configured to run as a web 
service on a completely separate server (referred to as “RRServer”).  Depending on what you 
want to accomplish and the configuration of your current Taskmaster client/server 
environment, running Rulerunner as a web service may or may not be advantageous.  Be sure 
to contact your Datacap Implementation Specialist or Support before implementing Rulerunner 
running as a web service. 

This section provides the information you need to install and configure Rulerunner as a web 
service on a Windows 2003 (IIS 6) Server in an existing, working Taskmaster 7.5 SP1 or later 
environment.  This section assumes you are installing Rulerunner as a web service on a 
separate Server; that is, the Server is not running other Taskmaster components.  

The Windows 2003 RRServer that hosts Rulerunner requires components that are installed 
when Taskmaster Client and Taskmaster Web or later components are installed (but not 
configured). 

Overview of Rulerunner as a Web Service Installation 
The installation and configuration process is made up of the following steps: 

1 Ensure you have a working Taskmaster 7.5 SP1 or later environment where you have 
successfully processed batches through export and that your application works with 
Rulerunner running locally. 

2 Use your Taskmaster installation media to install (but not configure) the Taskmaster 
Web and Taskmaster Client components on Windows 2003 RRServer  

3 Configure Rulerunner as a web service on Windows 2003, RRServer 

4 Configure the Taskmaster application to use Rulerunner as a web service 

5 Test the application using Rulerunner running as a web service 

While the installation package (Setup.exe) can be located anywhere (for example, on the 
RRServer's CD/DVD drive, on an accessible network drive), when run, the destination will be 
the physical hard drive of the machine from which you run the Setup.exe. 
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Ensure Domain Account Exists for Rulerunner 
Set up a specific domain account for Rulerunner running as a web service and give it the Log 
on as a service right. 

Share Datacap Folder Set Sharing Permissions for Rulerunner 
Depending on the operating system of the Server that is hosting the Datacap folder, follow the 
appropriate set of instructions in Configure Taskmaster on Server to set up the appropriate 
sharing permissions for the c:\Datacap folder.  Note that other accounts have already been 
granted sharing permissions during the installation and configuration of Taskmaster. 

Add/ensure Domain/Windows User ID of Rulerunner is set to allow Full Control. 

Set Up Security on Shared Datacap Folder for Rulerunner 
Depending on the operating system of the Server that is hosting the Datacap folder, follow the 
appropriate set of instructions in Configure Taskmaster on Server to set up the appropriate 
security for the c:\Datacap folder. 

Add/ensure Domain/Windows User ID of Rulerunner is set to allow Read & Execute. 

Set Up RRS Folder Account Permissions (Windows 2000, Windows 2003) 
This procedure provides instructions on how to set up the appropriate security permissions for 
the c:\Datacap\RRS folder on the Server that is hosting the Datacap folder when the Server’s 
operating system is Windows 2000 or Windows 2003.  Note that accounts were granted 
security permissions during the installation and configuration of Taskmaster, and one or more 
may already be set up properly.  

1 On the Server, start Windows Explorer, navigate to, right-click the c:\Datacap\RRS 
folder, and select Sharing and Security.  The Sharing tab is displayed. 

2 Click the Security tab to display it. 

3 Add/ensure ASP.NET Machine Account (Server\ASPNET) and Internet Guest Account 
(Server\IUSR_SERVER) are set to allow Full Control; add/ensure Domain/Windows 
User ID of Rulerunner is set to allow Full Control. 

4 Click Apply and then OK to save your changes and close the dialog. 

Set Up RRS Folder Account Permissions (Vista, Windows 2008) 
This procedure provides instructions on how to set up the appropriate security permissions for 
the c:\Datacap\RRS folder on the Server that is hosting the Datacap folder when the Server’s 
operating system is Vista or Windows 2008.  Note that accounts were granted security 
permissions during the installation and configuration of Taskmaster, and one or more may 
already be set up properly.  

1 On the Server, start Windows Explorer, navigate to and right-click the c:\Datacap\RRS 
folder and select Properties.  The Properties dialog opens with the General tab 
displayed. 

2 Click the Security tab to display it, then click Edit. 
When UAC is on, the User Account Control window is displayed.  Click Continue. 
The Permissions dialog opens. 

3 Add/ensure NETWORK SERVICE and local IUSR are set to allow Full Control, 
add/ensure Domain/Windows User ID of Rulerunner is set to allow Full Control. 
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4 Click Apply and then OK to save your changes and close the dialog. 

Set Up Security on Batches Folder for Rulerunner (All OS) 
This procedure provides instructions on how to set up the appropriate security for the 
c:\Datacap\Application\Batches folder on the Server that is hosting the Datacap folder when 
the Server’s operating system is Windows 2000, Windows 2003, Vista, or Windows 2008.  
Note that accounts were granted security permissions during the installation and configuration 
of Taskmaster 7.6, and one or more may already be set up properly. 

1 On the Server, start Windows Explorer, navigate to, right-click the 
c:\Datacap\Application\Batches folder (for example c:\Datacap\APT\Batches), and 
select Properties.  The Properties dialog opens with the General tab displayed. 

2 Click the Security tab to display it. 

3 Add/ensure Domain/Windows User ID of Rulerunner is set to allow Full Control. 

4 Click Apply and then OK to save your changes and close the dialog. 

Set Up WRRS Folder Account Permissions for Rulerunner (Windows 2000, Windows 
2003) 
This procedure provides instructions on how to set up the appropriate security for the 
c:\Datacap\WRRS folder on the Server that is hosting the Datacap folder when the Server’s 
operating system is Windows 2000, or Windows 2003.  Note that accounts were granted 
security permissions during the installation and configuration of Taskmaster 7.6, and one or 
more may already be set up properly. 

1 On the Server, start Windows Explorer, navigate to, right-click the c:\Datacap\WRRS 
folder, and select Sharing and Security .  The Sharing tab is displayed. 

2 Click the Security tab to display it. 

3 Add/ensure ASP.NET Machine Account (Server\ASPNET) and add/ensure Internet 
Guest Account (Server\IUSR_SERVER) are set to allow Read & Execute; add/ensure 
Domain/Windows User ID of Rulerunner is set to allow Full Control. 

4 Click Apply and then OK to save your changes and close the dialog. 

Set Up WRRS Folder Account Permissions for Rulerunner (Vista and Windows 2008) 
This procedure provides instructions on how to set up the appropriate security for the 
c:\Datacap\WRRS folder on the Server that is hosting the Datacap folder when the Server’s 
operating system is Vista or Windows 2008.  Note that accounts were granted security 
permissions during the installation and configuration of Taskmaster 7.6, and one or more may 
already be set up properly. 

1 On the Server, start Windows Explorer, navigate to, right-click the c:\Datacap\WRRS 
folder, and select Properties .  The Properties dialog opens with the General tab 
displayed. 

2 Click the Security tab to display it, then click Edit. 
When UAC is on, the User Account Control window is displayed.  Click Continue. 
The Permissions dialog opens. 

3 Add/ensure NETWORK SERVICE and IUSR are set to allow Read & Execute, 
add/ensure Domain/Windows User ID of Rulerunner is set to allow Full Control. 

4 Click Apply and then OK to save your changes and close the dialog. 
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Update ASP.NET Process Identity in Machine.Config File (Windows 2003) 
On the Windows 2003 RRServer that will host Rulerunner as a web service, update the 
machine.config file with Rulerunner's domain account information. 

1 On the RRServer, use Windows Explorer to navigate to and use a text editor such as 
Notepad to open 
C:\WINDOWS\Microsoft.NET\Framework\v2.0.50727\CONFIG\machine.config  

2 Locate the line <system.web> and the next line starting with <processModel … 

3 Add the following information to the <processModel line so that it reflects information 
for the Rulerunner domain account that you want to use:  

 <processModel autoConfig="true" enable="true" userName="MYDOMAINRulerunner 
AccountName" password="RulerunnerAccountPassword"/>  

4 Save the changes to machine.config and close the file. 

Grant Rulerunner Access to IIS Metabase (Windows 2003) 
On the Windows 2003 RRServer that will host Rulerunner running as a web service, grant 
Rulerunner's domain account access to the IIS metabase and other directories used by 
ASP.NET.   

This procedure provides instructions on how to run Microsoft's ASP.NET IIS Registration 
Tool (version 2 of .NET Framework) with the grant access parameter (-ga) to grant the 
Rulerunner account access to the IIS metabase.  For more information about the tool, search 
for "aspnet_regiis.exe" on the Microsoft website. 

1 On the RRServer, from the Windows Start menu, select Run.  The Run dialog opens. 

2 In the Open field, type cmd, and click OK.  A DOS command prompt window opens. 

3 Locate the aspnet_regiis.exe (for example, from your C:\> prompt, type: dir 
aspnet_regiis.exe /s). 

4 Run the aspnet_regiis.exe with the -ga parameter followed by the domain name, a 
backslash, then the Rulerunner account name;  
for example (no line breaks): 
C:\>C:\WINDOWS\Microsoft.NET\Framework\v2.0.50727\aspnet_regiis.exe -ga 
DOMAIN\RulerunnerAccountName  
then press <ENTER>. 
A "Start granting… access" message is displayed, followed by a "Finished granting… 
access" message. 

5 Close the DOS command prompt window. 

Grant DCOProcessor Permissions to Rulerunner in DCOM Config (Windows 2003) 
On the Windows 2003 RRServer that will host Rulerunner running as a web service, in 
Administrative Tools > Component Services > DCOM Config > DCOProcessor, add and grant 
Local Launch and Local Activation permissions to the Rulerunner account.  

Ensure RRServer's Registry Points to TMServer 
Edit or ensure that the RRServer's Windows registry RRS\locations\rrs key reflects the UNC 
name of the TMServer hosting the Datacap folder and the path to the \\Server\Datacap\RRS 
folder. 



Taskmaster 7.6 

Confidential and Proprietary Information of Datacap Inc. Page 135 
Copyright © 2010 Datacap Inc. 

Regedit:  HKEY_LOCAL_MACHINE > SOFTWARE > DATACAP > RRS> locations > rrs 
should reflect:  \\Server\Datacap\RRS\ 

Create and Share Virtual Directory for Rulerunner Running as Web Service (Windows 
2003) 
These instructions assume you will create a virtual directory for Rulerunner running as a web 
service nested within the RRServer’s Default Web Site.  

This procedure provides instructions on how to create a virtual directory for Rulerunner 
running as a web service.  

1 On the RRServer's Windows Start menu, select Settings, select Control Panel, select 
Administrative Tools, and double-click Internet Information Services to open the 
Internet Information Services window. 

2 Expand the computer on which you want to create the virtual directory, expand its Web 
Sites folder, right-click the Default Web Site, and on the shortcut menu, select New, 
then select Virtual Directory.  The Welcome page of the Virtual Directory Creation 
Wizard opens. 

3 Click Next. The Virtual Directory Alias page is displayed. 

4 Enter RRS as the alias, then click Next.  The Web Site Content Directory page is 
displayed. 

5 Enter the full path of or use the Browse button to navigate to and select the 
c:\Datacap\WRRS folder, then click OK.  The Web Site Content Directory page 
reappears with the full path to the WRRS folder displayed. 

6 Click Next. The Access Permissions page is displayed. 

7 Select the Read, Run scripts, and Execute options, then click Next.  The completion 
page of the Virtual Directory Creation Wizard is displayed. 

8 Click Finish.  The Wizard closes and the new RRS virtual directory is displayed in the 
Internet Information Services window. 

9 Right-click RRS, select Properties from the shortcut menu. The RRS Properties window 
is displayed with the Virtual Directory tab on top. 

10 Click the ASP.NET tab to display it and confirm the ASP.NET version is 2.0.nnnnn.  If 
it is not, you cannot continue with this procedure.  To recover, ensure that you installed 
Datacap Taskmaster:  

• If you did not, begin this entire process over again with the correct version of the 
Taskmaster software. 

• If you did, follow the instructions to Run aspnet_regiis.exe to update the ASP.NET 
application script maps. 

11 Click OK to save the settings and close the RRS Properties window. 

Set or Confirm Timeout Parameters for Rulerunner Running as Web Service (Windows 
2003) 
This procedure provides instructions on how to set or confirm the timeout parameters affecting 
Rulerunner running as a web service. 
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1 From the RRServer’s Windows Start menu, select Settings, select Control Panel, select 
Administrative Tools, and double-click Internet Information Services to open the 
Internet Information Services window. 

2 Expand the computer, expand its Web Sites folder, expand its Default Web Site,  right-
click the RRS virtual directory, and select Properties from the shortcut menu.  The RRS 
Properties dialog opens with the Virtual Directory tab displayed on top. 

3 Click the Configuration button.  The Application Configuration window opens. 

4 Click the Options tab to display it. 

5 Select or ensure the Enable session state option is selected and the Session timeout field 
is set to 20 minutes. 

6 Select or ensure the Enable parent paths option is selected and the ASP Script timeout 
field is set to 1200 seconds. 

7 Click Apply if you have made any changes 

8 Click OK to close the Application Configuration window. 

9 Click the ASP.NET tab to display it. 

10 Click the Edit Configuration button. The ASP.NET Configuration Settings window 
opens with the General tab displayed on top. 

11 Click the Application tab to display it. 

12 Select or ensure the Request execution timeout field is set to 1200 seconds, then click 
Apply if you have made any changes. 

13 Click State Management tab to display it. 

14 Select or ensure the Session timeout field is set to 20 minutes, then click Apply if you 
have made any changes. 

15 OK to save and close the RRS Properties dialog. 

16 Close the Internet Information Services window. 

Set Web Site Isolation Mode for Rulerunner (Windows 2003) 
This procedure provides instructions on how to set the service to run in IIS 5.0 Isolation Mode 
on a Windows 2003IIS 6 Server. 

1 On the RRServer, with the Internet Information Services window open, expand the 
computer on which you created the virtual directory, right-click Web Sites, and on the 
shortcut menu, select Properties.  The Web Site Properties dialog opens. 

2 Click the Service tab to display it. 

3 Select Isolation Mode:  Run WWW Service in IIS 5.0 Isolation Mode, and click OK.  A 
message box related to restarting IIS is displayed. 

4 Click Yes.  The message box and Web Site Properties dialog close, and IIS is restarted. 

Select Web Service Extensions for Rulerunner (Windows 2003) 
This procedure provides instructions on how to allow the Active Server Page extensions on a 
Windows 2003 IIS 6 Server. 
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1 On the RRServer, with the Internet Information Services window open, expand the 
computer on which you created the virtual directory, and select Web Service 
Extensions.  The Web Service Extension options are displayed in the right pane. 

2 Select/ensure Active Server Pages, ASP.NET v2.0.50727, and Server Side includes are 
Allowed. 

Test Rulerunner Access to Virtual Directory 
This procedure provides instructions on how to test that you have correctly configured 
Rulerunner running as a web service. 

1 Open Internet Explorer, and enter the following: http://RRServerName/rrs/session.asmx 

 where: 

• ServerName is either the default IP address or URL of the RRServer  

• rrs is the alias you assigned to the WRRS folder 

   After a pause, a Session Web Service window is displayed. 

2 Close the window.  

Start or Ensure Taskmaster Server Service is Started 
All configurations of Taskmaster (all components installed on a single Workstation or separate 
components installed on different machines) require that the Taskmaster Server Service be 
running before you can successfully start the application. 

This procedure provides instructions on how to start or ensure the Datacap Taskmaster Server 
Service is started on the Server. 

1 From the Server's Windows Start menu, select All Programs, select Datacap, select 
Taskmaster Server, and click Taskmaster Server.  The TMS Configuration window 
opens. 

2 When the Status: 

 Shows as Running, continue with the next step. 
 Shows as Stopped, click Start.  A Starting Service message is displayed.  The Status 

changes to Running when the service is started.  
If a Taskmaster Server Service error is displayed 
See the instructions in Configure Taskmaster on Server to re-grant Taskmaster Server 
Service Log On as a Service Right. 

3 Close the TMS Configuration window. 

Start APT Taskmaster Client 
This procedure provides instructions on how to start the APT Taskmaster Client application.  If 
you have logged into the Taskmaster Client before, the information you entered previously is 
displayed. 

1 From the Workstation's Windows Start menu, select All Programs, select Datacap, 
select Applications, select APT, and click the APT Client icon (the target of this icon 
should be pointing to the local TMClient.exe with parameters pointing to the 
APTAdm.mdb and APTEng.mdb in the application's process folder on the \\Server).  
The Select Taskmaster Server dialog opens. 



Installation & Configuration Guide 

Page 138 Confidential and Proprietary Information of Datacap Inc. 

 Copyright © 2010 Datacap Inc. 

2 Enter the Server name (without initial backslashes) or IP address of the Server hosting 
the application and click OK.  A Please login window opens. 

3 Ensure the User ID is admin, enter the password provided by Datacap, and ensure the 
Station is set to 1, then click OK. 

4 The APT main window opens with the Operations pane displayed. 

Configure Taskmaster Application to Use Rulerunner as a Web Service 
This procedure provides instructions on how to configure a Windows-based Taskmaster Client 
application to use Rulerunner running as a web service rather than the local Rulerunner.  This 
procedure uses the Taskmaster 1040EZ application as an example. 

1 With the application’s main window open, on the Settings menu, select Workflow.  The 
Taskmaster Administrator dialog opens with the Workflow tab displayed on top. 

2 Select the Main Job to expand it. 

3 Select the Recognize task, then click Setup.  The Recognize Setup - Batch Pilot window 
opens.  

4 Select the Rulerunner Web Service option, then click Done.  The Recognize Setup - 
Batch Pilot window closes and the Taskmaster Administrator dialog reappears. 

5 Click Apply. 

Test Taskmaster Application Using Rulerunner as a Web Service 
Once you have set up at least one task in the Taskmaster Client application to use Rulerunner 
running as a web service, create a batch and process it through that task.  If the task completes 
successfully, open the application’s batches folder, and open the log file associated with that 
task.  The log file should contain a “RRS is REMOTE” entry that confirms the task used 
Rulerunner running as a web service. 
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Chapter 5 
Uninstall Taskmaster 7.6 

This chapter provides the information you need to uninstall Taskmaster 7.6 software 
components. 

Overview of Taskmaster 7.6 Uninstall Process 
The procedures in this section apply only to uninstalling Taskmaster 7.6. 

After you have stopped all of the Datacap Taskmaster 7.6 components that are running on the 
Workstations and Servers (for example Taskmaster Client, Taskmaster Client Service, 
Taskmaster Server Service), there are two ways you can uninstall Taskmaster components: 

• Re-run Taskmaster 7.6 Setup.exe - You will be given the choice to Repair, Modify, or 
Remove  

• Select Datacap Taskmaster 7.6 from Windows Control Panel > Administrative Tools > 
Add/Remove Programs - You will be prompted to Remove 

The Taskmaster 7.6 uninstall process removes only those files that the previous Taskmaster 7.6 
installation process created.  This means that all files and settings that you created in 
Taskmaster 7.6 or that were changed by Taskmaster 7.6 processing are not removed 
automatically by the uninstall process, and, depending on whether the application is a sample 
application such as Survey or a customized application, you have the option of backing up, 
moving, or deleting what remains after the uninstall.  

If you will be installing a newer version of Taskmaster 7.6 on the same machine in the same 
location, customized applications that were untouched by the uninstall process will not be 
changed by the later installation, but you must follow all applicable upgrade instructions (if 
any) provided with the newer version of Taskmaster for your custom application. 

If you have created a new (custom) Taskmaster 7.6 application or customized a foundation 
application, and want to keep it, follow the instructions provided in these procedures: 

• Ensure All Taskmaster Clients are Shut Down (Taskmaster Client and Taskmaster Web 
Client) 

• Stop Taskmaster Server Service 

• Stop Taskmaster Client Service 

• Uninstall Taskmaster Components using Add or Remove Programs 

• Create Backup Folder 

• Backup Application 

• Backup Application Shortcuts 

• Backup System DSNs 
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• Reboot after Uninstall 

If you have run any Taskmaster 7.6 sample or foundation applications, and do not want to keep 
any applications, batches, export files or exported images, follow the instructions provided in 
these procedures: 

• Ensure All Taskmaster Clients are Shut Down (Taskmaster Client and Taskmaster Web 
Client)  

• Stop Taskmaster Server Service 

• Stop Taskmaster Client Service 

• Uninstall Taskmaster Components using Add or Remove Programs 

• Delete Remaining Folders 

• Reboot after Uninstall 

If you have not run, altered, or created any Taskmaster 7.6 applications, follow the instructions 
provided in: 

• Stop Taskmaster Server Service 

• Stop Taskmaster Client Service 

• Uninstall Taskmaster Components using Add or Remove Programs 

• Reboot after Uninstall 

Uninstall Instructions 

Ensure All Taskmaster Clients are Shut Down 
Before you begin uninstalling, ensure that all Taskmaster Client and Taskmaster Web Client 
users on all workstations are logged off. 

Stop or Ensure Taskmaster Server Service is Stopped 
This procedure provides instructions on how to stop or ensure the Datacap Taskmaster Server 
Service is stopped on the Server. 

1 From the Server's Windows Start menu, select Programs, select Datacap, select 
Taskmaster Server, and click Taskmaster Server.  The TMS Configuration window 
opens. 

2 When the Status: 

 Shows as Stopped, continue with the next step. 
 Shows as Running, click Stop.  A Stopping Service message is displayed.  The 

Status changes to Stopped when the service is stopped.  
3 Close the TMS Configuration window. 

Stop or Ensure the Taskmaster Client Service is Stopped 
This procedure provides instructions on how to stop or ensure the Datacap Taskmaster Client 
Service is stopped on the TCSServer. 
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1 From the TCSServer's Windows Start menu, select Settings, select Control Panel, select 
Administrative Tools, double-click Services, and scroll down to the Datacap 
Taskmaster Client Service entry.   

2 When the Status: 

 Is blank, the service is stopped.  Continue with the next step. 
 Shows as Started, click Stop the Service.  A Stopping Service message is  

displayed.  The Status changes to a blank when the service is stopped.  
3 Close the Services window. 

Uninstall Datacap Taskmaster 7.6 using Add or Remove Programs 
This procedure provides instructions on how to uninstall Taskmaster using the Windows Add 
or Remove Programs tool. 

1 From the Windows Start menu, select Settings, select Control Panel, select 
Administrative Tools, and double-click Add or Remove Programs.  After a pause, the 
Add or Remove Programs window is displayed with a list of the software installed on 
the machine. 

2 Scroll down to Datacap Taskmaster 7.6 and click Remove.  A message box is displayed 
prompting you to confirm that you want to remove the software. 

3 Click Yes.  Windows displays a Preparing to Install... window followed by a Datacap 
Taskmaster 7.6 window and progress bar.  When the uninstall process is finished, a 
Datacap Taskmaster 7.6 message box is displayed prompting you to reboot your 
system.   

4 Depending on whether you want to backup your customized application or delete 
remaining files before you reboot your system, click either No or Yes.  The message 
box closes. 

Create Backup Folder 
In Windows Explorer, navigate to a network location of your choice and create a folder for 
storing the backup copy of your customized application folders, shortcuts, and information 
about your application DSNs.   

Backup Custom Application 
This procedure provides instructions on how to make backups of folders that contain 
customizations you want to keep.  Repeat these instructions to make copies of every 
customized application.  

1 Using Windows Explorer, navigate to c:\Datacap\<application name> folder. 

2 Delete the batches and export subfolders. 

3 Copy the <application name> folder (including its process folder) to your backup 
folder.  

4 Using Windows Explorer, navigate to c:\Datacap\RRS\Libs folder. 

5 Copy the RRS\LIBS\<application> folder to your backup folder.  

6 Delete the subfolders for applications you do not want to back up. 
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Backup Application Shortcuts 
This procedure provides instructions on how to make backup copies of Taskmaster shortcuts.  
Repeat these instructions to make copies of every shortcut  associated with each of your 
customized applications.   

For shortcuts located on the desktop: 

1 Display your desktop, right-click the shortcut, and select Copy from the shortcut menu.  

2 Using Windows Explorer, navigate to your backup folder and, if necessary, the 
appropriate subfolder. 

3 Right-click in the folder and select Paste Shortcut from the shortcut menu. 

For shortcuts located only on the Start menu: 

1 Using Windows Explorer, navigate to C:\Documents and Settings\All Users\Start 
Menu\Programs, right click the Datacap folder and select Copy from the shortcut menu. 

2 Using Windows Explorer, navigate to your backup folder and, if necessary, the 
appropriate subfolder. 

3 Right-click in the folder and select Paste Shortcut from the shortcut menu. 

Backup System DSNs 
This procedure provides instructions on how to locate and record your Taskmaster System 
DSN information.  

1 Open a new text file using a text editor such as Notepad. 

2 From the Windows Start menu, select Settings, select Control Panel, select 
Administrative Tools, and double-click Data Sources (ODBC).  The ODBC Data 
Source Administrator window opens with the User DSN tab displayed on top. 

3 Click the System DSN tab to display it.  

4 Select the DSN for the first Taskmaster database displayed, then click Configure.  The 
ODBC Setup window opens. 

5 Click Select to open the Select Database dialog and write down the type of Taskmaster 
database (Admin, Eng, etc.), the full path and file name of the database, then click 
Cancel.  The Select Database dialog closes. 

6 Click Cancel to close the ODBC Setup window. 

7 Repeat the previous two steps each of the Taskmaster databases displayed on the ODBC 
Data Source Administrator's System DSN tab. 

8 Click Cancel to close the ODBC Data Source Administrator window. 

9 Save the text file with an appropriate name to your backup folder and, if necessary, the 
appropriate subfolder. 

Delete Remaining Folders 
This procedure provides instructions on how to locate and delete folders that were not removed 
by the uninstall process. 

1 Using Windows Explorer, navigate to and delete the c:\Datacap folder.  If access is 
denied, delete individual subfolders before deleting the c:\Datacap folder. 
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2 If you processed batches using the Taskmaster Web Client, a Scan Into folder was used 
to temporarily hold images during scanning.  If this folder was outside c:\Datacap, 
navigate to and delete the folder.  

Reboot after Uninstall 
After completing the Taskmaster uninstall process, reboot your machine. 
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Appendix A 
Vista Machine Setup Checklist 

This Appendix provides a summary of the account and configuration settings that are required 
to run Datacap Taskmaster 7.6 server, web, and clients on a single Vista, IIS 7 machine with a 
single Domain/Windows user who has administrator rights on the machine.  

The sections are sequenced deliberately, as some items in later sections depend on steps from 
the previous sections having been completed successfully. 

Vista Machine Setup 

Single Vista, IIS 7 Machine Prerequisites 

On Do This 
Workstation Set Up Installer's User ID 

Add/ensure Domain/Windows User ID of developer is in 
Workstation's Administrator group to allow developer to run 
InstallShield on Workstation 

Control Panel > User Accounts > User Accounts > Manage User 
Accounts  

Workstation Install/Ensure IIS is Installed 

If necessary, install IIS 

Workstation Run Datacap InstallShield on Workstation 

Install all components 

Workstation Reboot 

 

Configure Taskmaster Server on Single Vista Machine 

On Do This 
Workstation Start Taskmaster Server Service 

Start > All Programs > Datacap > Taskmaster Server > Taskmaster 
Server > Start  

Or, to start the service automatically on boot  

Control Panel > System and Maintenance > Admin Tools > 
Services > right-click Datacap Taskmaster Server Service > 
Properties > General tab > Startup Type of Automatic 
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Run Taskmaster Client on Single Vista Machine 

On Do This 
Workstation Install and Test Scanner 

(Note:  A physical scanner is not required for running the Datacap 
sample applications, as those applications can use the prescanned 
images included during installation.) 

Install scanner, ensure scanner works outside of Taskmaster. 

Workstation Test Thick Client Sample Application 

Sign on as Taskmaster user "admin" 

Run/test thick client and confirm each job in the workflow is 
processing correctly 

Exit Taskmaster Client. 

Workstation Test Sample Application Report Viewer 

Run/test thick Report Viewer client and view reports on the jobs 
that were run. 

Exit Report Viewer. 

Workstation Review Default Installation (Users, Groups, Stations) 

 

Configure Taskmaster Web on Single Vista Workstation 

On Do This 
Workstation Stop Taskmaster Server Service 

Start > All Programs > Datacap > Taskmaster Server > Taskmaster 
Server > Stop 
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On Do This 
Workstation Increase MaxRequestLength 

Windows Explorer navigate to and open using a text editor 
c:\Datacap\tmweb.net\web.config  

In <system.web>, locate and increase the  
<httpRuntime maxRequestLength="52428" />  
element - parameter expressed in kb, then save 

Set IIS ASP Request Size Limit 

Control Panel > System and Maintenance > Admin Tools > IIS > 
select computer > in Home pane, scroll down to the IIS area and 
double-click ASP.  Behavior > Limits Properties > increase the 
Maximum Requesting Entity Body Limit 
(maxRequestEntityAllowed) - expressed in bytes, and apply 

Create and Share Nested Taskmaster Web Site 

Control Panel > System and Maintenance > Admin Tools > IIS  

In Connections pane, expand computer > expand Sites > right-click 
Default Web Site and select Add Application 

Alias: tmweb.net 
Application pool: Classic .NET AppPool 
Physical path:  c:\Datacap\tmweb.net 

Save changes 

In Connections pane, click Default Web Site, expand Manage Web 
Site, click Configure Limits link, in Edit Web Site Limits dialog, set 
Connection Timeout = 1200 and save 

In Connections pane, click the Default Web Site, in the middle 
Default Web Site Home pane, in the IIS section, double-click the 
HTTP Response Headers icon, in the far right pane, click the Set 
Common Headers links, select Expire Web content, select 
Immediately, click OK to save changes  

Workstation Create TaskRun Folder and Set Up Security 

Folder name is case-sensitive and must be named TaskRun; folder 
must be created at the same level as the tmweb.net folder. 

In Windows Explorer, navigate to c:\Datacap and create a TaskRun 
folder. 

Right-click c:\Datacap\TaskRun > Properties > click Security tab 

Add NETWORK SERVICE and local IUSR and set to allow 
Modify 
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On Do This 
Workstation Set Up TaskRun Virtual Folder 

Control Panel > System and Maintenance > Admin Tools > IIS 

In Connections pane, expand computer > expand Sites > right-click 
Default Web Site, select Add Virtual Directory 
Alias:  TaskRun 
Physical path:  c:\Datacap\TaskRun 

Save changes 

Workstation Install Crystal Reports Runtime 

Run Crystal Reports runtime Setup.exe 

c:\Datacap\Install\tmweb7cr\setup.exe 

Set virtual directory to tmweb.net 

Workstation Start Taskmaster Server Service 

Start > Programs > Datacap > Taskmaster Server > Taskmaster 
Server > Start  

 

 Configure IE 7 and Run Taskmaster Web Client on Single Vista Machine 

On Do This 
Workstation Confirm Scanner Available  

(Note:  A physical scanner is not required for running the Datacap 
sample applications, as those applications can use the prescanned 
images included during installation.) 

If scanner shows in Control Panel > Hardware and Sound > 
Scanners and Cameras, scanner is available to thin client. 
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On Do This 
Workstation Configure IE 7 

Start IE 7 

Tools > Internet Options > General tab >  
Security tab > Select Trusted sites > Click Sites button > Trusted 
sites dialog  

On Trusted sites dialog, clear Require server verification, and add 
the default IP address of the Taskmaster Server (http://127.0.0.1)  

Security tab > Click Custom level button > Security settings dialog 

  Enable: Download signed ActiveX controls 

  Enable: Download unsigned ActiveX controls 

  Enable: Initialize and script ActiveX controls not marked as safe 
for scripting 

  Enable: Include local directory path when uploading files to a 
server 

Click OK and save changes 

Workstation Test IE 7 

To test your setup, run IE, and use the default IP address of the 
Taskmaster Server with the tmweb.net virtual directory and the test 
page to run the test setup -  the URL will look like: 
http://127.0.0.1/tmweb.net/ietest.aspx 

Workstation Run Thin Client 

Start IE, and enter the URL (http://127.0.0.1/tmweb.net )  

Sign on as Taskmaster user "admin" 

Run/test thin client using the images found in the application's 
process folder, and confirm each job in the workflow is processing 
correctly (will have to switch back to thick client to run some jobs) 

Workstation Run Thin Client Reports 

Run/test thin client Report generation  

 

Start Datacap Studio on Vista Machine 

On Do This 
Workstation Start Datacap Studio 

Start > All Programs > Datacap > Datacap Studio> Datacap Studio 

Server address:  127.0.0.1 

Select Work Offline > Select APT > Login as admin. 
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Appendix B 
 Client/Server Setup Checklist 

This Appendix provides a summary of the account and configuration settings that are required 
to run Datacap Taskmaster 7.6 server, web, and clients in a client/server, Windows desktop 
and/or web-based environment for development, test, and production purposes. 

The server ("Server") hosts the Taskmaster Server, the applications, batch files, and databases. 
For the Server, these instructions cover Vista (which limit the number of users to five), as well 
as Windows 2000, Windows 2003, and Windows 2008.  

The workstation ("Workstation") hosts the thick clients (Taskmaster Client, Report Viewer, 
Datacap Studio, etc.) and the browser.  For the Workstation, these instructions cover Vista. 

An optional, separate server ("RRServer") hosts Rulerunner running as a web service.  For 
RRServer, these instructions cover Windows 2003. 

This Appendix also provides a summary of the account settings for five types of users:  
Developers with administrative rights on both Server and Workstation, the Taskmaster Server 
Service, Taskmaster Client Service, Rulerunner running as a web service, and end users.  

The sections are sequenced deliberately, as some items in later sections depend on steps from 
the previous sections having been completed successfully. 

Server Setup 

Server Setup Prerequisites 

On Do This 
Server Set Up Installer's User ID 

Add/ensure Domain/Windows User ID of developer is in Server's 
Administrator group to allow developer to run InstallShield on Server 

Server Install/Ensure IIS and .NET are Installed 

If necessary: 

1 Install IIS 

2 Depending on operating system and sequence in which IIS and 
.NET were installed, run aspnet_regiis.exe 
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 Install Taskmaster Server and Taskmaster Web on Server 

On Do This 
Server Run Datacap InstallShield 

Install only Taskmaster Server and Taskmaster Web components 

Server Win 2000 Server 

1 In Windows Explorer, navigate to the C:\Datacap\support\download 
directory, and open the readme.txt file. 

2 Follow the instructions in the readme.txt file to install the 
appropriate scripting program. 

Server Reboot 

 

 Configure Taskmaster Server on Server 

On Do This 
Server Ensure Domain/Windows Account Exists for Taskmaster Server 

Service 

Ensure Domain/Windows account exists for Taskmaster Server 
Service  

To start Taskmaster Server Service automatically on boot  

Control Panel > (System and Maintenance) > Admin Tools > Services 
> Right-click Datacap Taskmaster Server Service > Properties > 
General tab > select Startup Type of Automatic 

Grant Taskmaster Server Service Log On as a Service Right 

Control Panel > (System and Maintenance) > Admin Tools > Services 
> right-click Datacap Taskmaster Server Service > Properties > Log 
On tab 

Select This Account and enter domain name, user name and password 
of the Taskmaster Server Service User you just set up, click Apply, 
returns message that user granted Log On as a Service right  

Server Ensure Domain/Windows Accounts Exist for End Users 
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On Do This 
Server Vista, Windows 2008 

Share Datacap Folder and Set Up Sharing Permissions 

Right-click c:\Datacap folder and select Properties 

Click Sharing tab, click Advanced Sharing 

Click Share this Folder (as Datacap) 

Click Permissions button 

1 Add NETWORK SERVICE and local IUSR and allow Full Control 

2 Add/ensure Domain/Windows User IDs of developers are set to 
allow Full Control 

3 Add/ensure Domain/Windows User ID of Taskmaster Server 
Service is set to allow Full Control 

4 When Batches folders are staying on Server in 
c:\Datacap\Application path, add/ensure Domain/Windows User IDs 
of Taskmaster end users are set to allow Full Control 

Server Windows 2000, Windows 2003 

Share Datacap Folder and Set Up Sharing Permissions  

Right-click c:\Datacap folder and select Sharing and Security 

Click Sharing tab, click Share this Folder (as Datacap) 

Click Permissions button 

1 Add ASP.NET Machine Account (Server\ASPNET) and Internet 
Guest Account (Server\IUSR_SERVER) and set to allow Full 
Control 

2 Add/ensure Domain/Windows User IDs of developers are set to 
allow Full Control 

3 Add/ensure Domain/Windows User ID of Taskmaster Server 
Service is set to allow Full Control 

4 When Batches folders are staying on Server in 
c:\Datacap\Application path, add/ensure Domain/Windows User IDs 
of Taskmaster end users are set to allow Full Control 
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On Do This 
Server Vista, Windows 2008 

Share Datacap Folder and Set Up Sharing Permissions  

Right-click c:\Datacap folder and select Properties 

Click Sharing tab, click Advanced Sharing 

Click Share this Folder (as Datacap) 

Click Permissions button 

1 Add NETWORK SERVICE and local IUSR and set to allow Full 
Control 

2 Add/ensure Domain/Windows User IDs of developers are set to 
allow Full Control 

3 Add/ensure Domain/Windows User ID of Taskmaster Server 
Service is set to allow Full Control 

4 When Batches folders are staying on Server in 
c:\Datacap\Application path, add/ensure Domain/Windows User IDs 
of Taskmaster end users are set to allow Full Control 

Server Set Up Security on Shared Folder (Vista, Windows 2008) 

Right-click c:\Datacap folder and select Properties 

Click Security tab  

1 Add/ensure Domain/Windows User IDs of developers who can 
change existing Taskmaster applications are set to allow Read & 
Execute (this developer cannot create new applications) 

2 Add/ensure Domain/Windows User IDs of developers who can 
create new Taskmaster applications in the c:\Datacap folder are set 
to allow Full Control  

3 Add/ensure Domain/Windows User ID of Taskmaster Server 
Service is set to allow Read & Execute  

4 When Batches folders are staying on Server in 
c:\Datacap\Application path, add/ensure Domain/Windows User IDs 
of Taskmaster end users are set to allow Read & Execute  
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On Do This 
Server Set Up Security on Shared Folder (Windows 2000, Windows 

2003) 

Right-click c:\Datacap folder and select Sharing and Security 

Click Security tab  

1 Add/ensure Domain/Windows User IDs of developers who can 
change existing Taskmaster applications are set to allow Read & 
Execute (this developer cannot create new applications) 

2 Add/ensure Domain/Windows User IDs of developers who can 
create new Taskmaster applications in the c:\Datacap folder are set 
to allow Full Control  

3 Add/ensure Domain/Windows User ID of Taskmaster Server 
Service is set to allow Read & Execute  

4 When Batches folders are staying on Server in 
c:\Datacap\Application path, add/ensure Domain/Windows User IDs 
of Taskmaster end users are set to allow Read & Execute  

Server Edit Server's Registry  

Edit the Server's Windows registry so it reflects the UNC name of 
Server (rather than C:\) and path to the \\Server\Datacap\RRS folder 

Regedit:  HKEY_LOCAL_MACHINE > SOFTWARE > DATACAP 
> RRS> locations > rrs should reflect:  \\Server\Datacap\RRS\ 

Server Start Taskmaster Server Service 

Start > All Programs > Datacap > Taskmaster Server > Taskmaster 
Server > Start  

 

Workstation Setup 

Workstation Setup Prerequisites 

On Do This 
Workstation Set Up Installer's User ID 

Add/ensure Domain/Windows User ID of developer is in 
Workstation's Administrator group to allow developer to run 
InstallShield on Workstation (developer also has admin rights on 
Server) 

Workstation Set up Domain/Windows User Account for End Users 
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On Do This 
Workstation Install and Test Scanner 

(Note:  A physical scanner is not required for running the Datacap 
sample applications, as those applications can use the prescanned 
images included during installation.) 

Install scanner, ensure scanner works outside of Taskmaster. 

 

 Install Taskmaster Client on Workstation 

On Do This 
Workstation Run Datacap InstallShield 

Log into Windows as developer/administrator, and run InstallShield, 
install Taskmaster Client, Support, and Documentation 

Workstation Reboot 

 

Datacap Application Copy Wizard 

 Prepare to Copy Application to Server 
Skip these steps if you have not ever run the application. 

On Do This 
Server Start Taskmaster Server Service 

Start > All Programs > Datacap > Taskmaster Server > Taskmaster 
Server > Start 

Workstation Delete All Batches from Application on Workstation 

Start Taskmaster Client application that you are going to copy 

Use Job Monitor to delete all existing batches and data from the 
Engine database. 
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  Copy Application to Server 

On Do This 
Workstation Copy Sample Application to Server 

Log into Windows as developer/administrator, run DStudio, cancel 
without connecting to Server, use Copy Wizard to copy application 
from Workstation to Datacap shared folder on Server 
(\\Server\Datacap) using SAME APPLICATION NAME:   

Source RRS Application Library folder - Location on the Workstation 
of the source application’s  \RRS\Libs\AppName folder 
(c:\Datacap\RRS\Libs\APT) 

Libraries folder on target system - Location of the application’s  
\RRS\Libs folder on the Server (\\Server\Datacap\RRS\Libs) 

Root folder on target system - Location where the new application 
folder will be created on the Server (\\Server\Datacap) 

Taskmaster folder on target system - Location where the Taskmaster 
Client software is installed on the Workstations (c:\Datacap) 

TMWeb.Net Folder path - Location of the tmweb.net folder on the 
Server (\\Server\Datacap\tmweb.net) 

Click to open View Logs (found in \\Server\Datacap\APT) and search 
for errors and warnings that you need to fix 

Workstation Edit Workstation's Registry 

Edit the Workstation's Windows registry so it reflects UNC of Server 
and path to the \\Server\Datacap\RRS\ folder 

Regedit:  HKEY_LOCAL_MACHINE > SOFTWARE > DATACAP 
> RRS> locations > rrs should reflect: \\Server\Datacap\RRS\ 

 

 Complete Server Configuration 

Set Security Permissions 

On Do This 
Server Stop Taskmaster Server Service 

Start > All Programs > Datacap > Taskmaster Server > Taskmaster 
Server > Stop 

Server Vista, Windows 2008 

Set Up Security on RRS\Libs Folder 

Right-click c:\Datacap\RRS\Libs folder and select Properties 

Click Security tab 

Add NETWORK SERVICE and local IUSR and set to allow Read & 
Execute  
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On Do This 
Server Windows 2000, Windows 2003 

Set Up Security on RRS\Libs Folder 

Right-click c:\Datacap\RRS\Libs folder and select Sharing and 
Security 

On Security tab 

Add ASP.NET Machine Account (Server\ASPNET) and add Internet 
Guest Account (Server\IUSR_SERVER) and set to allow Read & 
Execute  

Server Set Up Security on RRS\Libs\Application Folder (All OS) 

Repeat these instructions for each Datacap RRS\Libs\Application 
folder - setting up these security permissions at this level allows you 
to grant access to different applications to specific developers and end 
users. 

Right-click c:\Datacap\RRS\Libs\Application folder and select 
Properties 

Click Security tab  

1 Add/ensure Domain/Windows User ID of developer is set to allow 
Full Control 

2 Add/ensure Domain/Windows User ID of Taskmaster Server 
Service is set to allow Full Control 

3 When Batches folders are staying on Server in 
c:\Datacap\Application  path, add/ensure Domain/Windows User 
IDs of Taskmaster end users are set to allow Full Control 

Server Vista, Windows 2008 

Set Up Security on Datacap\Application Folder  

Repeat these instructions for each c:\Datacap\Application folder - 
setting up these security permissions at this level allows you to grant 
access to different applications to specific developers and end users. 

Right-click c:\Datacap\Application folder and select Properties 

Click Security tab 

1 Add NETWORK SERVICE and local IUSR are set to allow Full 
Control 

2 Add/ensure Domain/Windows User ID of developer is set to allow 
Full Control 

3 Add/ensure Domain/Windows User ID of Taskmaster Server 
Service is set to allow Full Control 

4 When Batches folders are staying on Server in 
c:\Datacap\Application path, add/ensure Domain/Windows User IDs 
of Taskmaster end users are set to allow Full Control 
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On Do This 
Server Windows 2000, Windows 2003 

Set Up Security on Datacap\Application Folder 

Repeat these instructions for each Datacap Application folder - setting 
up these security permissions at this level allows you to grant access 
to different applications to specific developers and end users. 

Right-click c:\Datacap\Application folder and select Sharing and 
Security 

On Security tab 

1 Add ASP.NET Machine Account (Server\ASPNET) and Internet 
Guest Account (Server\IUSR_SERVER) and set to allow Full 
Control  

2 Add/ensure Domain/Windows User ID of developer is set to allow 
Full Control 

3 Add/ensure Domain/Windows User ID of Taskmaster Server 
Service is set to allow Full Control 

4 When Batches folders are staying on Server in 
c:\Datacap\Application path, add/ensure Domain/Windows User IDs 
of Taskmaster end users are set to allow Full Control 

Workstation Create System DSNs on Workstations when necessary 

 

Run Taskmaster Client on Workstation 

On Do This 
Server Start Taskmaster Server Service 

Start > All Programs > Datacap > Taskmaster Server > Taskmaster 
Server > Start 

Workstation Test Thick Client Application 

Log into Windows as end user  

Start the application by clicking the Taskmaster Client shortcut that 
points to the application files on the Server (shortcut on Start menu 
was updated, shortcut was created on desktop and on Server in new 
application's folder)  

Sign on as Taskmaster user "admin" 

Run/test thick client and confirm each job in the workflow is 
processing correctly 

Exit client 
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On Do This 
Workstation Test Sample Application Report Viewer 

Edit the Report Viewer shortcut on the Start menu so it points to the 
rptview.ini file, and application's Admin and Engine databases on 
Server 

Run/test thick Report Viewer client and view reports on jobs that were 
run 

Exit Report Viewer 

Workstation Optional:  Review Default Installation (Users, Groups, Stations) 

 

 

Configure Taskmaster Web on Windows 2000, IIS 5 Server 

On Do This 
Server Stop Taskmaster Server Service 

Start > All Programs > Datacap > Taskmaster Server > Taskmaster 
Server > Stop 

Server Add or Ensure Application Information in APPS.INI is Correct  

1 On the Server, in Windows Explorer, navigate to and open the 
application's process folder (you need the names of the databases).  

2 On the Server, in Windows Explorer, navigate to and open the 
c:\Datacap\tmweb.net\apps.ini file. 

3 To change information about an application that was copied to the 
Server, edit the application's section to reflect the correct 
Application name, Server name, Administration and Engine 
database names, paths to the databases (all found in the application's 
process folder). 

4 To add information about a newly-created application, copy the 
entire section for an existing application and paste it below the 
original section but above the last line: 

 ;;; End of Apps.ini entries - Do not remove this line.  

 Edit the copied section to reflect the new application's Application 
name, Server name, Administration and Engine database names, and 
the paths to the databases (all found in the copy's \process folder). 

5 Save and close the APPS.INI file 
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On Do This 
Server Add or Ensure Upload Limit Setting is Large Enough in 

web.config 

1 On the Server, in Windows Explorer, navigate to and open the 
C:\Datacap\tmweb.net folder, scroll down to the web.config file and 
open it in a text editor such as Notepad. 

2 Within the <system.web> element, locate or add the   
<httpRuntime maxRequestLength="52428" />  
element - this parameter is expressed in kilobytes. 

3 Depending on the usual size of the images that are being uploaded, 
you can increase the size, for example: 
<httpRuntime maxRequestLength="102400" /> 

4 When you have made changes, save and close the file. 

Server Create and Share (Nested) Virtual Directory for Taskmaster Web  

Admin Tools > IIS > expand computer > expand Web Sites folder > 
right-click Default Web Site and select New > Virtual Directory >  

Alias: tmweb.net 
Web Site Content directory: c:\Datacap\tmweb.net folder 
Access Permissions:  Read, Run scripts, Execute 

Server Create TaskRun Folder, Set Up Web Sharing and Security 
Settings 

Folder name is case-sensitive and must be named TaskRun; folder 
must be created at the same level as the tmweb.net folder. 

In Windows Explorer, navigate to c:\Datacap and create a TaskRun 
folder.  

Right-click c:\Datacap\TaskRun > Properties 

Web Sharing tab > Share this folder > TaskRun is alias > Application 
Permissions = None, and Access Permissions Write and Read, click 
Apply 

Security tab > Add ASP.NET Machine Account (Server\ASPNET) 
and set to allow Modify;  add Internet Guest Account 
(Server\IUSR_SERVER) and set to allow Modify  
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On Do This 
Server Set Up TaskRun Virtual Folder 

Admin Tools > IIS > expand computer, expand Web Sites, expand 
Default Web Site, right-click TaskRun folder > Properties 

Virtual Directory tab > click Remove button 

Documents tab > add/ensure default.aspx is displayed 

Directory Security tab > top Edit button > Authentication Methods > 
Select Anonymous access, clear Integrated Windows authentication, 
OK 

ASP.NET tab > confirm version 

HTTP Headers tab > Select Enable Content Expiration, select Expire 
Immediately, click Apply 

Server Install Crystal Reports Runtime 

Run Install Crystal Reports runtime: 

c:\Datacap\Install\tmweb7cr\setup.exe 

Set virtual directory to tmweb.net 

Server Confirm Server.INI File Points to TaskRun 

Using Notepad, open c:\Datacap\tmweb.net\server.ini and ensure 
TempFolder=/TaskRun/  

Server Change Secure Socket Layer Setting in Server.INI 

If using web site SSL, also do the following: 

Using Notepad, open c:\Datacatp\tmweb.net\server.ini and ensure  
UseSSL=1 

Server Start Taskmaster Server Service 

Start > All Programs > Datacap > Taskmaster Server > Taskmaster 
Server > Start  

Server Configure and Test IE 

See instructions below  

 

Configure Taskmaster Web on Windows 2003, IIS 6 Server 

On Do This 
Server Stop Taskmaster Server Service 

Start > All Programs > Datacap > Taskmaster Server > Taskmaster 
Server > Stop 
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On Do This 
Server Add or Ensure Application Information in APPS.INI is Correct  

1 On the Server, in Windows Explorer, navigate to and open the 
application's process folder (you need the names of the databases).  

2 On the Server, in Windows Explorer, navigate to and open the 
c:\Datacap\tmweb.net\apps.ini file. 

3 To change information about an application that was copied to the 
Server, edit the application's section to reflect the correct 
Application name, Server name, Administration and Engine 
database names, paths to the databases (all found in the application's 
process folder). 

4 To add information about a newly-created application, copy the 
entire section for an existing application and paste it below the 
original section but above the last line: 

 ;;; End of Apps.ini entries - Do not remove this line.  

 Edit the copied section to reflect the new application's Application 
name, Server name, Administration and Engine database names, and 
the paths to the databases (all found in the copy's \process folder). 

5 Save and close the APPS.INI file 

Server Add or Ensure Upload Limit Setting is Large Enough in 
web.config 

1 On the Server, in Windows Explorer, navigate to and open the 
C:\Datacap\tmweb.net folder, scroll down to the web.config file and 
open it in a text editor such as Notepad. 

2 Within the <system.web> element, locate or add the   
<httpRuntime maxRequestLength="52428" />  
element - this parameter is expressed in kilobytes. 

3 Depending on the usual size of the images that are being uploaded, 
you can increase the size, for example: 
<httpRuntime maxRequestLength="102400" /> 

4 When you have made changes, save and close the file. 

Server Add or Ensure File Transfer Limit Setting is Large Enough 

1 Enable metabase edit-while-running. 

2 On the Server, in Windows Explorer, navigate to and open the 
\windows\system32\inetsvr folder, scroll down to the metabase.xml 
file and open it in a text editor such as Notepad. 

3 Locate and change the value for AspMaxRequestEntityAllowed= 
from 204800 to 10238976 (or larger) 

4 When you have made changes, save and close the file. 

5 Disable metabase edit-while-running. 
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On Do This 
Server Create and Share (Nested) Virtual Directory for Taskmaster Web  

Admin Tools > IIS > expand computer > expand Web Sites folder > 
right-click Default Web Site and select New > Virtual Directory >  

Alias: tmweb.net 
Web Site Content directory: c:\Datacap\tmweb.net folder 
Access Permissions:  Read, Run scripts, Execute 

Server Set Other Parameters for (Nested) Taskmaster Web Site 

Admin Tools > IIS > expand computer, expand Web Sites, expand 
Default Web Site, right-click tmweb.net web site > Properties 

Virtual Directory tab > click Configuration button > Application 
Configuration > Options tab > Select Enable session state, Timeout = 
20, select Enable parent paths, Default ASP Language = VBScript, 
ASP Script timeout = 1200 

Documents tab > add/ensure default.aspx is displayed 

ASP.NET tab > click Edit Global Configuration button > General tab 

Application tab > Request execution timeout > 1200 

State Management tab > Session timeout = 20 

ASP.NET tab > click Edit Configuration button > General tab 

Application tab > Request execution timeout > 1200 

State Management tab > Session timeout = 20 

Server Set Web Site Isolation Mode 

Admin Tools > IIS > expand computer > Right-click Web Sites >Web 
Site  Properties > Service tab, select WWW Isolation Mode: Run 
Service in IIS 5.0 Isolation Mode. 

Server Select Web Service Extensions 

Admin Tools > IIS > expand computer > click Web Service 
Extensions 

Select/ensure Active Server Pages, ASP.NET v2.0.50727, and Server 
Side Includes are Allowed. 
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On Do This 
Server Create TaskRun Folder, Set Up Web Sharing and Security 

Settings 

Folder name is case-sensitive and must be named TaskRun; folder 
must be created at the same level as the tmweb.net folder. 

In Windows Explorer, navigate to c:\Datacap and create a TaskRun 
folder. 

Right-click c:\Datacap\TaskRun > Properties 

Web Sharing tab > Share this folder > TaskRun is alias > Application 
Permissions = None, and Access Permissions Write and Read 

Security tab > Add ASP.NET Machine Account (Server\ASPNET) 
and set to allow Modify;  add Internet Guest Account 
(Server\IUSR_SERVER) and set to allow Modify 

Server Set Up TaskRun Virtual Folder 

Admin Tools > IIS > right-click TaskRun folder >Properties 

Virtual Directory tab > click Remove  

Documents tab > add/ensure default.aspx is displayed 

Directory Security tab > top Edit button > Authentication Methods > 
Select Anonymous access, clear Integrated Windows authentication, 
OK 

ASP.NET tab > confirm version 

HTTP Headers tab > Select Enable Content Expiration, select Expire 
Immediately, click Apply 

Server Install Crystal Reports Runtime 

Run Install Crystal Reports runtime: 

c:\Datacap\Install\tmweb7cr\setup.exe 

Set virtual directory to tmweb.net 

Server Confirm Server.INI File Points to TaskRun 

Using Notepad, open c:\Datacaptmweb.net\server.ini and ensure 
TempFolder=/TaskRun/  

Server Change Secure Socket Layer Setting in Server.INI 

If using web site SSL, also do the following: 

Using Notepad, open c:\Datacap\tmweb.net\server.ini and ensure  
UseSSL=1 

Server Start Taskmaster Server Service 

Start > All Programs > Datacap > Taskmaster Server > Taskmaster 
Server > Start  
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On Do This 
Server Configure and Test IE 

See instructions below  

 

Configure Taskmaster Web on Vista, Windows 2008 IIS 7 Server 

On Do This 
Server Stop Taskmaster Server Service 

Start > All Programs > Datacap > Taskmaster Server > Taskmaster 
Server > Stop 

Server Add or Ensure Application Information in APPS.INI is Correct  

1 On the Server, in Windows Explorer, navigate to and open the 
application's process folder (you need the names of the databases).  

2 On the Server, in Windows Explorer, navigate to and open the 
c:\Datacap\tmweb.net\apps.ini file. 

3 To change information about an application that was copied to the 
Server, edit the application's section to reflect the correct 
Application name, Server name, Administration and Engine 
database names, paths to the databases (all found in the application's 
process folder). 

4 To add information about a newly-created application, copy the 
entire section for an existing application and paste it below the 
original section but above the last line: 

 ;;; End of Apps.ini entries - Do not remove this line.  

 Edit the copied section to reflect the new application's Application 
name, Server name, Administration and Engine database names, and 
the paths to the databases (all found in the copy's \process folder). 

5 Save and close the APPS.INI file 

Server Add or Ensure Upload Limit Setting is Large Enough in 
web.config 

1 On the Server, in Windows Explorer, navigate to and open the 
C:\Datacap\tmweb.net folder, scroll down to the web.config file and 
open it in a text editor such as Notepad. 

2 Within the <system.web> element, locate or add the   
<httpRuntime maxRequestLength="52428" />  
element - this parameter is expressed in kilobytes. 

3 Depending on the usual size of the images that are being uploaded, 
you can increase the size, for example: 
<httpRuntime maxRequestLength="102400" /> 

4 When you have made changes, save and close the file. 
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On Do This 
Server Vista 

Ensure Required IIS Components are Installed  

Control Panel > double-click Programs and Features, and select Turn 
Windows features on or off  

Ensure/select Internet Information Services Settings: 

Under Internet Information Services > Web Management Tools > IIS 
6 Management Compatibility, ensure/select IIS Metabase and IIS 6 
configuration compatibility  

Under Internet Information Services > World Wide Web Services > 
Application Development Features, ensure/select both ASP and 
ASP.NET (selecting these automatically selects other prerequisite 
features) 

Click OK 

Server Windows 2008 

Ensure Required IIS Components are Installed  

Admin Tools > Server Manager 

Expand Roles, select Web Server (IIS) 

In Web Server (IIS) pane: 

Scroll down to Role Services, under Application Development ensure 
ASP.NET and ASP modules are installed 

Scroll down further to Management Tools, ensure IIS 6 Management 
Compatibility is installed, and under that, ensure/select IIS Metabase 
Compatibility is installed  

Server Set IIS ASP Request Size Limit 

Admin Tools > Internet Information Services (IIS) Manager 

Connections pane > Select the Server, in Server’s Home pane, scroll 
down to the IIS area and double-click ASP 

ASP properties pane > Behavior section, expand Limits Properties. 

Locate Maximum Requesting Entity Body Limit 
(maxRequestEntityAllowed), increase value (increase size) 

Click Apply 
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On Do This 
Server Create (Nested) Taskmaster Web Site  

Admin Tools > Internet Information Services (IIS) Manager 

Connections pane > Expand the Server > expand Sites  

Right-click Default Web Site, select Add Application... and select or 
enter the following on the Add Application dialog: 

  Alias: tmweb.net 
  Application pool: Classic .NET AppPool 
  Physical path: C:\Datacap\tmweb.net 
  On 64-bit Windows 2008, also select Advanced Settings > Enable 32-
Bit Applications, set to True 

Click OK 

Click Default Web Site, on Actions tab (far right) expand Manage 
Web Site, click Configure Limits... link and set Connection timeout (in 
seconds) to 1200, click OK 

Click Default Web Site, in middle Default Web Site Home pane, 
double-click HTTP Response Header icon, and on Actions tab (far 
right) click Set Common Headers…link and ensure the following are 
set: 

  Expire Web content: Checked 
  Immediately: Selected 

Click OK to save and close. 

Server Create TaskRun Folder and Set Up Security 

Folder name is case-sensitive and must be named TaskRun; folder 
must be created at the same level as the tmweb.net folder. 

In Windows Explorer, navigate to c:\Datacap and create a TaskRun 
folder. 

Right-click c:\Datacap\TaskRun > Properties 

Security tab > Add NETWORK SERVICE & local IUSR, and set to 
allow Modify 

Server Set Up TaskRun Virtual Folder 

Admin Tools > Internet Information Services (IIS) Manager 

Connections pane> Expand the Computer > expand Sites 

Right-click Default Web Site, select Add Virtual Directory... and select 
or enter the following on the Add Virtual Directory dialog: 

  Alias: TaskRun 
  Physical path: c:\Datacap\TaskRun (case sensitive) 
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On Do This 
Server Install Crystal Reports Runtime 

Install Crystal Reports runtime  

c:\Datacap\Install\tmweb7cr\setup.exe 

  Site: Default Web Site  
  Virtual directory: tmweb.net 

Server Confirm Server.INI File Points to TaskRun 

Using Notepad, open c:\Datacap\tmweb.net\server.ini and ensure 
TempFolder=/TaskRun/  

Server Change Secure Socket Layer Setting in Server.INI 

If using web site SSL, also do the following: 

Using Notepad, open c:\Datacap\tmweb.net\server.ini and ensure  
UseSSL=1 

Server Start Taskmaster Server Service 

Start > All Programs > Datacap > Taskmaster Server > Taskmaster 
Server > Start  

Server Configure and Test IE 

See instructions below 

Configure Internet Explorer 

Configure IE 6 on Workstation and Run Taskmaster Web Client 

On Do This 
Workstation Confirm Scanner Available  

(Note:  A physical scanner is not required for running the Datacap 
sample applications, as those applications can use the prescanned 
images included during installation.) 

If scanner shows in Control Panel >  Scanners and Cameras, scanner 
is available to thin client. 
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On Do This 
Workstation Configure IE 6 

Start IE 6 

Tools > Internet Options > General tab > Temporary Internet files > 
Click Settings button> Settings dialog> Select: Every visit to the 
page, click OK 

Security tab > Select Trusted sites > Click Sites button > Trusted sites 
dialog  

On Trusted sites dialog, clear Require server verification, and add 
either the default IP address of the Taskmaster Server 
(http://127.0.0.1) or the URL of the Server as it is defined in your 
network's DNS (http://Server or https://Server), click OK. 

Security tab > Click Custom level button > Security settings dialog 

  Enable: Download signed ActiveX controls 
  Enable: Download unsigned ActiveX controls 
  Enable: Initialize and script ActiveX controls not marked as safe for 
scripting 

Click OK to close Security settings dialog and Internet Options 
window 

Workstation Test IE 6 

To test your setup, run IE, and use either the default IP address of the 
Taskmaster Server or the URL of the Server with the tmweb.net 
virtual directory and the test page to run the test setup -  the URL will 
look like: 
http://127.0.0.7/tmweb.net/ietest.aspx, 
http://Server/tmweb.net/ietest.aspx, or 
https://Server/tmweb.net/ietest.aspx   

Workstation Run Thin Client 

Start IE, and enter the appropriate Server URL 
(http://127.0.0.7/tmweb.net, http://Server/tmweb.net, or 
https://Server/tmweb.net).  

Sign on as Taskmaster user "admin" and Station "remote" 

Run/test thin client using the images on the Server in the application's 
images folder, and confirm each job in the workflow is processing 
correctly (you will  have to switch back to thick client to run some 
jobs) 

Workstation Run Thin Client Reports 

Run/test thin client Report generation  

 



Taskmaster 7.6 

Confidential and Proprietary Information of Datacap Inc. Page 171 
Copyright © 2010 Datacap Inc. 

 Configure IE 7 or 8 on Workstation and Run Taskmaster Web Client 

On Do This 
Workstation Confirm Scanner Available  

(Note:  A physical scanner is not required for running the Datacap 
sample applications, as those applications can use the prescanned 
images included during installation.) 

If scanner shows in Control Panel >  Scanners and Cameras, scanner 
is available to web client. 

Workstation Configure IE 7 or 8 on Workstation 

Start IE 7 or 8 

Tools > Internet Options > General tab > Browsing history > click 
Settings button> Temporary Internet Files and History Settings 
dialog> Select: Every time I visit the webpage, click OK 

Security tab > Select Trusted sites > Click Sites button   

On Trusted sites dialog, clear Require server verification, and add 
either the default IP address of the Taskmaster Server 
(http://127.0.0.1) or the URL of the Server as it is defined in your 
network's DNS (http://Server or https://Server) click OK. 

Security tab > Click Custom level button > Security settings dialog - 
Trusted Sites Zone: 

  Enable: Download signed ActiveX controls 
  Enable: Download unsigned ActiveX controls 
  Enable: Initialize and script ActiveX controls not marked as safe  
  for scripting 

Scroll down to Miscellaneous settings > Enable Include local 
directory path when uploading files to a server, click OK. 

Close IE 7 or 8 

Workstation Run Web Client 

Start IE, and enter the appropriate Server URL 
(http://127.0.0.7/tmweb.net, http://Server/tmweb.net, or 
https://Server/tmweb.net ).  

Sign on as Taskmaster user "admin" and Station "remote" 

Run/test thin client using the images on the Server in the application's 
images folder, and confirm each job in the workflow is processing 
correctly (you will  have to switch back to thick client to run some 
jobs) 

Workstation Run/test thin client Report generation  
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Configure Taskmaster Client Service 

On Do This 
N/A Determine which Datacap Application, Tasks to Process 

Server Set up Domain/Windows User Account for Taskmaster Client 
Service 

Server Configure Taskmaster Server Service to use Windows 
Authentication (OPTIONAL - skip if not using Windows 
Authentication) 

Stop Taskmaster Server Service 

Start > All Programs > Datacap > Taskmaster Server > Taskmaster 
Server > Stop 

Click Taskmaster tab, click Show advanced 

Enter either native AD or typical LDAP user lookup string 

Server Start Taskmaster Server Service 

Start > All Programs > Datacap > Taskmaster Server > Taskmaster 
Server > Start 

Workstation Add Group, User, Station for Taskmaster Client Service to 
Application 

Start the application by clicking the Taskmaster Client shortcut that 
points to the application files on the Server  

Sign on as Taskmaster user "admin" 

Settings > Groups tab > click Add, add Group for Taskmaster Client 
Service (see Configure Windows Authentication for Taskmaster 
section for instructions on naming this group), and assign Privileges, 
Permissions 

Click Users tab > click Add, add User for Taskmaster Client Service 
and assign Privileges, and add to Group 

Click Stations tab > click Add, add Station for Taskmaster Client 
Service, and assign Permissions. 

Exit client 

TCSServer Run Datacap InstallShield 

Log into Windows as developer/administrator, and run InstallShield, 
install Taskmaster Client component 

TCSServer Reboot 

TCSServer Edit TCSServer's Registry 

Edit the TCSServer's Windows registry so it reflects UNC of Server 
and path to the \\Server\Datacap\RRS\ folder 

Regedit:  HKEY_LOCAL_MACHINE > SOFTWARE > DATACAP 
> RRS> locations > rrs should reflect: \\Server\Datacap\RRS\ 
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On Do This 
Workstation Note System DSNs 

Admin Tools > Data Sources > System DSN tab  

For each DSN used by application, note Driver, select DSN, click 
Configure, note Data Source Name, click Select, note the full UNC 
path 

TCSServer Create Required System DSNs 

Admin Tools > Data Sources > System DSN tab  

Click Add, select driver, click Finish, enter Data Source Name, click 
Select, navigate to the application’s Process folder on the Server, 
select database, click OK, click OK. 

Repeat for each DSN required by the application 

TCSServer Grant Taskmaster Client Service Log On as a Service Right 

Control Panel > (System and Maintenance) > Admin Tools > Services 
> right-click Datacap Taskmaster Client Service > Properties > Log 
On tab 

Select This Account and enter domain name, user name and password 
of the Taskmaster Client Service User, click Apply, returns message 
that user granted Log On as a Service right  

TCSServer Add Taskmaster Client Service Account on TCSServer 

Add Taskmaster Client Service Account to TCSServer’s 
Administrators group, or grant Taskmaster Client Service account 
permissions using DCOM Config: 

Admin Tools > Component Services > DCOM Config > change 
TaskMaster.RunTask properties on the Security tab: 

Launch and Activate:  Add Taskmaster Client Service account and 
allow Local Launch, Remote Launch, Local Activation, Remote 
Activation 

Access Permissions: Add Taskmaster Client Service account and 
allow Local Access, Remote Access 

Configuration Permissions: Add Taskmaster Client Service account 
and allow Full Control 

Server Vista, Windows 2008 

Set Up Datacap Folder Sharing for Taskmaster Client Service 

Right-click c:\Datacap folder and select Properties 

Click Sharing tab, click Advanced Sharing, click Permissions, add 
Taskmaster Client Service account and set to allow Full Control  
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On Do This 
Server Windows 2000, Windows 2003 

Set Up Datacap Folder Sharing for Taskmaster Client Service 

Right-click c:\Datacap folder and select Sharing and Security 

Click Sharing tab, click Permissions, add Taskmaster Client Service 
account and set to allow Full Control 

Server Set Up Security on Shared Folder for Taskmaster Client Service 
(All OS) 

Right-click c:\Datacap folder and select Properties 

Click Security tab: Add Taskmaster Client Service account and set to 
allow Read & Execute 

Server Set Up Security on RRS\Libs\Application Folder for Taskmaster 
Client Service (All OS) 

Right-click c:\Datacap\RRS\Libs\Application and select Properties 

Click Security tab: Add Taskmaster Client Service account and set to 
allow Full Control 

Server Set Up Security on Datacap\Application Folder for Taskmaster 
Client Service (All OS) 

Right-click c:\Datacap\Application and select Properties 

Click Security tab: Add Taskmaster Client Service account and set to 
allow Full Control 
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On Do This 
TCSServer Configure Taskmaster Client Service 

Start > All Programs > Datacap > Taskmaster Client > Taskmaster 
Client Service > Client Service Settings window > Confirm 
Taskmaster Client Service is Stopped. 

Taskmaster Server tab > Enter Server Name or IP address, click 
Connect 

Admin/Engine tab > 

Admin database tab > select Database type, select application’s 
Admin database on the Server 

Engine database tab > select Database type, select application’s 
Engine database on the Server 

Click Connect 

Login tab: select appropriate authentication method and enter info, 
click Login 

Workflow:Job:Task tab > Expand workflow, expand jobs, select tasks 
in each job that this Taskmaster Client Service is to run 

Clear Stop on Abort, select Mixed queuing, clear Write to Debug, 
change the Sleep and Task Instances settings if appropriate, then click 
Save. 

Logging tab > Change settings if appropriate, click Save. 

Taskmaster Server tab > click Disconnect 

TM Sub tab > click Start 

Click Close. 

Admin Tools > double-click Services 

Scroll down to Datacap Taskmaster Client Service, right-click > 
Properties 

General tab > Change Startup Type to Automatic, click Apply, click 
OK 

Workstation Test Taskmaster Client Service by Running Application 

Start and run application tasks that should trigger the Taskmaster 
Client Service 

 

 Configure Windows Authentication for Taskmaster 

On Do This 
Server Create/ensure domain exists in which Taskmaster-specific AD/LDAP 

security groups can be created 
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On Do This 
Server Create/ensure AD/LDAP security group exists 

Server Create/ensure Taskmaster user, Taskmaster Client Service accounts 
exist and are part of security group 

Server Stop Taskmaster Server Service 

Start > All Programs > Datacap > Taskmaster Server > Taskmaster 
Server > Stop 

Server Configure Taskmaster Server Service to use Windows 
Authentication 

Start > All Programs > Datacap > Taskmaster Server > Taskmaster 
Server  

Taskmaster tab > click Show Advanced, enter either Native AD or 
typical LDAP authentication string: 
WinNT://<%domain%>/<%user%>  
LDAP://CN=<%user%>,CN=Users,DC=<%domain%>,dc=Com 
Click Save   
Service tab > click Start 

Workstation Ensure Workstation's Registry 

Edit the Workstation's Windows registry so it reflects UNC of Server 
and path to the \\Server\Datacap\RRS\ folder 

Regedit:  HKEY_LOCAL_MACHINE > SOFTWARE > DATACAP 
> RRS> locations > rrs should reflect: \\Server\Datacap\RRS\ 

Workstation Add Taskmaster Group to Application 

Start Taskmaster Client Application as Admin 

Settings > Groups  

Click Add, and enter a Group ID that is a concatenation of: 

--Your Taskmaster-specific security group name 
--A dot 
--The domain to which your Taskmaster-specific security group 
    belongs 

Click Apply, then OK 

Expand Privileges, select appropriate privileges, click Apply, then OK 

Expand Permissions, select appropriate permissions, click Apply, 
click OK, click Apply, click Done 

Workstation Update Authentication Parameter in Taskmaster Client 
Application Shortcut 

Right-click application shortcut > Properties 

Press <End> to move cursor to end of Target field, then ensure last 
parameter in line is -nta, click Apply, click OK 
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 Configure Rulerunner Running as a Web Service 

Note:  “Rulerunner running as a Web Service” is referred to here as “Rulerunner account”  

These instructions cover Windows 2003 Server. 

On Do This 
Server Ensure Domain/Windows User Account exists for Rulerunner 

account with Log on as a service right 

Server Set Up Security on Shared Folder for Rulerunner account 

Right-click c:\Datacap and select Sharing and Security 

Click Security tab: Add/ensure Domain/Windows Rulerunner account 
is set to allow Read & Execute 

Server Set Up RRS Folder Permissions 

Right-click c:\Datacap\RRS and select Sharing and Security 

Click Security tab: Add/ensure ASP.NET Machine Account 
(Server\ASPNET) and Internet Guest Account 
(Server\IUSR_SERVER) are set to allow Full Control; add/ensure 
Domain/Windows account of Rulerunner account is set to allow Full 
Control 

Server Set Up Security on Batches Folder 

Right-click c:\Datacap\Application\Batches folder and select Sharing 
and Security 

Click Security tab: Add/ensure Domain/Windows Rulerunner account 
is set to allow Full Control 

Server Set Up WRRS Folder Permissions 

Right-click c:\Datacap\WRRS and select Sharing and Security 

On Security tab: ASP.NET Machine Account (Server\ASPNET) and 
Internet Guest Account (Server\IUSR_SERVER) are set to allow 
Read & Execute; add/ensure Domain/Windows Rulerunner account is 
set to allow Full Control  
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On Do This 
RRServer Update ASP.NET Process Identity in Machine.Config File  

In Windows Explorer, navigate to and use Notepad to edit: 
c:\WINDOWS\Microsoft.NET\Framework\v2.0.50727\CONFIG\mac
hine.config 

Locate <system.web> and <processModel… 

Add Rulerunner account information to 

<processModel autoConfig="true" enable="true" 
userName="MYDOMAINRulerunnerAccountName" 
password="RulerunnerAccountPassword"/>  

Save and close file 

RRServer Grant Access to IIS Metabase 
Start > Run 
Type cmd, click OK.   
Locate the aspnet_regiis.exe and run with -ga parameter followed by the 
domain name, a backslash, then the Rulerunner account name;  
for example (no line breaks): 
C:\>C:\WINDOWS\Microsoft.NET\Framework\v2.0.50727\aspnet_regiis.ex
e -ga DOMAIN\RulerunnerAccountName  
then press <ENTER>. 
Close the DOS command window 

RRServer Grant DCOProcessor Permissions in DCOM Config 
Admin Tools > Component Services > DCOM Config > DCOProcessor, add 
and grant Local Launch and Local Activation permissions to the Rulerunner 
account.  

RRServer Edit RRServer's Registry 

Ensure the RRServer's Windows registry reflects the UNC name of 
Server (rather than C:\) and path to the \\Server\Datacap\RRS folder 

Regedit:  HKEY_LOCAL_MACHINE > SOFTWARE > DATACAP 
> RRS> locations > rrs should reflect:  \\Server\Datacap\RRS\ 

RRServer Create and Share Virtual Directory for Rulerunner  

Admin Tools > IIS > expand computer > expand Web Sites folder > 
right-click Default Web Site and select New > Virtual Directory > 
Alias: RRS 

Web Site Content directory: c:\Datacap\WRRS folder 

Access Permissions:  Read, Run scripts, Execute 

Right-click RRS > Properties 

ASP.NET tab > confirm version is 2.0.nnnnn 
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On Do This 
RRServer Set Timeout Parameters for Rulerunner  

Admin Tools > IIS > expand computer > expand Web Sites folder > 
expand Default Web Site and right-click RRS > Properties 

Virtual Directory tab > click Configuration button > Application 
Configuration > Options tab > Select Enable session state, Timeout = 
20, select Enable parent paths, Default ASP Language = VBScript, 
ASP Script timeout = 1200 

ASP.NET tab > click Edit Configuration button > General tab 

Application tab > Request execution timeout > 1200 

State Management tab > Session timeout = 20 

RRServer Set Web Site Isolation Mode 

Admin Tools > IIS > expand computer > Right-click Web Sites > 
Web Site  Properties > Service tab, select WWW Isolation Mode: Run 
Service in IIS 5.0 Isolation Mode 

RRServer Select Web Service Extensions 

Admin Tools > IIS > expand computer > click Web Service 
Extensions 

Select/ensure Active Server Pages, ASP.NET v2.0.50727, and Server 
Side Includes are Allowed. 

Any Test Rulerunner Access to Virtual Directory 

Open Internet Explorer, enter:  http://RRServerName/rrs/session.asmx 

Server Start Taskmaster Server Service 

Start > All Programs > Datacap > Taskmaster Server > Taskmaster 
Server > Start 

Workstation Configure Taskmaster Application to Use Rulerunner as a Web Service 
Sign on as Taskmaster user "admin" 
Settings > Workflow > select Main Job > select Recognize task, click Setup 
Recognize Setup - Batch Pilot window > select the Rulerunner Web Service 
option, click Done.   
Click Apply. 

Workstation Test Taskmaster Application Using Rulerunner as a Web Service 

Create a batch and process it through the (Recognize) task.   

Open application’s batches folder, open log file associated with task, 
look for “RRS is REMOTE” entry. 
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Appendix C 
  Taskmaster Installer Command Line 

Parameters 

This Appendix provides information about the most commonly used parameters available 
when running the Taskmaster InstallShield Setup.exe from the command line. 

Other parameters that are available are the standard InstallShield parameters and standard 
Microsoft Windows Installer parameters. 

InstallShield Parameters 
To view the InstallShield parameters: 

1 From the Windows Start menu, select Run.  The Run dialog opens. 

2 Click the Browse button, navigate to the folder containing the Taskmaster InstallShield 
Setup.exe, select it, and click Open.  The Browse window closes and the full path to the 
Setup.exe is displayed in the Run dialog. 

3 After Setup.exe, add a space and /? (for example: c:\SP1\setup.exe /?), then click OK.  
The InstallShield parameters are displayed. 

4 Click OK to close the InstallShield message box. 

Microsoft Windows Installer Parameters 
To view Microsoft’s Windows Installer parameters: 

1 From the Windows Start menu, select Run.  The Run dialog opens. 

2 Click the Browse button, navigate to the folder containing the Microsoft Windows 
Installer program msiexec.exe, select it and click Open.  The Browse window closes 
and the full path to the msiexec.exe is displayed in the Run dialog. 

3 After msiexec.exe, add a space and /? (for example: 
C:\WINDOWS\system32\msiexec.exe /?), then click OK.  The Windows Installer 
parameters are displayed. 

4 Click OK to close the Windows Installer message box. 

Most Commonly Used Taskmaster Setup.exe Parameters 
The following table covers the command lines that are most commonly used when installing 
Taskmaster. 
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IMPORTANT NOTES 

When installing components individually (Server, Web, Client), you must also install 
the 'Shared'  component, otherwise the individual component will not function 
properly. 

Name/value pairs (for example INSTALLDIR=\"<path>\" and 
ADDDEFAULT=Shared,Server) are case-sensitive:  Name is all capitals, values are 
upper/lower case as shown. 

Replace <path> with full path (for example C:\Datacap). 

Replace <filename> with name to assign to log file (for example: installLog). 

To Do This Use This Command Line 
Silent Install: Quiet mode, no 
user interaction 

setup.exe /S /V"/quiet" 

Silent Install: Quiet mode, 
different location 

setup.exe /S /V"/quiet INSTALLDIR=\"<path>\"" 

Silent Install: Unattended 
mode - progress bar only 

setup.exe /S /V"/passive" 

Silent Install: Unattended 
mode, different location 

setup.exe /S /V"/passive INSTALLDIR=\"<path>\"" 

Create Install Log setup.exe /V"/log <path>\<filename>.txt" 
Disable Auto Reboot after 
Install Finishes 

setup.exe /V"/norestart” 

Passively install 'Server' only setup.exe /S /V"/passive ADDDEFAULT=Shared,Server" 
Passively install 'Client' only setup.exe /S /V"/passive ADDDEFAULT=Shared,Client" 
Passively install 'Web' only setup.exe /S /V"/passive ADDDEFAULT=Shared,Web" 
Passively install 'Server' & 
'Web' 

setup.exe /S /V"/passive 
ADDDEFAULT=Shared,Server,Web" 

Passively install 'Client' & 
'Support' & ‘Docs’ 

setup.exe /S  
/V"/passive ADDDEFAULT=Shared,Client,Support,Docs" 
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